# Table of Contents

- **Change Log** ........................................................................................................ 7
- **Introduction** ........................................................................................................ 8
  - FortiClient features ........................................................................................... 8
  - Licensing ........................................................................................................... 10
    - Client limits .................................................................................................. 10
  - Installation information ...................................................................................... 11
  - Firmware images and tools ............................................................................... 12
    - Microsoft Windows ...................................................................................... 12
    - Mac OS X .................................................................................................... 13
  - Language support .............................................................................................. 14
- **What's New in FortiClient version 5.2** ........................................................... 15
  - New features in FortiClient version 5.2.3 ......................................................... 15
    - Log upload to Syslog server ........................................................................... 15
    - OpenSSL library ............................................................................................ 15
  - New features in FortiClient version 5.2.2 ......................................................... 15
    - Certificates ................................................................................................... 15
    - OpenSSL library ............................................................................................ 16
  - New features in FortiClient version 5.2.1 ......................................................... 16
    - OpenSSL library ............................................................................................ 16
  - New features in FortiClient version 5.2.0 ......................................................... 16
    - Antivirus ....................................................................................................... 16
    - Web Filtering ............................................................................................... 17
    - VPN ............................................................................................................... 17
    - Application Firewall ..................................................................................... 18
    - Endpoint Control .......................................................................................... 18
    - Installation .................................................................................................... 19
- **Provisioning FortiClient** .................................................................................. 21
  - Standard FortiClient installation ...................................................................... 21
  - Download the FortiClient installation files ....................................................... 21
  - Install FortiClient on a Microsoft Windows computer ...................................... 21
  - Installing FortiClient on a Microsoft Server .................................................... 24
  - Install FortiClient on a Mac OS X computer .................................................... 24
  - Installing FortiClient on an infected system ..................................................... 25
  - Installing FortiClient as part of a cloned disk image ....................................... 25
    - Installing FortiClient on cloned computers ................................................. 26
  - Deploy FortiClient using Microsoft Active Directory (AD) server .................... 26
# Deploy FortiClient using Microsoft SCCM 2012

- SCCM setup
- Task sequences
- Task sequence examples for FortiClient

## SCCM setup


## Task sequences


## Task sequence examples for FortiClient

## Endpoint Management

- Introduction
- Configure endpoint management
- Configuring endpoint registration over a VPN
- Endpoint registration on an IPsec VPN
- Endpoint registration on the SSL VPN
- Remembered FortiGates
- View FortiClient registration in the FortiGate Web-based Manager
- Configure the FortiGate IP address in FortiClient for registration
- Enable FortiClient endpoint registration key password (optional)
- Display or hide the FortiClient profile details
- Update FortiClient registration license on FortiGate
- Endpoint registration with Active Directory (AD) user groups
  - Configure users and groups on your AD server
  - Configure your FortiAuthenticator
  - Configure your FortiGate
  - Connect to the FortiGate using FortiClient endpoint
- Monitoring client registrations

## Antivirus

- FortiClient Antivirus
  - Enable or disable antivirus
  - Notifications
  - Scan now
  - Scan a file or folder on your workstation
  - Submit a file for analysis
  - View FortiClient engine and signature versions
  - Schedule antivirus scanning
  - Add files/folders to an exclusion list
  - View quarantined threats
  - View site violations
  - View alerts dialog box
  - Real-time Protection events
- Antivirus logging
- Antivirus options
- Endpoint control

## Web Security/Web Filter

- Enable/Disable Web Security
- Web Security profile
- Web Security exclusion list
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Web Security settings</td>
<td>81</td>
</tr>
<tr>
<td>View violations</td>
<td>82</td>
</tr>
<tr>
<td>Web Filter</td>
<td>83</td>
</tr>
<tr>
<td><strong>Application Firewall</strong></td>
<td>88</td>
</tr>
<tr>
<td>View application firewall profile</td>
<td>91</td>
</tr>
<tr>
<td>View blocked applications</td>
<td>91</td>
</tr>
<tr>
<td><strong>IPsec VPN and SSL VPN</strong></td>
<td>92</td>
</tr>
<tr>
<td>Add a new connection</td>
<td>92</td>
</tr>
<tr>
<td>Create a new SSL VPN connection</td>
<td>92</td>
</tr>
<tr>
<td>Create a new IPsec VPN connection</td>
<td>94</td>
</tr>
<tr>
<td>Provision client VPN connections</td>
<td>96</td>
</tr>
<tr>
<td>Connect to a VPN</td>
<td>99</td>
</tr>
<tr>
<td>Save Password, Auto Connect, and Always Up (Keep Alive)</td>
<td>100</td>
</tr>
<tr>
<td>FortiToken and FortiClient VPN</td>
<td>102</td>
</tr>
<tr>
<td><strong>Advanced features (Microsoft Windows)</strong></td>
<td>103</td>
</tr>
<tr>
<td>Activating VPN before Windows Logon</td>
<td>103</td>
</tr>
<tr>
<td>Connect VPN before logon (AD environments)</td>
<td>103</td>
</tr>
<tr>
<td>Create a redundant IPsec VPN</td>
<td>103</td>
</tr>
<tr>
<td>Priority based SSL VPN connections</td>
<td>104</td>
</tr>
<tr>
<td><strong>Advanced features (Mac OS X)</strong></td>
<td>105</td>
</tr>
<tr>
<td>Create a redundant IPsec VPN</td>
<td>105</td>
</tr>
<tr>
<td>Priority based SSL VPN connections</td>
<td>106</td>
</tr>
<tr>
<td><strong>VPN tunnel &amp; script (Microsoft Windows)</strong></td>
<td>107</td>
</tr>
<tr>
<td>Feature overview</td>
<td>107</td>
</tr>
<tr>
<td>Map a network drive after tunnel connection</td>
<td>107</td>
</tr>
<tr>
<td>Delete a network drive after tunnel is disconnected</td>
<td>107</td>
</tr>
<tr>
<td><strong>VPN tunnel &amp; script (Mac OS X)</strong></td>
<td>108</td>
</tr>
<tr>
<td>Map a network drive after tunnel connection</td>
<td>108</td>
</tr>
<tr>
<td>Delete a network drive after tunnel is disconnected</td>
<td>108</td>
</tr>
<tr>
<td><strong>Vulnerability Scan</strong></td>
<td>109</td>
</tr>
<tr>
<td>Enable Vulnerability Scan</td>
<td>109</td>
</tr>
<tr>
<td>Scan now</td>
<td>111</td>
</tr>
<tr>
<td>View vulnerabilities</td>
<td>111</td>
</tr>
<tr>
<td><strong>Settings</strong></td>
<td>114</td>
</tr>
<tr>
<td>Backup or restore full configuration</td>
<td>114</td>
</tr>
<tr>
<td>Logging</td>
<td>115</td>
</tr>
<tr>
<td>Configure logging to FortiAnalyzer or FortiManager</td>
<td>116</td>
</tr>
<tr>
<td>Updates</td>
<td>119</td>
</tr>
<tr>
<td><strong>VPN options</strong></td>
<td>120</td>
</tr>
<tr>
<td><strong>Certificate management</strong></td>
<td>120</td>
</tr>
<tr>
<td><strong>Antivirus options</strong></td>
<td>120</td>
</tr>
<tr>
<td><strong>Advanced options</strong></td>
<td>121</td>
</tr>
</tbody>
</table>
Single Sign-On (SSO) mobility agent ................................................................. 123
FortiClient/FortiAuthenticator protocol .......................................................... 123
Configuration lock .......................................................................................... 125
FortiTray ........................................................................................................... 126
Connect to a VPN connection ........................................................................ 127

Custom FortiClient Installations ..................................................................... 128
Download the license file ............................................................................... 128
Create a custom installer ................................................................................. 129
FortiClient (Windows) Configurator tool ......................................................... 129
FortiClient (Mac OS X) Configurator tool ....................................................... 136
Custom installation packages .......................................................................... 138
FortiClient (Windows) ..................................................................................... 138
Advanced FortiClient profiles ......................................................................... 140
Provision a full XML configuration file .......................................................... 140
Advanced VPN provisioning .......................................................................... 143

Upgrade Information ....................................................................................... 147
FortiClient (Windows) version 5.2.3 upgrade information ... ........................... 147
FortiClient (Mac OS X) version 5.2.3 upgrade information ............................... 147

Appendix A: Deployment Scenarios ................................................................. 148
Basic FortiClient Profile ................................................................................... 148
Advanced FortiClient Profile (Full XML Configuration) ................................. 149
Advanced FortiClient Profile (Partial XML Configuration) ............................. 150
Advanced VPN Provisioning FortiClient Profile .............................................. 152
Advanced FortiClient Profile (No Settings Provisioned) .................................... 154
Using Active Directory Groups ....................................................................... 155
Monitoring registered users ............................................................................ 155
Customizing FortiClient using XML settings ............................................... 156
  Silent registration ......................................................................................... 156
  Locked FortiClient settings ......................................................................... 156
  Disable unregistration ............................................................................... 157
  Putting it together ....................................................................................... 157
  Off-net VPN auto-connect ........................................................................... 157

Appendix B: Using the FortiClient API ............................................................ 160
Overview ........................................................................................................ 160
API reference .................................................................................................. 160

Appendix C: Rebranding FortiClient ............................................................... 162

Appendix D: FortiClient Log Messages ......................................................... 169

Index .............................................................................................................. 179
## Change Log

<table>
<thead>
<tr>
<th>Date</th>
<th>Change Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>2014-08-18</td>
<td>Updated for FortiClient version 5.2.1.</td>
</tr>
<tr>
<td>2014-11-18</td>
<td>Updated for FortiClient version 5.2.2.</td>
</tr>
<tr>
<td>2015-01-29</td>
<td>Updated for Fortilient version 5.2.3.</td>
</tr>
</tbody>
</table>
Introduction

FortiClient provides a comprehensive network security solution for endpoints while improving your visibility and control. FortiClient allows you to manage the security of multiple endpoint devices from the FortiGate interface. This document provides an overview of FortiClient version 5.2.3.

This document was written for FortiClient (Windows) version 5.2.3. Not all features described in this document are supported for FortiClient (Mac OS X) version 5.2.3.

FortiClient features

The following table provides a feature comparison between the standalone client (free version) and the managed client (licensed version).

**Table 1: FortiClient feature comparison**

<table>
<thead>
<tr>
<th>Standalone Client (Free Version)</th>
<th>Managed Client (Licensed Version)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Installation Options</strong></td>
<td><strong>Installation Options</strong></td>
</tr>
<tr>
<td>• Complete: All Endpoint Security and VPN components will be installed.</td>
<td>• Complete: All Endpoint Security and VPN components will be installed.</td>
</tr>
<tr>
<td>• VPN Only: only VPN components (IPsec and SSL) will be installed.</td>
<td>• VPN Only: only VPN components (IPsec and SSL) will be installed.</td>
</tr>
<tr>
<td>• Create a custom FortiClient installer using the FortiClient Configurator tool using the trial mode. In trial mode, all online updates are disabled.</td>
<td>• Create a custom FortiClient installer using the FortiClient Configurator tool.</td>
</tr>
<tr>
<td><strong>Threat Protection</strong></td>
<td><strong>Threat Protection</strong></td>
</tr>
<tr>
<td>• Real-time Antivirus Protection</td>
<td>• Real-time Antivirus Protection</td>
</tr>
<tr>
<td>• Antirootkit/Antimalware</td>
<td>• Antirootkit/Antimalware</td>
</tr>
<tr>
<td>• Grayware Blocking (Adware/Riskware)</td>
<td>• Grayware Blocking (Adware/Riskware)</td>
</tr>
<tr>
<td><strong>Web Content</strong></td>
<td><strong>Web Content</strong></td>
</tr>
<tr>
<td>• Web Filtering</td>
<td>• Web Filtering</td>
</tr>
<tr>
<td>• Search Engine Safe Search</td>
<td>• Search Engine Safe Search</td>
</tr>
<tr>
<td>Bing and Yandex</td>
<td>Bing and Yandex</td>
</tr>
<tr>
<td>• YouTube Education Filter</td>
<td>• YouTube Education Filter</td>
</tr>
</tbody>
</table>
**Table 1: FortiClient feature comparison (continued)**

<table>
<thead>
<tr>
<th>Standalone Client (Free Version)</th>
<th>Managed Client (Licensed Version)</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>VPN</strong></td>
<td><strong>VPN</strong></td>
</tr>
<tr>
<td>• SSL VPN</td>
<td>• SSL VPN</td>
</tr>
<tr>
<td>• IPsec VPN</td>
<td>• IPsec VPN</td>
</tr>
<tr>
<td>• Client Certificate Support</td>
<td>• Client Certificate Support</td>
</tr>
<tr>
<td>• X.509 Certificate Support</td>
<td>• X.509 Certificate Support</td>
</tr>
<tr>
<td>• Elliptical Curve Certificate Support</td>
<td>• Elliptical Curve Certificate Support</td>
</tr>
<tr>
<td>• Two-Factor Authentication</td>
<td>• Two-Factor Authentication</td>
</tr>
<tr>
<td><strong>Logging</strong></td>
<td><strong>Logging</strong></td>
</tr>
<tr>
<td>• VPN, Antivirus, Web Security, and Update Logging</td>
<td>• VPN, Application Firewall, Antivirus, Web Filter, Update, and Vulnerability Scan Logging</td>
</tr>
<tr>
<td>• View logs locally</td>
<td>• View logs locally</td>
</tr>
<tr>
<td><strong>Application Control</strong></td>
<td><strong>Application Control</strong></td>
</tr>
<tr>
<td>• Application Firewall</td>
<td>• Application Firewall</td>
</tr>
<tr>
<td>• Block Specific Application Traffic</td>
<td>• Block Specific Application Traffic</td>
</tr>
<tr>
<td><strong>Vulnerability Management</strong></td>
<td><strong>Vulnerability Management</strong></td>
</tr>
<tr>
<td>• Vulnerability Scan</td>
<td>• Vulnerability Scan</td>
</tr>
<tr>
<td>• Link to FortiGuard with information on the impact and recommended actions</td>
<td>• Link to FortiGuard with information on the impact and recommended actions</td>
</tr>
<tr>
<td><strong>Central Management</strong></td>
<td><strong>Central Management</strong></td>
</tr>
<tr>
<td>• Centralized Client Management and monitoring</td>
<td>• Centralized Client Management and monitoring</td>
</tr>
<tr>
<td>• Centralized configuration provisioning and deployment</td>
<td>• Centralized configuration provisioning and deployment</td>
</tr>
<tr>
<td>• Enforcement of enterprise security policies.</td>
<td>• Enforcement of enterprise security policies.</td>
</tr>
<tr>
<td><strong>Central Logging</strong></td>
<td><strong>Central Logging</strong></td>
</tr>
<tr>
<td>• Upload logs to a FortiAnalyzer or FortiManager. FortiClient must be registered to FortiGate to upload logs to FortiAnalyzer or FortiManager.</td>
<td>• Upload logs to a FortiAnalyzer or FortiManager. FortiClient must be registered to FortiGate to upload logs to FortiAnalyzer or FortiManager.</td>
</tr>
</tbody>
</table>
Licensing

Licensing on the FortiGate is based on the number of registered clients. FortiGate 30 series and higher models support ten (10) free managed FortiClient licenses. For additional managed clients, a FortiClient license subscription must be purchased. The maximum number of managed clients varies per device model.

The VPN on-net, off-net feature in Endpoint Control will be activated only when the FortiGate, to which FortiClient is registered, is running FortiOS version 5.2 with a FortiClient version 5.2 license.

Client limits

The following table shows client limits per FortiGate model series.

**Table 2: FortiClient license upgrade**

<table>
<thead>
<tr>
<th>FortiGate Series</th>
<th>Free Registrations</th>
<th>FortiClient License Upgrade</th>
</tr>
</thead>
<tbody>
<tr>
<td>FortiGate/FortiWiFi 30 to 90 series</td>
<td>10</td>
<td>1 year FortiClient license subscription for up to 200 clients</td>
</tr>
<tr>
<td>FortiGate 100 to 300 series</td>
<td>10</td>
<td>1 year FortiClient license subscription for up to 600 clients</td>
</tr>
<tr>
<td>FortiGate 500 to 800 series, FortiGate VM01, FortiGate VM02</td>
<td>10</td>
<td>1 year FortiClient license subscription for up to 2000 clients</td>
</tr>
<tr>
<td>FortiGate 1000 series, FortiGate VM04</td>
<td>10</td>
<td>1 year FortiClient license subscription for up to 8000 clients</td>
</tr>
<tr>
<td>FortiGate 3000 to 5000 series, FortiGate VM08</td>
<td>10</td>
<td>1 year FortiClient license subscription for up to 20 000 clients</td>
</tr>
</tbody>
</table>

In high availability (HA) configurations, all cluster members require an upgrade license key.

For more information, go to [www.forticlient.com](http://www.forticlient.com).

The FortiClient license for FortiOS version 5.2 includes the license file required to use the FortiClient Configurator tool used to create custom FortiClient installers. The Configurator tool also allows you to rebrand the installer file.
The following table lists operating system support and the minimum system requirements.

**Table 3: Installation information**

<table>
<thead>
<tr>
<th>Operating System Support</th>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Microsoft Windows XP (32-bit)</td>
<td>Microsoft Internet Explorer version 8 or later</td>
</tr>
<tr>
<td>Microsoft Windows Vista (32-bit and 64-bit)</td>
<td>Microsoft Windows compatible computer with Intel processor or equivalent</td>
</tr>
<tr>
<td>Microsoft Windows 7 (32-bit and 64-bit)</td>
<td>Compatible operating system and minimum 512MB RAM</td>
</tr>
<tr>
<td>Microsoft Windows 8 (32-bit and 64-bit)</td>
<td>600MB free hard disk space</td>
</tr>
<tr>
<td>Microsoft Windows 8.1 (32-bit and 64-bit)</td>
<td>Native Microsoft TCP/IP communication protocol</td>
</tr>
<tr>
<td>Microsoft Windows Server 2008 R2</td>
<td>Native Microsoft PPP dialer for dial-up connections</td>
</tr>
<tr>
<td>Microsoft Windows Server 2012</td>
<td>Ethernet NIC for network connections</td>
</tr>
<tr>
<td></td>
<td>Wireless adapter for wireless network connections</td>
</tr>
<tr>
<td></td>
<td>Adobe Acrobat Reader for documentation</td>
</tr>
<tr>
<td></td>
<td>MSI installer 3.0 or later.</td>
</tr>
</tbody>
</table>
Table 3: Installation information (continued)

<table>
<thead>
<tr>
<th>Operating System Support</th>
<th>Minimum System Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mac OS X v10.8 Mountain Lion</td>
<td>Apple Mac computer with an Intel processor</td>
</tr>
<tr>
<td>Mac OS X v10.9 Mavericks</td>
<td>256MB of RAM</td>
</tr>
<tr>
<td>Mac OS X v10.10 Yosemite</td>
<td>20MB of hard disk drive (HDD) space</td>
</tr>
<tr>
<td></td>
<td>TCP/IP communication protocol</td>
</tr>
<tr>
<td></td>
<td>Ethernet NIC for network connections</td>
</tr>
<tr>
<td></td>
<td>Wireless adapter for wireless network connections</td>
</tr>
</tbody>
</table>

Firmware images and tools

**Microsoft Windows**

The following files are available in the firmware image file folder:

- **FortiClientSetup_5.2.xx.xxxx.exe**
  Standard installer for Microsoft Windows (32-bit).

- **FortiClientSetup_5.2.xx.xxxx.zip**
  A zip package containing FortiClient.msi and language transforms for Microsoft Windows (32-bit). Some properties of the MSI package can be customized with FortiClient Configurator tool.

- **FortiClientSetup_5.2.xx.xxxx_x64.exe**
  Standard installer for Microsoft Windows (64-bit).

- **FortiClientSetup_5.2.xx.xxxx_x64.zip**
  A zip package containing FortiClient.msi and language transforms for Microsoft Windows (64-bit). Some properties of the MSI package can be customized with FortiClient Configurator tool.

- **FortiClientTools_5.2.xx.xxxx.zip**
  A zip package containing miscellaneous tools including the FortiClient Configurator tool and VPN Automation files.

When creating a custom FortiClient version 5.2 installer using the FortiClient Configurator tool, you can choose to which features to install. You can also select to enable or disable software updates, configure SSO, and rebrand FortiClient.
Mac OS X

The following files are available in the firmware image file folder:

- FortiClient_5.2.x.xxx_macosx.dmg
  Standard installer or Mac OS X.
- FortiClientTools_5.2.x.xxx_macosx.tar
  FortiClient includes various utility tools and files to help with installations. The following tools and files are available in the FortiClientTools .tar file:
  - OnlineInstaller
    This file downloads and installs the latest FortiClient file from the public FDS.
  - FortiClientConfigurator
    An installer repackaging tool that is used to create customized installation packages.
  - RebrandingResources
    Rebranding resources used by the FortiClient Configurator tool.

When creating a custom FortiClient 5.2.3 installer using the FortiClient Repackager tool, you can choose to install Everything, VPN Only, or SSO only. You can also select to enable or disable software updates and rebrand FortiClient.

FortiClient version 5.2 cannot use FortiClient version 5.0 licenses. To use FortiClient Configurator, you need to use the FortiClient version 5.2 license file.
### Language support

The following table lists FortiClient language support information.

**Table 4: Language support**

<table>
<thead>
<tr>
<th>Language</th>
<th>Graphical User Interface</th>
<th>XML Configuration</th>
<th>Documentation</th>
</tr>
</thead>
<tbody>
<tr>
<td>English (United States)</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Chinese (Simplified)</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Chinese (Traditional)</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>French (France)</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>German</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Japanese</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Korean</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Portuguese (Brazil)</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Spanish (Spain)</td>
<td>✓</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>

Please review the [FortiClient (Windows) 5.2.3 Release Notes](#) or the [FortiClient (Mac OS X) 5.2.3 Release Notes](#) prior to upgrading. Release Notes are available at the Customer Service & Support portal.

FortiClient language is dependent on the regional settings on the client workstation. When the regional language setting is not supported, FortiClient defaults to English.
What’s New in FortiClient version 5.2

The following is a list of new features and enhancements in FortiClient version 5.2.

This document was written for FortiClient (Windows) version 5.2.3. Not all features described in this document are supported for FortiClient (Mac OS X) version 5.2.3.

New features in FortiClient version 5.2.3

The following is a list of new features in FortiClient version 5.2.3.

Log upload to Syslog server

FortiClient may be configured to send log messages to a syslog server. The following XML configuration may be used to enable this feature:

```xml
<forticlient_configuration>
  <system>
    <log_settings>
      <remote_logging>
        <log_protocol>syslog</log_protocol> <!-- faz | syslog -->
        <netlog_server></netlog_server> <!-- server IP address -->
      </remote_logging>
    </log_settings>
  </system>
</forticlient_configuration>
```

Set `<log_protocol>` to `faz` in order to switch logging to FortiAnalyzer. This is the default. Provide the IP address of the syslog server in `<netlog_server>`.

OpenSSL library

The OpenSSL library has been updated to the latest version 1.0.1k.

New features in FortiClient version 5.2.2

The following is a list of new features in FortiClient version 5.2.2.

Certificates

Elliptical curve certificates are now supported for both IPsec and SSL VPN.
OpenSSL library

The OpenSSL library has been updated to the latest version 1.0.1j.

New features in FortiClient version 5.2.1

The following is a list of new features in FortiClient 5.2.1

OpenSSL library

The OpenSSL library has been updated to the latest version 1.0.1i.

Logging to FortiManager/FortiAnalyzer

Uploading logs to FortiManager or FortiAnalyzer requires FortiClient to be registered to a FortiGate.

New features in FortiClient version 5.2.0

The following is a list of new features in FortiClient version 5.2.0.

Antivirus

Malware cleanup in safe mode

Malware that is already on a Microsoft Windows computer system that could not be removed in normal mode, may be removed by running FortiClient in safe mode. Only the FortiClient Antivirus feature is available in safe mode. Full or custom antivirus scans can be started from while in safe mode. The resulting log files and any quarantined files, will be available both in safe mode, as well as after returning to normal mode.

The FortiClient installer always runs a quick antivirus scan on the target host system before proceeding with the installation. In case a virus on an infected system prevents downloading of the new FortiClient package, you can boot into safe mode, run the FortiClient installer to scan and quarantine the virus or malware, and then proceed with the installation.

Protection against security threats in URLs has moved to the Antivirus module

Malicious and Phishing URLs were previously configured and blocked as part of the Web Filtering feature. These are in the Security Risk category. This category has now been moved to become part of the Antivirus feature. When a custom FortiClient installation is created without the antivirus module, these threats are blocked by the Web Filtering feature.

View real-time protection events in the console

When an antivirus real-time protection event has occurred you can select to view these events in the FortiClient console. Select AntiVirus > Threats Detected and select Real-time Protection events. The realtime_scan.log will open in the default viewer.

Example log output:

```
Realtime scan result:
time: 03/18/14 10:46:07, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\desktop\eicar.com
```
Removable media scan

In FortiClient version 5.2 you can select to perform an antivirus scan of all connected devices with removable storage. Select **AntiVirus > Scan Now > Removable media Scan** to scan these connected devices. When performing a **Full Scan**, removable storage is also scanned.

One-click button to enable antivirus

In the FortiClient console, you can enable the antivirus feature using a single button visible in the header. This is convenient in the event that you are on a tab other than the Antivirus tab. The button is visible only when Real-time Protection is disabled.

Web Filtering

**Manual URL filter list support**

FortiClient now supports URL filters configured in the FortiOS security profile and applied to the FortiClient Profile.

Web Security

FortiClient Parental Control has been renamed Web Security. When FortiClient is registered to a FortiGate, Web Security is named Web Filter.

VPN

**VPN over IPv6**

VPN connections to the FortiGate can be established on a network that is configured with IPv6. New connections may be configured from the FortiClient console or through the XML configuration file. IPv6 is supported for IPsec and SSL VPN.

Note that FortiOS only supports VPN over IPv6 when both sides of the connection are using IPv6. A network with one end using IPv6 while the other end uses IPv4 is not supported.

**Advanced VPN configuration in the FortiClient console**

VPN configurations through the FortiClient console have been simplified since FortiClient v5.0. Only a few configuration entries were required and advanced configuration required use of the XML configuration file. In FortiClient v5.2 you can access IPsec VPN advanced settings in the FortiClient console. These advanced settings are useful when setting up connections to an IPsec VPN server other than a FortiGate.
Simplified FortiClient console for VPN only installations

FortiClient features may be customized in one of three ways:

- In the standard FortiClient installer,
- In the FortiClient Configurator tool,
- In the FortiGate FortiClient Profile, you can turn off and hide unused features.

When only the VPN feature is selected with any of these three methods, FortiClient will present a simplified console, with no tabs on the left-hand side.

VPN auto-connect based on DHCP off-net determination

VPN auto-connect ensures that FortiClient creates a VPN connection to the FortiGate when considered to be off-net. A site administrator, who has configured Endpoint Control on their FortiGate, may choose to enable VPN auto-connect in the Endpoint Control profile.

Computer endpoints or clients in the network should use the designated DHCP server for IP address assignments. The DHCP server sends a special tag within the protocol to identify if the client is on-net or off-net. The on-net status indicates that the endpoint is within the corporate network protected by the FortiGate.

When the client is off-net, FortiClient will automatically attempt to establish a VPN connection to the VPN server indicated in the FortiGate Endpoint Control configuration. When the client is on-net, no VPN connection is required.

This feature requires FortiOS version 5.2.0 or later. The FortiGate must use a FortiClient v5.2 license.

VPN auto-connect improvements

VPN auto-connect/always-up regardless of how the VPN connection ended.

Application Firewall

Updated Application Firewall Engine

FortiClient now uses a common Application Firewall detection engine with FortiOS. This provides enhanced detection coverage. Signatures configured in the FortiGate security profile are available to FortiClient.

When the application being blocked is web-based, a message is displayed to the user in the web browser. For non-browser applications, a system tray notification is displayed. Notifications are disabled by default to reduce distractions to everyday use of the system.

Endpoint Control

Improvemnts to the Endpoint Control page

The FortiGate Endpoint Protection > FortiClient Profiles page has been simplified.

VPN auto-connect based on DHCP off-net determination

See VPN auto-connect based on DHCP off-net determination.
Enable Vulnerability Scan module

In FortiOS version 5.2, the Vulnerability Scan module is enabled via the FortiGate Command Line Interface (CLI). This feature is not available in the FortiClient Profile in the Web-based Manager until enabled via the CLI. This feature is available in FortiClient when registered to FortiGate for endpoint control.

To enable Vulnerability Scan, enter the following CLI commands:

```plaintext
config endpoint-control profile
edit <profile-name>
    config forticlient-winmac-settings
        set forticlient-vuln-scan {enable | disable}
        set forticlient-vuln-scan-schedule {daily | weekly | monthly}
        set forticlient-vuln-scan-on-registration {enable | disable}
        set forticlient-ui-options {av | wf | af | vpn | vs}
    end
end
```

When setting the `forticlient-ui-options`, you must include all the modules that you want to enable in the FortiClient console.

---

Installation

**Standard installation options**

When installing FortiClient (Windows/Mac OS X) version 5.2, you can choose the setup type that best suits your needs. Select one of the following options:

- Complete: All Endpoint Security and VPN components will be installed
- VPN Only: Only VPN components (IPsec and SSL) will be installed.

**Custom install - select features to include in the FortiClient install**

The FortiClient Configurator tool can be used to create custom FortiClient MSI installers with various combinations. Some of the customization options available include:

- Select FortiClient features of interest
- Provide a custom XML configuration file
- Rebrand the FortiClient product

The customized executable installer generated may be used to install on all supported platforms manually. An MSI installer is also created for distribution using Active Directory or SCCM.

---

A FortiClient version 5.2 license is required to use the FortiClient Configurator tool.
Client installer and Configurator updates (more granular installation options)

Select to install the complete feature set or VPN only in the regular client installer. When selecting to use the repackager, you can install the complete feature set, VPN only, or SSO only.

Client rebranding capabilities (via the Configurator tool)

You can edit various text and graphical UI elements using the rebranding option in the FortiClient Configurator tool.
Provisioning FortiClient

FortiClient can be installed on a standalone computer using the installation wizard or deployed to multiple Microsoft Windows systems using Microsoft Active Directory (AD) or the Microsoft System Center 2012 Configuration Manager (SCCM).

This chapter contains the following sections:

- Standard FortiClient installation
- Installing FortiClient on an infected system
- Installing FortiClient as part of a cloned disk image
- Deploy FortiClient using Microsoft Active Directory (AD) server
- Deploy FortiClient using Microsoft SCCM 2012

Standard FortiClient installation

The following section describes installing FortiClient to a standalone Microsoft Windows and Apple Mac computer.

Download the FortiClient installation files

The FortiClient installation files can be downloaded from the following sites:

- Fortinet Customer Service & Support: https://support.fortinet.com
  Requires a support account with a valid support contract. Download either the Microsoft Windows (32-bit/64-bit) or the Mac OS X online installation file.
- FortiClient homepage: www.forticlient.com
  Download the FortiClient online installation file. The installer file performs a virus and malware scan of the target system prior to installing FortiClient.
  Download the FortiClient online installation file. On this page you can download the latest version of FortiClient for Microsoft Windows, Mac OS X, iOS, and Android.

In FortiOS version 5.0.1 and later, you can download the FortiClient installation files in the FortiGate dashboard. Go to System > Dashboard > Status, in the License Information widget, select Mac or Windows to download the FortiClient Online Installer file.

Install FortiClient on a Microsoft Windows computer

The following instructions will guide you through the installation of FortiClient on a Microsoft Windows computer. For more information, see the FortiClient (Windows) Release Notes.

When installing FortiClient, it is recommended to use the FortiClientOnlineInstaller file. This file will launch the FortiClient Virus Cleaner which will scan the target system prior to installing the FortiClient application.

To check the digital signature of FortiClient, right-click on the installation file and select Properties. In this menu you can set file attributes, run the compatibility troubleshooter, view the digital signature and certificate, install the certificate, set file permissions, and view file details.
To install FortiClient (Windows):

1. Double-click the FortiClient executable file to launch the setup wizard. The Setup Wizard will launch on your computer. When using the FortiClient OnlineInstaller file, the FortiClient Virus Cleaner will run before launching the Setup Wizard. If a virus is found that prevents the infected system from downloading the new FortiClient package, see “Installing FortiClient on an infected system” on page 25.

The Welcome screen is displayed.

2. Read the license agreement, select the checkbox, and select Next to continue. You have the option to print the EULA in this License Agreement screen. The Choose Setup Type screen is displayed.

3. Select one of the following setup types:
   - Complete: All Endpoint Security and VPN components will be installed.
   - VPN Only: Only VPN components (IPsec and SSL) will be installed.
4. Select Next to continue. The Destination Folder screen is displayed.

5. Select Change to choose an alternate folder destination for installation.

6. Select Next to continue.

   FortiClient will search the target system for other installed antivirus software. If found, FortiClient will display the Conflicting Antivirus Software page. You can either exit the current installation and uninstall the antivirus software, disable the antivirus feature of the conflicting software, or continue with the installation with FortiClient real-time protection disabled.

---

This dialog box is displayed during a new installation of FortiClient and when upgrading from an older version of FortiClient which does not have the antivirus feature installed.

---

It is recommended to uninstall the conflicting antivirus software before installing FortiClient or enabling the antivirus real-time protection feature. Alternatively, you can disable the antivirus feature of the conflicting software.

---

7. Select Next to continue.

8. Select Install to begin the installation.

9. Select Finish to exit the FortiClient Setup Wizard.

   On a new FortiClient installation, you do not need to reboot your system. When upgrading the FortiClient version, you must restart your system for the configuration changes made to FortiClient to take effect. Select Yes to restart your system now, or select No to manually restart later.

   FortiClient will update signatures and components from the FortiGuard Distribution Network (FDN).

10. If the FortiGate on the network is broadcasting discovery messages, FortiClient will attempt to register to the FortiGate.

    If the FortiGate is not broadcasting discovery messages, select the Register to FortiGate button in the FortiClient header, specify the address of the FortiGate in the text field, and select the Go icon.

---

If you have any questions about registering FortiClient to FortiGate, please contact your network administrator.

---

11. To launch FortiClient, double-click the desktop shortcut icon.
Installing FortiClient on a Microsoft Server

In FortiClient version 5.2 you can install FortiClient on a Microsoft Windows Server 2008 R2 or 2012 server. You can use the regular FortiClient Windows image for Server installations.

Please refer to the Microsoft knowledge base for caveats on installing antivirus software in a server environment.

Install FortiClient on a Mac OS X computer

The following instructions will guide you though the installation of FortiClient on a Mac OS X computer. For more information, see the FortiClient (Mac OS X) 5.2.3 Release Notes.

To install FortiClient (Mac OS X):
1. Double-click the FortiClient .dmg installer file to launch the FortiClient installer. The FortiClient Installer will install FortiClient on your computer. Select Continue.

Select the lock icon in the upper right corner to view certificate details.

Figure 3: Certificate details

2. Read the Software License Agreement and select Continue. You have the option to print or save the Software Agreement in this window. You will be prompted to Agree with the terms of the license agreement.

3. Select the destination folder for the installation.

4. Select Install to perform a standard installation on this computer. You can change the install location from this screen.

5. Depending on your system, you may be prompted to enter your system password.

6. The installation was successful. Select Close to exit the installer.
7. FortiClient has been saved to the Applications folder.

8. Double-click the FortiClient icon to launch the application. The application console loads to your desktop. Select the lock icon in the FortiClient console to make changes to the FortiClient configuration.

Installing FortiClient on an infected system

The FortiClient installer always runs a quick antivirus scan on the target host system before proceeding with the complete installation. If the system is clean, installation proceeds as usual. Any virus found during this step is quarantined before installation continues.

In case a virus on an infected system prevents downloading of the new FortiClient package, use the following process:

- Boot into “safe mode with networking” (which is required for the FortiClient installer to download the latest signature packages from the Fortinet Distribution Network).
- Run the FortiClient installer.

This scans the entire file system. A log file is generated in the logs subdirectory. If a virus is found, it will be quarantined. When complete, reboot back into normal mode and run the FortiClient installer to complete the installation.

Microsoft Windows will not allow FortiClient installation to complete in safe mode. An error message will be generated. It is necessary to reboot back into normal mode to complete the installation.

Installing FortiClient as part of a cloned disk image

If you configure computers using a cloned hard disk image, you need to remove the unique identifier from the FortiClient application. You will encounter problems with FortiGate if you deploy multiple FortiClient applications with the same identifier.

This section describes how to include a custom FortiClient installation in a cloned hard disk image but remove its unique identifier. On each computer configured with the cloned hard disk image, the FortiClient application will generate its own unique identifier the first time the computer is started.

To include a FortiClient installation in a hard disk image:

1. Using an MSI FortiClient installer, install and configure the FortiClient application to suit your requirements.
   - You can use a standard or a customized installation package.
2. Right-click the FortiClient icon in the system tray and select Shutdown FortiClient.
3. From the folder where you expanded the FortiClientTools.zip file, run RemoveFCTID.exe.
   - The RemoveFCTID tool requires administrative rights.

Do not include the RemoveFCTID tool as part of a logon script.
4. Shut down the computer.

Do not reboot the Windows operating system on the computer before you create the hard disk image. The FortiClient identifier is created before you log on.

5. Create the hard disk image and deploy it as needed.

Installing FortiClient on cloned computers

If you intend to create an image of the hard drive for deployment to other computers, you need to shut down FortiClient and use the RemoveFCTID tool to remove the FortiClient identifier.

Deploy FortiClient using Microsoft Active Directory (AD) server

There are multiple ways to deploy FortiClient to endpoint devices including using Microsoft Active Directory.

The following instructions are based from Microsoft Windows Server 2008. If you are using a different version of Microsoft Server, your MMC or snap-in locations may be different.

Using Microsoft AD to deploy FortiClient:

1. On your domain controller, create a distribution point.
2. Log on to the server computer as an administrator.
3. Create a shared network folder where the FortiClient MSI installer file will be distributed from.
4. Set file permissions on the share to allow access to the distribution package. Copy the FortiClient MSI installer package into this share folder.
6. After selecting your domain, right-click to select a new Organizational Unit (OU).
7. Move all the computers you wish to distribute the FortiClient software to into the newly-created OU.
8. Select Start > Administrative Tools > Group Policy Management. The Group Policy Management MMC Snap-in will open. Select the OU you just created. Right-click it, Select Create a GPO in this domain, and Link it here. Give the new GPO a name then select OK.
9. Expand the Group Policy Object container and find the GPO you just created. Right-click the GPO and select Edit. The Group Policy Management Editor MMC Snap-in will open.
11. Select the path of your distribution point and FortiClient installer file and then select Open. Select Assigned and select OK. The package will then be generated.
12. If you wish to expedite the installation process, on both the server and client computers, force a GPO update.
13. The software will be installed on the client computer’s next reboot. You can also wait for the client computer to poll the domain controller for GPO changes and install the software then.
Uninstall FortiClient using Microsoft Active Directory server:

1. On your domain controller, select Start > Administrative Tools > Group Policy Management. The Group Policy Management MMC Snap-in will open. Expand the Group Policy Objects container and right-click the Group Policy Object you created to install FortiClient and select Edit. The Group Policy Management Editor will open.

2. Select Computer Configuration > Policy > Software Settings > Software Installation. You will now be able to see the package that was used to install FortiClient.

3. Right-click the package, select All Tasks > Remove. Choose Immediately uninstall the software from users and computers, or Allow users to continue to use the software but prevent new installations. Select OK. The package will delete.

4. If you wish to expedite the uninstallation process, on both the server and client computers, force a GPO update as shown in the previous section. The software will be uninstalled on the client computer’s next reboot. You can also wait for the client computer to poll the domain controller for GPO changes and uninstall the software then.

Deploy FortiClient using Microsoft SCCM 2012

The Microsoft System Center 2012 Configuration Manager (SCCM) may be used to deploy and manage multiple FortiClient Installations. This section presents various scenarios that you can utilize.

A fully functional SCCM server, along with discovered devices, is required. Visit the Microsoft web site for supporting documentation.

These instructions assume you have already installed and configured SCCM. If you have not, please refer to Microsoft’s online help sources for information on this task.

The Microsoft System Center 2012 Configuration Manager (SCCM) may be used to deploy and manage multiple FortiClient Installations. This chapter presents various scenarios that you can utilize.

A fully functional SCCM server, along with discovered devices, is required. Visit the Microsoft web site for supporting documentation.

The following topics are detailed in this section:

- SCCM setup
- Task sequences
- Task sequence examples for FortiClient.

SCCM setup

Microsoft maintains a public free virtual lab of the System Center 2012 Configuration Manager (SCCM) at http://technet.microsoft.com/virtuallabs/bb539977.

At this page you can access a completely installed and properly configured system that can be used for testing various SCCM deployment scenarios. For ongoing enterprise use, a new system has to be created and configured.

The following subsections discuss some of the preparations required to enable control of FortiClient host computers.
**Client discovery options and configuration**

The Configuration Manager uses various methods to discover the Windows devices that an administrator can control on the network. One such method is the use of a common domain. To use this method, the Windows server hosting the Configuration Manager should be configured as domain controller. All Windows devices that will be managed should then join the domain. The Configuration Manager automatically discovers all Windows devices that join.

**Client installation**

The Configuration Manager console may be used to install configuration manager client software on target Windows devices that have joined the controlled domain. This is required for pushing the configuration to the devices.

**Client policy polling interval settings**

The configuration manager client on each Windows device polls for policy changes on the server at a regular interval. The polling interval defaults to 60 minutes. Each newly pushed or deployed task will run on all selected clients within this polling interval. You can customize the polling interval as required.

**Client collections**

New configurations are usually deployed to collections of devices. All of the devices that have joined the controlled domain will be added to a default collection.

You may want to deploy a different set of configurations to different groups of devices based on your user base. This can be accomplished by creating different client collections. Devices that have joined the domain will be added to one or more of those collections. Configurations may then be selectively deployed.

**Client security issues**

The Configuration Manager is able to deploy a large variety of applications to all the devices that joined the domain. Most of these tasks run with the administrator or system user authorisation level on the client devices. It is important to keep the Configuration Manager host under the highest level of security control possible.

It is also important to always test new planned application deployments in a controlled lab environment, or on a small client collection, before deploying to the entire client base.

**Network share for all clients**

The Configuration Manager console is used to deploy applications to client devices. Some of the applications require specification of files by file path and name. The client devices must have access to the files when the applications run. For instance, to upload a FortiClient XML configuration file to a given client collection, all client devices in the collection must independently have local access to the new XML configuration file.

The files may be provided by any suitable method. Examples include use of an HTTP or FTP server. The examples in this document use a network share. This should be available to all devices on the given client collection.
Task sequences

The Configuration Manager provides task sequences as a means of deploying commands to discovered clients without requiring user intervention. The FortiClient configuration examples in this chapter use the Run Command Line task sequences to run various command-line commands on client devices.

Here is a simple example of how task sequences may be used to control client devices.

In this example, a simple set of command-line commands are created in the Configuration Manager console. Once deployed, the commands will print information requested to the log file for each client.

The following commands will be executed on each client:

```plaintext
cd
dir c:\users
whoami
```

The first command will print the current working directory. This is likely to be `c:\windows\system32`. The second command will print the contents of the specified directory. The third command will print the name of the current user (the user under which the task sequence is running).

The output of the commands can be found in the log file on each client device at:

`C:\Windows\CCM\Logs\smsts.log`

To create a new task sequence:

1. Launch the Configuration Manager console. The Configuration Manager console opens.

   **Figure 4:** SCCM configuration manager

   ![SCCM configuration manager](image)


3. Right-click the Task Sequence menu item and select Create Task Sequence.
Alternatively, you can select *Create Task Sequence* in the toolbar.

The *Create Task Sequence Wizard* opens.

4. Select the *Create a new custom task sequence* radio button. Then select *Next* to proceed.
5. Enter a name for the task sequence.
6. Enter a comment to describe the task sequence.
7. Select *Next* to proceed. A summary of the task sequence configuration is displayed.
8. Select Close to save the configuration. The new task sequence is created and displayed in the Configuration Manager console.

9. Select Task Sequences in the menu in the left pane of the Configuration Manager console. The new task sequence is displayed in the right pane.

To add individual tasks into the task sequence:

1. Right-click in the newly created task sequence.

2. From the shortcut menu list, select Edit. The Task Sequence Editor dialog box is displayed. Alternatively, select the Task Sequence and select the Edit icon in the toolbar.

3. Select the Add drop-down button.

4. From the drop-down list, select General and the select Run Command Line. A new tab is displayed in the right pane of the dialog box.

5. Configure the following settings:

<table>
<thead>
<tr>
<th>Name</th>
<th>Enter a name for the command.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Enter a description for the command.</td>
</tr>
<tr>
<td>Command line</td>
<td>Enter the command line in the text field.</td>
</tr>
<tr>
<td></td>
<td>The command will usually start with “cmd /c”. For instance, the first command in this example is entered as:</td>
</tr>
<tr>
<td></td>
<td><code>cmd /c cd</code></td>
</tr>
<tr>
<td></td>
<td><code>cmd /c dir c:\users</code></td>
</tr>
<tr>
<td></td>
<td><code>cmd /c whoami</code></td>
</tr>
</tbody>
</table>

6. Select Apply to apply the configuration.

7. Select OK to continue.
The task sequence will be saved with the three command-line tasks. To view or modify the tasks, select Edit in the short-cut menu for the selected task sequence.

There are three commands in this example. Each of the commands may be created as a single task. There will be a total of three tasks in the left pane of the dialog box. Each of the tasks will have one of the command-line commands:

```
cmd /c cd
cmd /c dir c:\users
cmd /c whoami
```

This format is preferred as it isolates any client errors to a specific task.

The three commands may also be combined into a lengthy single command:

```
cmd /c cd ; dir c:\users ; whoami
```

This format may mask task sequence errors. It is not recommended.

There is also an option to use a batch script.

**Deploy the task sequence:**

1. Right-click the task sequence.
2. Select Deploy in the right-click menu list. The **Deploy Software Wizard** dialog box opens.

**Figure 9:** Deploy software wizard dialog box

Alternatively, select the Task Sequence and select the Deploy icon in the toolbar.

3. Select Browse. A **Browse Collections** dialog box appears listing all currently configured client collections.
4. Select the client collection to which this task sequence should be deployed
5. Select OK to close the Browse Collections dialog box. Pressing CTRL returns you to the General tab of the Deploy Software Wizard dialog box.
6. Select Next. The Deployment Settings tab is displayed
7. In the Purpose drop-down menu select Required. This makes the task mandatory for all clients receiving it.
8. Select the Send wake-up packets checkbox to enable this feature.
9. Select Next. The Scheduling tab is displayed
10. Select New. In the Assignment Schedule dialog box select the Assign immediately after this event radio button.
11. Select OK. This closes the Assignment Schedule dialog box. The Scheduling tab is displayed.
12. Select Next. The User Experience tab is displayed.
13. Select the Show Task Sequence progress checkbox to enable this feature.
   This configuration is optional. It displays a progress dialog box on each client as the task executes. If a silent background execution of tasks is desired, leave this checkbox unchecked.
14. Select Next. The Distribution Points tab is displayed. For this example, there is nothing to change in this tab.
15. Select Next. The Summary tab is displayed.
16. Select Next. The Completion tab is displayed which shows a summary of all selections.
17. Select Close to close the Deploy Software Wizard.

This completes the deployment of the task sequence to the selected client collections. Client devices in the collection should start to receive and execute the task. All clients will run the task within the Policy Polling Interval configured.
Monitor a deployed task sequence:
1. Launch the Configuration Manager console.
2. Select Monitoring from the tree-menu.
3. Select the Overview menu item in the left pane to expand the menu.
4. Select the Deployments menu item. The list of deployments is displayed in the right pane.
5. Click to select the recently deployed task sequence in the right pane. The Deployments window is displayed.

Figure 11: Deployment window

To monitor a deployed task sequence on the client device, use the following process:
1. Launch the Software Center console on the client device. It displays a list of tasks deployed to it.

If a recently deployed task sequence is not displayed, most likely the Policy Polling Interval is yet to expire on this client.

2. Select the Task Sequence. The current status is displayed.

In addition to the two monitoring procedures above, the client log file is available on the client device at:

C:\Windows\CCM\Logs\smsts.log
It will contain details of the task sequence, including:

- the command-line commands executed
- any output generated by the commands
- any error messages

**Mapping a network drive**

When a file is referenced in a task sequence, it must be made available to all clients before the task sequence starts. The processes listed below explain how to map a network folder to a drive in a given task sequence. If the mapping is successful, all the files in the shared folder will be available for the command-line commands in the task sequence.

**To map a network drive in the task sequence:**

1. Create a new custom task sequence.
2. Edit the task sequence. The Task Sequence Editor dialog box is displayed.

![Figure 12: Task sequence editor dialog box](image)

3. Select the Add drop-down button.
4. In the drop-down list, select General > Connect to Network Folder. A new tab is displayed in the right pane of the dialog box.
5. Type a name for the command.
6. Type a description for the command.
7. Type the full path to the network shared folder or use the Browse button to select it.

When using the Browse button, be sure that the network share is being reported with the same path as the client devices will use.

Here is an example of a valid path: `\172.21.85.245\accounts_dept`
8. Type a drive letter, along with a colon.
   For example: G:
9. Select Set and provide a user name and password that is valid for the network shared folder selected.
10. Select OK to return to the Task Sequence Editor dialog box.
11. Select Apply to save the task.

More tasks may be added to the task sequence as described in earlier parts of this section.
Tasks may be re-ordered using the other buttons provided in the top of the left pane in the Task Sequence Editor dialog box.

When all tasks have been added, select OK to close the dialog box.

Task sequence examples for FortiClient

The task sequence processes described in the preceding section may be applied to any regular Windows tasks that runs on the command line. This section discusses several example FortiClient configurations that could be completed from the Windows command-line.

The examples in this section list only the command-line commands to be used. When deploying these from the Configuration Manager console, remember to always use the processes discussed this chapter to create the task sequence. The procedure is the same, only the contents of the Run Command Line commands will differ.

**Install FortiClient**

FortiClient can be installed from the command line using **msiexec**. In this example, a FortiClient MSI file that is provided on a network shared folder is used to install FortiClient to devices in the client collection.

Use the following commands in a task sequence to install FortiClient on a Windows client device.

1. Connect to a network folder:
   - Name: map_network_drive
   - Description: Mount a network shared directory that contains the FortiClient image to install
   - Path: \172.21.85.245\accounts_dept
   - Drive: G:
   - Account: vNexttest\administrator

2. Run command line:
   - Name: copy_fct_image
   - Description: Copy FortiClient MSI image from network shared directory
   - Command line: cmd /c copy /y G:\FortiClient.msi c:\temp\FortiClient.msi

3. Run command line:
   - Name: install_fct
   - Description: Install FortiClient using MSI image
   - Command line: cmd /c msiexec /i c:\temp\FortiClient.msi /qn

Ensure that the FortiClient.msi file is available in the network share, and that the network share is accessible to all client devices in the client collection before deploying this task sequence.
Export the FortiClient XML configuration file

FortiClient features may be controlled using an XML configuration file. The configuration file is first exported from FortiClient, modified with a text editor, and re-imported into FortiClient. The XML configuration syntax and usage is documented in the FortiClient v5.2 XML Reference.

Use the following commands in a task sequence to export the XML configuration file from a Windows client device which has FortiClient installed.

1. Connect to a network folder:
   - Name: map_network_share
   - Description: Mount a network shared directory to which configuration file will be copied.
   - Path: \172.21.85.245\engineering_dept
   - Drive: M:
   - Account: vNexttest\administrator

2. Run command line:
   - Name: export_fct_xml
   - Description: Export the FortiClient XML configuration file
   - Command line: cmd /c C:\Program Files\Fortinet\FortiClient\fcconfig -o export -f c:\temp\fct_xml.conf

3. Run command line:
   - Name: copy_fct_xml
   - Description: Copy FortiClient XML file to network shared directory
   - Command line: cmd /c copy /y c:\temp\fct_xml.conf M:\

This copies fct_xml.conf to the mounted share. If there is more than one device in the client collection, they will each overwrite the same file. You may use a batch script to uniquely rename the file as it is copied.

The full path to the FortiClient installation directory is used as a prefix to FCConfig.exe. The value provided in this example is the default on a 32-bit system. The default on 64-bit systems is:

C:\Program Files (x86)\Fortinet\FortiClient

If the client collection has a mixture of both 32-bit and 64-bit devices, a batch script may be used to selectively run from the correct platform-dependent directory.

Import a modified XML configuration file

Use the following commands in a task sequence to import an XML configuration file into FortiClient in a Windows client device.

1. Connect to a network folder:
   - Name: map_network_share
   - Description: Mount a network shared directory that contains the XML configuration file
   - Path: \172.21.85.245\engineering_dept
   - Drive: M:
   - Account: vNexttest\administrator
2. Run command line:
   Name: copy_fct_xml
   Description: Copy FortiClient XML configuration file from network shared directory
   Command line: cmd / c copy /y M:\fct_xml.conf c:\temp\n
3. Run command line:
   Name: import_fct_xml
   Description: Import the FortiClient XML configuration file
   Command line: cmd /c “C:\Program Files\Fortinet\FortiClient\fcconfig -o import -f c:\temp\fct_xml.conf”
   The same configuration file is used by all devices in the client collection.

When deploying a custom FortiClient XML configuration, use the advanced Endpoint Profile options in FortiGate to ensure the Endpoint Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient v5.2 XML Reference and the CLI Reference for FortiOS 5.2.

Upgrade FortiClient
The FortiClient upgrade process is similar to the regular installation. The only difference is the use of a different version of FortiClient during the installation. A reboot is required, but the task sequence should handle this properly.

The same procedure listed earlier for FortiClient installation could be reused.

Uninstall FortiClient
Use the following command in a task sequence to uninstall FortiClient from Windows client devices.
1. Run command line:
   • Name: uninstall_fct
   • Description: Uninstall FortiClient
   • Command line: wmic product where name="FortiClient" call uninstall /nointeractive
   The task sequence should process the required reboot correctly.
Endpoint Management

Introduction

The purpose of this section is to provide basic instructions on how to configure, deploy, and manage FortiClient configurations from your FortiGate device.

Endpoint Management requires FortiClient version 5.0/5.2 and a FortiGate device running FortiOS version 5.0/5.2, or a FortiCarrier device running FortiOS Carrier version 5.0/v5.2.

Endpoint Management is available on FG-30D model series and higher.

FortiOS version 5.2 can manage both FortiClient version 5.2 and FortiClient version 5.0 registrations. Certain features are only available in FortiClient version 5.2.

Configure endpoint management

In FortiOS version 5.0 or later, configuration and management of FortiClient endpoint agents are handled by FortiGate. You can configure your FortiGate device to discover new devices on your network, enforce FortiClient registration, and deploy a pre-configured FortiClient profile to connected devices. The FortiClient profile can be deployed to devices on your network and over a VPN connection. You can configure multiple FortiClient profiles. The FortiClient profile consists of the following sections:

- Antivirus Protection
- Web Category Filtering
  You can select the web filtering security profile to associate with the FortiClient profile. You can also select to enable Web Filtering when the client is protected by the FortiGate (On-Net).
- VPN
  Select to enable client VPN provisioning. You can specify the VPN name, type, gateway and other settings the client will use to connect to your FortiGate device via the VPN connection. Two-factor authentication is configured in the FortiGate VPN configuration.
- Application Firewall
  You can select the application control sensor to associate with the FortiClient profile.
• Endpoint Vulnerability on Client
  You can select to scan daily, weekly or monthly. You can also select to scan the client after registration with your FortiGate device. Vulnerability Scan must be enabled via the CLI in order for it to be displayed in the FortiClient Profile.

• Upload logs to FortiAnalyzer/FortiManager
  You can select to use the same IP address as the FortiGate device or specify a different device IP address. You can specify the frequency of the log upload. FortiClient must be registered to FortiGate to upload logs to FortiAnalyzer/FortiManager.

• Use FortiManager for client software/signature update
  Select to enable this feature and enter the IP address of your FortiManager device. You can select to failover over to the FortiGuard Distribution Network (FDN) when the FortiManager is not available.

• Dashboard Banner
  You can select to display or hide the FortiClient advertisement banner. FortiClient ads are downloaded from the FortiGuard Distribution Servers.
  Select if profile details may be displayed before endpoint control registration is completed.

• Client-based Logging when On-Net
  Select to enable client-based logging when protected by the FortiGate (On-Net).

When FortiClient is On-Net, the icon displayed to the left of the username will be green. When FortiClient is Off-Net, the icon is grey.

See the FortiOS Handbook for more information on configuring your FortiGate device.

**Configure Endpoint Management on the FortiGate device:**

1. Enable device management and broadcast discovery messages.
   To configure Device Management, go to System > Network > Interfaces, select the applicable interface, and select Edit in the toolbar. In the Edit Interface page you can select to enable Detect and Identify Devices. To enable Broadcast Discovery Messages (optional) you must first enable FCT-Access under Administrative Access. Select OK to save the setting.

Broadcast Discovery Messages is an optional configuration. When enabled, the FortiGate will broadcast messages to your network, allowing client connections to discover the FortiGate for FortiClient registration. Without this feature enabled, the user will enter the IP address or URL of the FortiGate to complete registration.
Configure the following settings:

**Administrative Access**
Select the checkbox for FCT-Access. This option is available for both IPv4 and IPv6 Administrative Access.

**Security Mode**
Select None or Captive Portal. When selecting Captive Portal, users are forwarded to a captive portal where they need to enter their username and password to authenticate with the FortiGate. You can customize the portal message and specify user groups.

This option is available when Addressing mode is set to Manual.

**Device Management**

**Detect and Identify Devices**
Select to detect and identify devices on the selected interface.
When configuring FortiClient access on an internal interface, you can select to send users to a captive portal.

**Figure 14:** Security Mode settings

<table>
<thead>
<tr>
<th>Security Mode</th>
<th>Select Captive Portal from the drop-down list</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authentication Portal</td>
<td>Select either Local or External. When selecting External, you can specify the link path.</td>
</tr>
<tr>
<td>User Groups</td>
<td>Select user groups from the drop-down list. FortiClient does not support nested groups in FortiOS.</td>
</tr>
<tr>
<td>Exempt List</td>
<td>Select an exempt list from the drop-down list.</td>
</tr>
<tr>
<td>Customize Portal Messages</td>
<td>Enable and select the edit icon to edit the portal replacement message.</td>
</tr>
</tbody>
</table>

**Figure 15** shows the captive portal replacement message editor.
Configure the FortiClient profile:

1. To configure the FortiClient Profile, go to User & Device > FortiClient Profiles. You can edit the default profile or create a new FortiClient profile.

The option to assign the profile to device groups, user groups, and users is only available when selecting to create a new FortiClient profile. You can assign the profile to user groups and users when using Active Directory authentication or RADIUS authentication for VPN.

In FortiOS version 5.0.3 or later, you will need to enable Multiple Security Profiles in the Feature Settings to create a new FortiClient profile.

When registering to a FortiGate device, FortiClient will receive the configured FortiClient profile. The FortiClient configuration is overwritten by the FortiClient profile settings. When selecting to unregister FortiClient, the settings will reflect that of the FortiClient profile.
2. Configure the following settings:

<table>
<thead>
<tr>
<th>Toolbar Options</th>
<th>FortiClient Profile page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select <strong>Create New</strong> to create a new FortiClient profile. Select a profile in the list and select <strong>Edit</strong> to edit the FortiClient Profile. Select a profile in the list and select <strong>Delete</strong> to delete the FortiClient Profile.</td>
<td></td>
</tr>
<tr>
<td><strong>Edit FortiClient Profile page</strong></td>
<td></td>
</tr>
<tr>
<td>Select the create new icon to create a new FortiClient profile. Select the clone icon to create a clone of an existing FortiClient profile. Select the view list icon to view FortiClient profiles and assignment.</td>
<td></td>
</tr>
<tr>
<td><strong>Profile Name</strong></td>
<td>When editing the default profile, the name cannot be changed. When creating a new FortiClient profile, XSS vulnerability characters are not allowed. Enter a name for the new FortiClient profile.</td>
</tr>
<tr>
<td><strong>Comments</strong></td>
<td>Enter a profile description. (optional)</td>
</tr>
</tbody>
</table>
### Assign to Profile To:

- **Device Groups:** Select device groups in the drop-down list. Use the add icon to assign multiple device groups to the FortiClient profile, for example Mac and Windows PC.
- **User Groups:** Select user groups in the drop-down list. Use the add icon to assign multiple user groups to the FortiClient profile.
- **Users:** Select users in the drop-down list. Use the add icon to assign multiple users to the FortiClient profile.

These options are only available when creating a new FortiClient profile.

You can assign the profile to user groups and users when using Active Directory authentication or RADIUS authentication for VPN.

FortiClient does not support nested groups in FortiOS.

---

### FortiClient Configuration Deployment

#### Windows and Mac

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>AntiVirus Protection</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td><strong>Web Category Filtering</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td></td>
<td>When enabled, you can select a web filter profile in the drop-down list.</td>
</tr>
<tr>
<td></td>
<td>Select the checkbox to disable web category filtering on the client when</td>
</tr>
<tr>
<td></td>
<td>protected by the FortiGate (On-Net).</td>
</tr>
<tr>
<td><strong>VPN</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td></td>
<td>Select the checkbox for Client VPN Provisioning. When enabled, you can</td>
</tr>
<tr>
<td></td>
<td>configure multiple IPsec VPN and SSL VPN connections.</td>
</tr>
<tr>
<td></td>
<td>Use the add icon to add additional VPN connections.</td>
</tr>
<tr>
<td></td>
<td>Enter the VPN name, type, remote gateway, and authentication method</td>
</tr>
<tr>
<td></td>
<td>information.</td>
</tr>
<tr>
<td></td>
<td>Select the checkbox to auto connect to a VPN when the client is Off-Net.</td>
</tr>
<tr>
<td></td>
<td>Select a VPN from the drop-down list.</td>
</tr>
<tr>
<td><strong>Application Firewall</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td></td>
<td>When enabled, you can select an application control sensor in the drop-down</td>
</tr>
<tr>
<td></td>
<td>list.</td>
</tr>
<tr>
<td><strong>Endpoint Vulnerability Scan on Client</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td></td>
<td>When enabled, you can select the scheduled scan type to daily, weekly, or</td>
</tr>
<tr>
<td></td>
<td>monthly.</td>
</tr>
<tr>
<td></td>
<td>Select the checkbox to initiate a scan after client registration with the</td>
</tr>
<tr>
<td></td>
<td>FortiGate.</td>
</tr>
<tr>
<td></td>
<td>Vulnerability Scan must be enabled via the CLI in order for it to be</td>
</tr>
<tr>
<td></td>
<td>displayed in the FortiClient Profile.</td>
</tr>
</tbody>
</table>
3. Select **Apply** to save the FortiClient profile setting.

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the *FortiClient XML Reference* and the *CLI Reference for FortiOS*.

For information on configuring firewall policies for Endpoint Management, see the *FortiOS Handbook - The Complete Guide for FortiOS*.

**Configure firewall policies (Optional):**

1. To configure a firewall policy for **Endpoint Management**, go to **Policy & Objects > Policy** and select **Create New** in the toolbar.

   The **New Policy** window is displayed.
2. Configure the policy as required. Select the source user(s) and source device types from the drop-down list.

3. Toggle *Compliant with FortiClient Profile* to *ON*. Users will be redirected (via a web browser) to a dedicated portal where they can download the client. Once registered to the FortiGate, the FortiClient profile will be assigned.

You can create policies for users and devices which will be captive portal exempt.
4. Select OK to save the rule.

After the FortiGate configuration has been completed, you can proceed with FortiClient configuration. Configure your Windows PC on the corporate network with the default gateway set to the IP address of the FortiGate.

FortiClient endpoint network topologies

The following FortiClient Profile topologies are supported:

- 1: Client is directly connected to FortiGate; either to a physical port, switch port or WiFi SSID.

  This topology supports client registration, configuration sync, and FortiClient profile enforcement.

- 2: Client is connected to FortiGate, but is behind a router or NAT device.

  This topology supports client registration and configuration sync.

- 3: Client is connected to FortiGate across a VPN connection.

  This topology supports client registration, configuration sync, and FortiClient profile enforcement.

**Figure 18:** Network topologies

When creating a device policy, if Device Management > Detect and Identify Devices is not enabled on the incoming interface you will be prompted a confirmation dialog box with the option to Enable Device Identification.
Configure FortiClient for Endpoint Management:

1. Download and install the FortiClient software.

   Open a web browser from your workstation and attempt to open a web page, the web page will be directed to the NAC Download Portal. Follow the instructions in the portal to download and install FortiClient.

To allow users to download FortiClient, you must enable this setting in the SSL VPN Portal on your FortiGate device. To enable this feature, go to VPN > SSL > Portals and select Create New in the toolbar.

Figure 19: NAC download portal block page

To configure NAC download portal endpoint control replacement messages, go to System > Config > Replacement Message. Select Extended View in the toolbar to display Endpoint Control replacement messages for Android, iOS, Mac, Windows, and other.
2. Register FortiClient.

After FortiClient completes installation, FortiClient will automatically launch and search for a FortiGate device for registration.

There are four ways that the FortiClient/FortiGate communication is initiated:

- FortiClient will attempt to connect to the default gateway IP address;
- FortiClient will attempt endpoint control registration over VPN (if configured on the FortiGate);
- FortiClient will attempt to connect to a remembered FortiGate;
- FortiClient will attempt to connect to a redundant FortiGate.

FortiClient will search for available FortiGate devices to complete registration. You can include the option to prompt the user to enter the FortiClient registration key password. Select the Register to FortiGate button in the FortiClient console to retry the search.

Figure 20: Registering to FortiGate dialog box

If FortiClient is unable to detect a FortiGate device, enter the IP address or URL of the device and select the Go icon. When FortiClient locates the FortiGate, you will be prompted to confirm the registration. Select the Accept button to complete registration. Upon successful registration, the FortiGate will send the FortiClient profile configuration.

3. Deploy the FortiClient profile from the FortiGate device.

The FortiGate will deploy the FortiClient profile after registration is complete. This FortiClient profile will permit traffic through the FortiGate. A system tray bubble message will be displayed once update is complete.

Your personal computer’s default gateway IP address should be configured to be the IP address set in the FortiGate interface.
The FortiClient console will display that it is successfully registered to the FortiGate. The FortiClient profile is installed on FortiClient.

Deploy the FortiClient profile to clients over a VPN connection:

1. In the FortiClient console, select the Register to FortiGate button. Enter the IP address and port number (if required) of the FortiGate’s internal interface and select the Go icon.
2. Configure an IPsec VPN connection from FortiClient to the management FortiGate.
3. Connect to the VPN.
4. You can now search for the FortiGate gateway.
5. After registration, the client is able to receive the FortiClient profile.

When creating a new FortiClient VPN (IPsec) or SSL VPN tunnel configuration on your FortiGate device, you must enable Endpoint Registration. See the IPsec VPN for FortiOS and SSL VPN for FortiOS sections of the FortiOS Handbook for more information.
Configuring endpoint registration over a VPN

FortiGate units can register FortiClient-equipped endpoints over either an interface-based IPsec VPN or a tunnel-mode SSL VPN. After the user authenticates, the FortiGate unit sends the FortiClient application the IP address and port to be used for registration. If the user accepts the FortiGate invitation to register, registration proceeds and the FortiClient profile is downloaded to the client.

Users without FortiClient Endpoint Security connecting to the SSL VPN through a browser can be redirected to a captive portal to download and install the FortiClient software. The security policy must enable Compliant with FortiClient Profile and disable Captive Portal Exempt.

Endpoint registration on an IPsec VPN

You can enable endpoint registration when you configure the FortiClient VPN or you can enable it on an existing FortiClient VPN.

To enable endpoint registration while configuring the VPN:
Enable Allow Endpoint Registration on the Network page of the VPN Wizard when creating the FortiClient VPN.

To enable endpoint registration on an existing VPN:
1. Go to System > Network > Interfaces and edit the VPN’s tunnel interface.
   The tunnel is a subinterface of the physical network interface.
2. In Administrative Access, make sure that FCT-Access is enabled.
3. Select OK.

Endpoint registration on the SSL VPN

To enable endpoint registration on the SSL VPN:
1. Go to VPN > SSL > Portal.
2. Make sure Enable Tunnel Mode is enabled.
3. Optionally, enable Include FortiClient Download.
   Users who access the VPN with a browser will be able to download FortiClient Endpoint Security for their device.
4. Select Apply.

Remembered FortiGates

FortiClient version 5.0.1 or later adds the option to remember up to 20 FortiGate devices when accepting the broadcast registration message. FortiClient can remember and register to multiple FortiGate devices. This feature enables users to move freely between office locations and register conveniently to each FortiGate device.

When prompted to enter a registration key, FortiClient can remember the registration password.
Figure 23: Option to remember FortiGate

Select the registration button in the console to view information for the current registered device including the IP address, serial number, endpoint user, domain, and hostname.

Figure 24: Remembered FortiGates

Forget a remembered FortiGate:
1. In the FortiClient console, click on the registered device name to display the registration dialog box.
2. Select Show Remembered FortiGate to show a list of FortiGate devices that FortiClient has previously registered with.
3. Select the device that you would like to remove from the remembered FortiGates list and select the Forget link.
Figure 25: Remembered FortiGates list

When selecting to forget a FortiGate, FortiClient will not automatically register to the FortiGate when re-connecting to the network. When the FortiGate is detected, you will be prompted to accept registration.

Unregister from FortiGate:

1. In the FortiClient console, click on the registered device name to display the registration details. The Registration dialog box appears.

Figure 26: Registration dialog box

2. Select Unregister in the registration dialog box. A confirmation dialog box is displayed.

Figure 27: Confirmation dialog box

3. Select Yes to unregister FortiClient from the FortiGate selected.

When selecting to unregister from FortiGate, FortiClient will automatically register with the FortiGate when re-connecting to the network. To prevent this behavior, you must select to Forget the device.

Roaming clients (multiple redundant gateways) example

The following figure illustrates three corporate FortiGate networks. Each FortiGate can reach each other over a WAN network. FortiClient can only reach one FortiGate at a time. FortiClient may connect directly to the FortiGate or through a NAT device.
If FortiClient connects through a NAT device to the FortiGate, do not enforce endpoint control compliance on the FortiGate.

On each of the three FortiGate devices configure the following:

- Interface IP addresses
- FortiClient profile
- Device identification in the interface
- FortiClient profile in the applicable firewall policy
- Endpoint control synchronization

Endpoint control synchronization allows you to synchronize endpoint control for multiple FortiGate devices. To enable endpoint control synchronization via the CLI enter the following commands on your FortiGate:

```plaintext
config endpoint-control forticlient-registration-sync
edit 1
    set peer-ip 172.20.52.19
next
edit 2
    set peer-ip 172.22.53.29
end
end
```

The IP addresses set for the `peer-ip` field are the WAN IP addresses for each of the FortiGate devices in the synchronization group.
You need to add the following XML configuration to FortiClient for this synchronization group. Modify the configuration file to add the following:

```xml
<forticlient_configuration>
    <endpoint_control>
        <!-- List of redundant FortiGates, since 5.0.2 -->
        <fortigates>
            <fortigate>
                <name>Corporate Network</name>
                <addresses>10.18.51.9;10.20.52.19;10.22.53.29</addresses>
            </fortigate>
        </fortigates>
    </endpoint_control>
</forticlient_configuration>
```

The IP addresses are the internal IP addresses for each of the three FortiGates in the synchronization group. FortiClient can reach any of these IPs, one at a time.

If the three FortiGate devices share the same DNS name, use the following XML configuration:

```xml
<forticlient_configuration>
    <endpoint_control>
        <!-- List of redundant FortiGates, since 5.0.2 -->
        <fortigates>
            <fortigate>
                <name>Fortinet Americas</name>
                <addresses>fct_americas.fortinet.com</addresses>
            </fortigate>
        </fortigates>
    </endpoint_control>
</forticlient_configuration>
```

The DNS server should return one reachable FortiGate IP address for the domain name used. You will need to manually add FortiClient to the synchronization group when FortiClient initially registers with the FortiGate. Once added, no further action is required.

On your FortiGate, use the following CLI command to list all registered FortiClient endpoints:

```
diagnose endpoint registration list registered-forticlients
FortiClient #1 (0):
  UID                      = BE6B76C509DB4CF3A8CB942AED200000
  vdom                     = root
  status                   = registered
  registering time         = Fri May 2 15:00:07 2014
  registration expiry time = none
  source IP                = 172.172.172.111
  source MAC               = b0:ac:6f:70:e0:a0
  user                     = user
  host OS                  = Microsoft Windows 7, 64-bit
  restored registration    = no
  remote registration      = yes
  registration FGT         = FGT60C3G11000000
  Total number of licences: 10
  Total number of granted licenses: 1
```
Total number of available licences: 9

The remote registration entry indicates whether this specific FortiClient is registered to this FortiGate, or to another FortiGate within the synchronization group.

If any of the FortiGate devices require a password to complete registration, you can use the following XML configuration to provide password information to FortiClient:

```xml
<forticlient_configuration>
  <endpoint_control>
    <!-- List of redundant FortiGates, since 5.0.2 -->
    <fortigates>
      <fortigate>
        <name>Corporate Network</name>
        <addresses>10.18.51.9;10.20.52.19;10.22.53.29</addresses>
        <registration_password>uNNbre@kable</registration_password>
      </fortigate>
    </fortigates>
  </endpoint_control>
</forticlient_configuration>
```

View FortiClient registration in the FortiGate Web-based Manager

You can view all registered FortiClient agents in the FortiGate Web-based Manager. Each new registration will be automatically added to the device table. To view registered devices go to User & Devices > Device > Device Definitions. The state for the new FortiClient registration is listed as registered. Alternatively, go to User & Device > Monitor > FortiClient.

**Figure 29:** FortiGate device details

Configure the FortiGate IP address in FortiClient for registration

The FortiClient administrative user can specify a FortiGate IP address for registration and client configuration management. When an unregistered FortiClient starts up, FortiClient will list all reachable FortiGates for endpoint control registration in the registration drop-down list. The list will include any FortiGate that sends endpoint control broadcasts. Select the registration button in the FortiClient console to list discovered FortiGates. Any IP address provided in the Settings page under the Registration element is included in the list.
To configure a FortiGate IP address in FortiClient, select the *Register to FortiGate* button in the FortiClient console. In the *Specify Address* field, enter the IP address and port number (if required) of the FortiGate’s internal interface, and select the *Go* icon.

**Figure 30:** Configure FortiGate in FortiClient

The FortiClient settings are locked, and cannot be modified after registration to a FortiGate is completed.

### Enable FortiClient endpoint registration key password (optional)

You can configure a registration key password for FortiClient endpoint registration. Upon registering to FortiGate, the user will need to enter the registration key password before registration can be completed.

**Enable registration key password requirement on registration:**

1. On your FortiGate device, go to *System > Config > Advanced*.
2. Under *FortiClient Endpoint Registration*, select *Enable Registration Key for FortiClient* and enter a registration key password.

**Figure 31:** Enable FortiClient endpoint registration key password on FortiGate

The FortiClient settings are locked, and cannot be modified after registration to a FortiGate is completed.
3. Select **Apply** to save the setting.

   Alternatively, you can configure this via the CLI. On your FortiGate device, go to **System > Dashboard > Status**. Enter the following CLI command in the **CLI Console** widget:

   ```
   config endpoint-control settings
   set forticlient-key-enforce enable
   set forticlient-reg-key <password>
   end
   ```

4. When FortiClient users attempt to register with FortiGate, they will receive the Registering to FortiGate dialog box. The user will need to enter the registration key password you configured before they can register to FortiGate.

   **Figure 32:** Registration dialog box with registration key

   ![Registration dialog box with registration key](image)

   - FortiClient users can select to remember the registration key password in this page.

---

### Display or hide the FortiClient profile details

You can select to display or hide the FortiClient profile details in the Registering to FortiGate page. When disabled, the user will not be able to view the profile details prior to completing registration to FortiGate.

**To display or hide the FortiClient profile details:**

1. On your FortiGate device, go to **System > Dashboard > Status**.
2. Enter the following the CLI command in the CLI Console widget:
   ```
   config endpoint-control profile
   edit <profile name>
   config forticlient-winmac-settings
       set view-profile-details {enable | disable}
   end
   end
   ```

**Update FortiClient registration license on FortiGate**

To update the FortiClient registration license on FortiGate, use the following CLI command:

```
execute FortiClient-NAC update-registration-license <license key/activation code>
```

**Endpoint registration with Active Directory (AD) user groups**

The user’s AD domain name and group are both sent to the FortiGate during endpoint registration. Administrators may configure the FortiGate to deploy endpoint and/or firewall profiles based on the end user’s AD domain group. This feature requires FortiClient version 5.0.4 or later and FortiOS version 5.0.3 or later.

The following steps are discussed in more details:

- Configure users and groups on your AD server
- Configure your FortiAuthenticator
- Configure your FortiGate
- Connect to the FortiGate using FortiClient endpoint
- Monitoring client registrations

**Configure users and groups on your AD server**

Create the user accounts and groups on the AD server. Groups may have any number of users. A user may belong to more than one group at the same time.

**Configure your FortiAuthenticator**

Configure FortiAuthenticator to use the AD server that you created. For more information see the [FortiAuthenticator Administration Guide](#).

**Configure your FortiGate**

Configure FortiGate from the Web-based Manager as listed below.

**Add the FortiAuthenticator or Fortinet Single Sign-On Agent (FSSO):**

3. In the type field, select *Fortinet Single-Sign-On Agent*.
4. Enter the information required for the agent. This includes the name, primary and secondary IP address and password. Select an LDAP server in the drop-down list if applicable. Select *More FSSO agents* to add up to three additional agents.
5. Select OK to save the agent configuration.

**Create a user group:**
1. Go to *User & Device > User > User Groups*.
2. Select *Create New* in the toolbar. The *New User Group* window opens.

3. In the type field, select *Fortinet Single-Sign-On (FSSO)*.
4. Select members from the drop-down list.
5. Select OK to save the group configuration.

**Configure the FortiClient profile:**
1. Go to *User & Device > FortiClient Profiles*.
2. Select *Create New* in the toolbar. The *New FortiClient Profile* window opens.
3. Enter a profile name and optional comments.
4. In the User Groups drop-down list select the FSSO user group(s).
5. Configure FortiClient configuration deployment as required.
6. Select OK to save the new FortiClient profile.

Create any number of FortiClient profiles with different groups and different settings. The default profile will be assigned to users who register successfully but have no matching FortiClient profile.

Configure the firewall policy:

Configure the firewall policy as described in “Configure endpoint management” on page 39. Ensure that Compliant with FortiClient Profile is selected in the policy.

Connect to the FortiGate using FortiClient endpoint

The Microsoft Windows system on which FortiClient is installed should join the domain of the AD server configured earlier. Users may login with their domain user name.

Following this, FortiClient endpoint registrations will send the logged-in user’s name and domain to the FortiGate. The FortiGate will assign the appropriate profiles based on the configurations.
Monitoring client registrations

The following FortiOS CLI command lists information about registered clients. This includes domain-related details for the client (if any).

diagnose endpoint record-list

Record #1:
IP_Address = 172.172.172.111(1)
MAC_Address = b0:ac:6f:70:e0:a0
Host_MAC_Address = b0:ac:6f:70:e0:a0
MAC_list = b0-ac-6f-70-e0-a0;
VDOM = root
Registration status: Forticlient installed but not registered
Online status: offline
DHCP_on-net status: off-net
DHCP_server: None
FCC_connection_handle: 6
FortiClient_version: 5.1.29
AVDB_version: 22.137
FortiClient_app_signature_version: 3.0
FortiClient_vulnerability_scan_engine_version: 1.258
FortiClient_feature_version_status: 0
FortiClient_UID: BE6B76C509DB4CF3A8CB942AED2064A0 (0)
FortiClient_config_dirty: 1:1:1
FortiClient_KA_interval_dirty: 0
FortiClient_Full_KA_interval_dirty: 0
FortiClient_server_config: d9f86534f03fb6d109676ee49f6cfc09:
FortiClient_config: 1
FortiClient_iOS_server_mconf:
FortiClient_iOS_mconf:
FortiClient_iOS_server_ipsec_vpn_mconf:
FortiClient_iOS_ipsec_vpn_mconf:
Endpoint_Profile: Documentation
Reg_record_pos: 0
Auth_AD_groups:
Auth_group:
Auth_user:
Host_Name:
OS_Version: Microsoft Windows 7 , 64-bit Service Pack 1 (build 7601)
Host_Description: AT/AT COMPATIBLE
Domain:
Last_Login_User: FortiClient_User_Name
Host_Model: Studio 1558
Host_Manufacturer: Dell Inc.
CPU_Model: Intel(R) Core(TM) i7 CPU Q 720 @ 1.60GHz
Memory_Size: 6144
Installed_features: 55
Enabled_features: 21
online_records: 0; offline_records: 1
status -- none: 0; uninstalled: 0; unregistered: 1; registered: 0; blocked: 0
Antivirus

FortiClient Antivirus

FortiClient version 5.2 includes an antivirus module to scan system files, executable files, removable media, dynamic-link library (DLL) files, and drivers. FortiClient will also scan for and remove rootkits. In FortiClient version 5.2, File Based Malware, Malicious Websites, Phishing, and Spam URL protection is part of the antivirus module.

This section describes how to enable antivirus and configuration options.

Enable or disable antivirus

To enable FortiClient antivirus real-time protection, select the enable icon in the FortiClient console. To disable FortiClient antivirus real-time protection, select the disable link beside Real-time Protection Enabled in the FortiClient console.

When FortiClient is registered to FortiGate for endpoint control, antivirus is enabled and disabled in the FortiClient Profile.

If you have another antivirus program installed on your system, FortiClient will prompt the following dialog box warning that your system may lock up due to conflicts between different antivirus products.
Notifications

Select the notifications icon in the FortiClient console to view all notifications. When a virus has been detected, the notifications icon will change from gray to yellow.

Select View All in the drop-down Notifications window to view all event notifications. Event notifications include:

- AntiVirus events including scheduled scans and detected malware.
- Endpoint Control events including configuration updates received from FortiGate.
- WebFilter events including blocked web site access attempts.
- System events including signature and engine updates and software upgrades.

It is recommended to remove the conflicting antivirus product before installing FortiClient or enabling the antivirus real-time protection feature.
Select the Threat Detected link to view quarantined files, site violations, and real-time protection events.

**Scan now**

To perform on-demand antivirus scanning, select the Scan Now button in the FortiClient console. Use the drop-menu to select Custom Scan, Full Scan, Quick Scan, or Removable media Scan. The console displays the date of the last scan to the left of the button.

*Custom Scan* runs the rootkit detection engine to detect and remove rootkits. *Custom Scan* allows you to select a specific file folder on your local hard disk drive (HDD) to scan for threats.

*Full Scan* runs the rootkit detection engine to detect and remove rootkits. *Full Scan* then performs a full system scan including all files, executable files, DLLs, and drivers for threats.

*Quick System Scan* runs the rootkit detection engine to detect and remove rootkits. *Quick System Scan* only scans executable files, DLLs, drivers that are currently running for threats.

*Removable media Scan* runs the rootkit detection engine to detect and remove rootkits. *Removable media Scan* scans all connected removable media such as USB drives.
Scan a file or folder on your workstation

To perform a virus scan a specific file or folder on your workstation, right-click the file or folder and select *Scan with FortiClient AntiVirus* from the menu.

Submit a file for analysis

You can select to send up to 5 files a day to FortiGuard for analysis. To submit a file, right-click a file or executable and select *Submit for analysis* from the menu. A dialog box will be displayed which allows you to see the number of files you have submitted. Confirm the file location of the file you want to submit and select the *Submit* button.
You do not receive feedback for files submitted for analysis. The FortiGuard team is able to create signatures for any files which are submitted for analysis and determined to be malicious.

### View FortiClient engine and signature versions

To view the current FortiClient version, engine, and signature information, select Help in the toolbar, and select About in the drop-down menu. Hover the mouse over the status field to see the date and time that FortiClient last updated the selected item.

When FortiClient is registered to FortiGate for endpoint control, you can select to use a FortiManager device for client software and signature updates. When configuring the FortiClient profile, select Use FortiManager for client software/signature updates to enable the feature and enter the IP address of your FortiManager device. You can select to failover to FDN when FortiManager is not available.

You do not receive feedback for files submitted for analysis. The FortiGuard team is able to create signatures for any files which are submitted for analysis and determined to be malicious.

### View FortiClient engine and signature versions

To view the current FortiClient version, engine, and signature information, select Help in the toolbar, and select About in the drop-down menu. Hover the mouse over the status field to see the date and time that FortiClient last updated the selected item.

When FortiClient is registered to FortiGate for endpoint control, you can select to use a FortiManager device for client software and signature updates. When configuring the FortiClient profile, select Use FortiManager for client software/signature updates to enable the feature and enter the IP address of your FortiManager device. You can select to failover to FDN when FortiManager is not available.
Schedule antivirus scanning

Select the settings icon beside Status in the FortiClient console to open the antivirus settings page. To schedule antivirus scanning, select the Scheduled Scan tab in the left pane.

Figure 44: Antivirus scheduling page

Configure the following settings:

<table>
<thead>
<tr>
<th><strong>Schedule Type</strong></th>
<th>Select Daily, Weekly or Monthly in the drop-down list.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scan On</strong></td>
<td>For Weekly scheduled scan, select the day of the week in the drop-down list. For Monthly scheduled scan, select the day of the month in the drop-down list.</td>
</tr>
<tr>
<td><strong>Start</strong></td>
<td>Select the start time in the drop-down lists. The time format is represented in hours and minutes, 24-hour clock.</td>
</tr>
</tbody>
</table>
| **Scan Type**     | Select the scan type:  
  Custom Scan runs the rootkit detection engine to detect and remove rootkits. Custom Scan allows you to select a specific file folder on your local hard disk drive (HDD) to scan for threats.  
  Full Scan runs the rootkit detection engine to detect and remove rootkits. Full Scan then performs a full system scan including all files, executable files, DLLs, and drivers for threats.  
  Quick System Scan runs the rootkit detection engine to detect and remove rootkits. Quick System Scan only scans executable files, DLLs, drivers that are currently running for threats.  
  You can schedule a removable media scan. A full scan will scan removable media. |

**Disable Scheduled Scan** | Select to disable scheduled scan. |
Select OK to save the setting and return to the main FortiClient console page.

If you configure monthly scans to occur on the 31st of each month, the scan will occur on the first day of the month for those months with less than 31 days.

### Add files/folders to an exclusion list

Select the settings icon beside Status in the FortiClient console to open the antivirus settings page. To create an exclusion list, select the Exclusion List tab in the left pane. To add files/folders to the antivirus exclusion list, select Exclusion List in the content pane. Select the add icon and then select Add file or Add folder from the drop-down list. Any files or folders in this exclusion list will not be scanned. Select the minus icon to remove files or folders from the list.

**Figure 45:** Antivirus exclusion list page

Select OK to save the setting and return to the FortiClient console page.
View quarantined threats

To view quarantined threats, select the *Threats Detected* link in the FortiClient console, and select *Quarantined Files* in the left tree menu. In this page you can view, restore, or delete the quarantined file. You can also view the original file location, the virus name, submit the suspicious file to FortiGuard, and view logs.

**Figure 46: Quarantined files page**

This page displays the following:

<table>
<thead>
<tr>
<th>File Name</th>
<th>The name of the file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date Quarantined</td>
<td>The date and time that the file was quarantined by FortiClient.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select to refresh the quarantined files list.</td>
</tr>
<tr>
<td>Details</td>
<td>Select a file from the list to view detailed information including the file name, original location, date and time that the virus was quarantined, the submitted status, status, virus name, and quarantined file name.</td>
</tr>
<tr>
<td>Logs</td>
<td>Select to view FortiClient log data.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select to refresh the list.</td>
</tr>
<tr>
<td>Submit</td>
<td>Select to submit the quarantined file to FortiGuard. Press and hold the control key to submit multiple entries.</td>
</tr>
<tr>
<td>Restore</td>
<td>Select to restore the quarantined file. A confirmation dialog box will be displayed. You can select Yes to add this file/folder to the exclusion list, No to restore the file, or Cancel to exit the operation. Press and hold the control key to restore multiple entries.</td>
</tr>
</tbody>
</table>
View site violations

To view site violations, select the Threats Detected link in the FortiClient console, and select Site Violations in the left tree menu. In this page you can view site violations and submit sites to be re-categorized.

**Figure 47:** Site violations page

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete</td>
<td>Select to delete the quarantined file. A confirmation dialog box will be displayed, select Yes to continue. Press and hold the control key to delete multiple entries.</td>
</tr>
<tr>
<td>Close</td>
<td>Select to close the page and return to the FortiClient console.</td>
</tr>
</tbody>
</table>

This page displays the following:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Website</td>
<td>Displays the name of the website.</td>
</tr>
<tr>
<td>Time</td>
<td>Displays the date and time of the site violation.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select to refresh the site violation list.</td>
</tr>
<tr>
<td>Details</td>
<td>Select an entry in the list to view site violation details including the website name, category, date and time, user name, and status. Select the category link to request to have the site category re-evaluated.</td>
</tr>
</tbody>
</table>
View alerts dialog box

When FortiClient antivirus detects a virus while attempting to download a file via a web-browser, you will receive a warning dialog message.

**Figure 48:** Example virus alert dialog box

<table>
<thead>
<tr>
<th>Process</th>
<th>C:\Program Files (x86)\Mozilla Firefox\firefox.exe</th>
</tr>
</thead>
<tbody>
<tr>
<td>Item</td>
<td>c:\user\appdata\local\temp\app\1123.txt.part</td>
</tr>
<tr>
<td>Virus</td>
<td>EICAR_TEST_FILE</td>
</tr>
<tr>
<td>Status</td>
<td>Quarantined</td>
</tr>
</tbody>
</table>

Select **View recently detected virus(es)** to collapse the virus list. Select a file in the list and right-click to access the context menu.

- **Delete**
  Select to delete a quarantined or restored file.

- **Quarantine**
  Select to quarantine a restored file.

- **Restore**
  Select to restore a quarantined file.

- **Submit Suspicious File**
  Select to submit a file to FortiGuard as a suspicious file.

- **Submit as False Positive**
  Select to submit a quarantined file to FortiGuard as a false positive.

- **Add to Exclusion List**
  Select to add a restored file to the exclusion list. Any files in the exclusion list will not be scanned.

- **Open File Location**
  Select to open the file location on your workstation.

When **Alert when viruses are detected** under **AntiVirus Options** is not selected, you will not receive the virus alert dialog box when attempting to download a virus in a web browser.
**Real-time Protection events**

When an antivirus real-time protection event has occurred you can select to view these events in the FortiClient console. Select AntiVirus > Threats Detected and select Real-time Protection events in the left pane. The `realtime_scan.log` will open in the default viewer.

Example log output:

```
Realtime scan result:
time: 03/18/14 10:46:07, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\desktop\eicar.com
time: 03/18/14 10:46:07, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\desktop\eicar.com.txt
time: 03/18/14 10:46:07, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\desktop\eicarcom2.zip
time: 03/18/14 10:46:08, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\desktop\eicar_com.zip
time: 03/18/14 10:46:39, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\appdata\local\temp\3g_b18y9.com.part
time: 03/18/14 10:48:13, virus found: EICAR_TEST_FILE, action: Quarantined, c:\users\user\appdata\local\temp\xntwh8q1.zip.part
```

**Antivirus logging**

To configure antivirus logging, select File in the toolbar and Settings in the drop-down menu. Select Logging to view the drop-down menu.

**Figure 49**: Logging options

Configure the following settings:

| Enable logging for these features | Select antivirus to enable logging for this feature. |
| Log Level | Select the level of logging: |
| Log file | |

- Emergency: The system becomes unstable.
- Alert: Immediate action is required.
- Critical: Functionality is affected.
- Error: An error condition exists and functionality could be affected.
- Warning: Functionality could be affected.
- Notice: Information about normal events.
- Information: General information about system operations.
- Debug: Debug FortiClient.
Antivirus options

To configure antivirus options, select *File* in the toolbar, and *Settings* in the drop-down menu. Select *AntiVirus Options* to view the drop-down menu. In this menu you can configure options outlined in the following figure and table.

**Antivirus Options**

<table>
<thead>
<tr>
<th>Export logs</th>
<th>Select to export logs to your local hard disk drive (HDD) in <code>.log</code> format.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clear logs</td>
<td>Select to clear all logs. You will be presented a confirmation window, select Yes to proceed.</td>
</tr>
</tbody>
</table>

Configure the following settings:

**Grayware Options**

- **Grayware** is an umbrella term applied to a wide range of malicious applications such as spyware, adware and key loggers that are often secretly installed on a user’s computer to track and/or report certain information back to an external source without the user’s permission or knowledge.

**Adware**

- Select to enable adware detection and quarantine during the antivirus scan.

**Riskware**

- Select to enable riskware detection and quarantine during the antivirus scan.

**Advanced heuristics**

- Select to enable enhanced antivirus heuristics.

**Alert when viruses are detected**

- Select to have FortiClient provide a notification alert when a threat is detected on your personal computer. When *Alert when viruses are detected* under *AntiVirus Options* is not selected, you will not receive the virus alert dialog box when attempting to download a virus in a web browser.

**Pause background scanning on battery power**

- Select to pause background scanning when your personal computer is operating on battery power.

**Enable FortiGuard Analytics**

- Select to automatically send suspicious files to the FortiGuard Network for analysis.

When registered to FortiGate, you can select to enable or disable FortiClient Antivirus Protection in the FortiClient Profile.
Endpoint control

When FortiClient is registered to FortiGate for endpoint control, FortiClient receives configuration and settings via the FortiClient Profile configured on the FortiGate device.

To enable Antivirus Protection in the FortiClient Profile:
1. Log into your FortiGate.
2. In the left tree menu, select User & Device > FortiClient Profiles.
3. In the right pane, in the Edit FortiClient Profile page, in the FortiClient Configuration Deployment section, toggle the AntiVirus Protection button to ON.

Figure 51: Edit FortiClient Profile

4. Select Apply to save the profile.
   The FortiGate will send the FortiClient Profile configuration update to registered clients.

Figure 52: Configuration update was received from FortiGate.
Web Security/Web Filter

Web Security/Web Filter allows you to block, allow, warn, and monitor web traffic based on URL category or custom URL filters. URL categorization is handled by the FortiGuard Distribution Network (FDN). You can create a custom URL filter exclusion list which overrides the FDN category.

When FortiClient is not registered to FortiGate, you can enable or disable the Web Security feature. You can define what sites are allowed, blocked, or monitored and view violations.

Enable/Disable Web Security

To enable or disable FortiClient Web Security/Web Filtering, toggle the [Enable/Disable] link in the FortiClient console. Web Security is enabled by default.

Figure 53: Web Security module

<table>
<thead>
<tr>
<th>Enable/Disable</th>
<th>Select to enable or disable Web Security.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Violations (In the Last 7 Days)</td>
<td>Select to view Web Security log entries of the violations that have occurred in the last 7 days.</td>
</tr>
<tr>
<td>Settings</td>
<td>Select to configure the Web Security profile, exclusion list, settings, and view violations.</td>
</tr>
</tbody>
</table>
## Web Security profile

You can configure a Web Security profile to allow, block, warn, or monitor web traffic based on website category and sub-category. Select the settings icon and select the site category. Left-click the action icon and select the action in the menu for each category or sub-category.

**Figure 54:** Site categories

<table>
<thead>
<tr>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Allow</strong></td>
<td>Set the category or sub-category to <em>Allow</em> to allow access.</td>
</tr>
<tr>
<td><strong>Block</strong></td>
<td>Set the category or sub-category to <em>Block</em> to block access. The user will receive a Web Page Blocked message in the web browser.</td>
</tr>
<tr>
<td><strong>Warn</strong></td>
<td>Set the category or sub-category to <em>Warn</em> to block access. The user will receive a Web Page Blocked message in the web browser. The user can select to proceed or go back to the previous web page.</td>
</tr>
<tr>
<td><strong>Monitor</strong></td>
<td>Set the category or sub-category to <em>Monitor</em> to allow access. The site will be logged.</td>
</tr>
</tbody>
</table>

You can select to enable or disable *Site Categories* in the Web Security settings page. When site categories are disabled, FortiClient is protected by the exclusion list.
Web Security exclusion list

Select the settings icon and select Exclusion List from the menu. You can add websites to the exclusion list and set the permission to allow, block, monitor, or exempt. Use the add icon to add URLs to the exclusion list. If the website is part of a blocked category, an allow permission in the Exclusion List would allow the user to access the specific URL.

For more information on URL formats, type, and action, see the FortiOS Handbook available in the Fortinet Document Library.

Figure 55 shows an example Web Security exclusion list.

Figure 55: Exclusion list

Configure the following settings:

<table>
<thead>
<tr>
<th><strong>Profile</strong></th>
<th>Select to allow, block, warn or monitor traffic by category or sub-category.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Exclusion List</strong></td>
<td>Select to exclude URLs that are explicitly blocked or allowed. Use the add icon to add URLs and the delete icon to delete URLs from the list. Select a URL and select the edit icon to edit the selection.</td>
</tr>
<tr>
<td><strong>URL</strong></td>
<td>Enter a URL or IP address.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select one of the following pattern types from the drop-down list:</td>
</tr>
</tbody>
</table>

- Simple
- Wildcard
- Regular Expression
Web Security settings

To configure Web Security settings, select the settings icon and select Settings from the menu.

**Figure 56: Web Security settings**

Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable Site Categories</strong></td>
<td>Select to enable Site Categories. When site categories are disabled, FortiClient is protected by the exclusion list.</td>
</tr>
<tr>
<td><strong>Enable Safe Search</strong></td>
<td>Select to enable Safe Search.</td>
</tr>
<tr>
<td><strong>Search Engine Safe Search</strong></td>
<td>Select to enable search engine Safe Search for Bing and Yandex.</td>
</tr>
<tr>
<td><strong>YouTube Education Filter</strong></td>
<td>Select to enable the YouTube educational filter and enter your filter code. The filter blocks non-educational content as per your YouTube filter code.</td>
</tr>
<tr>
<td><strong>Log all URLs</strong></td>
<td>Select to log all URLs.</td>
</tr>
</tbody>
</table>

See [http://support.google.com/youtube/bin/answer.py?hl=en&answer=2592715](http://support.google.com/youtube/bin/answer.py?hl=en&answer=2592715) for more information on YouTube for schools and the education filter.
View violations

To view Web Security violations, select the settings icon and select Violations from the menu.

**Figure 57: Web Security logs**

<table>
<thead>
<tr>
<th>Website</th>
<th>The website name or IP address.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>The website sub-category.</td>
</tr>
<tr>
<td>Time</td>
<td>The date and time that the website was accessed.</td>
</tr>
<tr>
<td>User</td>
<td>The name of the user generating the traffic. Hover the mouse cursor over the column to view the complete entry in the pop-up bubble message.</td>
</tr>
</tbody>
</table>
Web Filter

When FortiClient is registered to a FortiGate, the Web Security module will reflect Web Filter.

**Figure 58:** Web Filter module.

You can disable *Web Category Filtering* in FortiClient from the FortiGate FortiClient profile. You can also select to enable or disable Web Filtering when the FortiClient device is On-Net. When *FortiGuard Categories* is disabled, FortiClient will be protected by the *Exclusion List* configured in the URL in the FortiClient profile.

The FortiClient Endpoint Control feature enables the site administrator to distribute a Web Filtering profile from a FortiGate device. The overall process is as follows:

- Create a Web Filter profile on the FortiGate
- Add the Web Filter profile to the FortiClient Profile on the FortiGate

**Step 1: Create a Web Filter Profile on the FortiGate**

Use the following steps to create a custom Web Filter profile on the FortiGate Web-based Manager:

1. Go to *Security Profiles > Web Filter*.
2. To create a new profile, click the create new icon in the toolbar. The *New Web Filter Profile* page opens.
3. Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>Enter a name for the Web Filter profile.</td>
</tr>
<tr>
<td><strong>Comments</strong></td>
<td>Enter a description in the comments field. (optional)</td>
</tr>
<tr>
<td><strong>Inspection Mode</strong></td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td><strong>FortiGuard Categories</strong></td>
<td>Select category and sub-category actions.</td>
</tr>
<tr>
<td></td>
<td>In FortiClient 5.2.3, the Security Risk category is part of the AntiVirus module. The Local Categories category is not applicable to FortiClient. The Authenticate and Disable actions are not applicable to FortiClient.</td>
</tr>
<tr>
<td></td>
<td>When FortiGuard Categories is disabled, FortiClient will be protected by the Exclusion List configured in the URL in the FortiClient profile.</td>
</tr>
<tr>
<td><strong>Quota on Categories</strong></td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
</tbody>
</table>

Figure 59: New web filter profile page
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Blocked Override</td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td>Search Engines</td>
<td></td>
</tr>
<tr>
<td>Enable Safe Search</td>
<td>Select to enable Safe Search.</td>
</tr>
<tr>
<td>Search Engine Safe Search</td>
<td>Select to enable search engine Safe Search for Bing and Yandex. Search engine safe search for Google and Yahoo! is currently not supported.</td>
</tr>
<tr>
<td>YouTube Education Filter</td>
<td>Select to enable the YouTube educational filter and enter your filter code. The filter blocks non-educational content as per your YouTube filter code.</td>
</tr>
<tr>
<td>Log All Search Keywords</td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td>Static URL Filter</td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td>Block Invalid URLs</td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td>Enable URL Filter</td>
<td>Select to enable URL filter. Select Create New to add a URL to the list. For Type, select one of Simple, Reg. Expression, or Wildcard. For Action, select one of Exempt, Block, Allow, or Monitor. For Status, select either Enable or Disable. FortiClient does not support the Exempt action. Any URLs in the URL filter with an exempt action will be added to the FortiClient Exclusion List with an allow action.</td>
</tr>
<tr>
<td>Web Content Filter</td>
<td>This setting is not applicable to FortiClient.</td>
</tr>
<tr>
<td>Rating Options</td>
<td>These settings are not applicable to FortiClient.</td>
</tr>
<tr>
<td>Proxy Options</td>
<td>These settings are not applicable to FortiClient.</td>
</tr>
</tbody>
</table>

4. Select OK to save the profile.

If the FortiGate device is not licensed, you will receive a dialog box advising that traffic may be blocked if this option is enabled.

**Step 2: Add the Web Filter profile to the FortiClient Profile**

1. Go to User & Device > FortiClient Profiles.
2. Select the FortiClient Profile and select Edit in the toolbar. The Edit FortiClient Profile page is displayed.
3. Toggle the *Web Category Filtering* button to **ON** and select the Web Filter profile from the drop-down list.

4. Optionally, select to enable *Client Web Filtering when On-Net*.

5. Select **Apply** to save the profile.

   The FortiGate will send the FortiClient Profile configuration update to registered clients.
The Web Filtering module is now available in FortiClient.

Figure 62 illustrates web filter profile settings received by the FortiGate endpoint control profile.

Figure 62: Web filter settings in the FortiClient profile
Application Firewall

FortiClient can recognize the traffic generated by a large number of applications. You can create rules to block or allow this traffic per category, or application.

In FortiClient version 5.2 this feature is disabled by default and the tab is hidden for standalone clients. For uses who are registered to a FortiGate using endpoint control, the FortiGate administrator may choose to enable this feature.

For more information on configuring application control security profiles, see the FortiOS Handbook - The Complete Guide to FortiOS available in the Fortinet Document Library.

In FortiClient v5.2, the application firewall feature is enabled in the FortiClient Profile. The profile includes application firewall configuration.

The FortiClient Endpoint Control feature enables the site administrator to distribute an Application Control sensor from a FortiGate device. The process is as follows:

- Create an Application Sensor and Application Filter on the FortiGate
- Add the Application Sensor to the FortiClient Profile on the FortiGate

**Step 1: Create a custom Application Control Sensor**

1. Login to your FortiGate.
2. In the left tree menu, select Security Profiles > Application Control.
3. To create a new sensor, click the Create New icon in the toolbar. The New Application Sensor page is displayed.
Configure the following options:

**Name**
Enter a unique name for the application sensor.

**Comments**
Enter an option comment for the application sensor.

**Categories**
Select categories to allow or block.

- **Allow**
The application category or application signature will be allowed in FortiClient Application Firewall.
- **Block**
The application category or application signature will be blocked in FortiClient Application Firewall.
- **Monitor**
The application category or application signature will be allowed in FortiClient Application Firewall. FortiClient will allow application traffic but will not monitor.
- **Reset**
The application category or application signature will be blocked in FortiClient Application Firewall.

**Traffic Shaping**
The application category or application signature will be allowed in FortiClient Application Firewall. FortiClient will allow application traffic but will not enforce traffic shaping settings.

**Application Overrides**
Select *Add Signatures* to add application signatures and set the category. An application which belongs to a blocked category can be set to allow.

**Options**
The options set in the FortiOS application sensor are ignored by FortiClient application firewall.

4. Select OK to save the sensor.
Step 2: Add the Application Control Sensor to the FortiClient Profile

1. In the left tree menu, select *User & Device > FortiClient Profiles*.
2. Select the FortiClient Profile and select *Edit* in the toolbar. The *Edit FortiClient Profile* page is displayed.

   **Figure 64: Edit FortiClient Profile**

   FortiClient Configuration Deployment

<table>
<thead>
<tr>
<th>Windows and Mac</th>
</tr>
</thead>
<tbody>
<tr>
<td>AntiVirus Protection</td>
</tr>
<tr>
<td>Web Category Filtering</td>
</tr>
<tr>
<td>Client Web Filtering when On-Net</td>
</tr>
<tr>
<td>VPN</td>
</tr>
<tr>
<td>Client VPN Provisioning</td>
</tr>
<tr>
<td>Application Firewall</td>
</tr>
<tr>
<td>Endpoint Vulnerability Scan on Client</td>
</tr>
<tr>
<td>Schedule Scan Type:</td>
</tr>
<tr>
<td>Daily  Weekly  Monthly</td>
</tr>
<tr>
<td>Initiate Scan After Client Registration</td>
</tr>
<tr>
<td>Upload Logs to FortAnalyzer/FortManager</td>
</tr>
<tr>
<td>Same as System</td>
</tr>
<tr>
<td>Specify</td>
</tr>
<tr>
<td>Schedule:</td>
</tr>
<tr>
<td>Hourly  Daily</td>
</tr>
<tr>
<td>Use FortManager for client software/signature update</td>
</tr>
<tr>
<td>Same as System</td>
</tr>
<tr>
<td>Specify</td>
</tr>
<tr>
<td>Fallback to FDN when FortManager is not available</td>
</tr>
<tr>
<td>Dashboard Banner</td>
</tr>
<tr>
<td>Client-based Logging when On-Net</td>
</tr>
</tbody>
</table>

3. In the right pane, toggle the *Application Firewall* button to *ON*.
4. Select the Application Sensor from the drop-down list.
5. Select *Apply* to save the profile.

   The FortiGate will send the FortiClient Profile configuration update to registered clients.

   **Figure 65: Configuration update received by FortiClient**

The Application Control module is now available in FortiClient.
View application firewall profile

To view the application firewall profile, select *Show all*.

View blocked applications

To view blocked applications, select the *Applications Blocked* link in the FortiClient console. This page lists all applications blocked in the past seven days, including the count and time of last occurrence.
IPsec VPN and SSL VPN

FortiClient supports both IPsec and SSL VPN connections to your network for remote access. You can provision client VPN connections in the FortiClient Profile or configure new connections in the FortiClient console.

This section describes how to configure remote access.

Add a new connection

Select Configure VPN in the FortiClient console to add a new VPN configuration.

Figure 68: Configure a new VPN connection

Create a new SSL VPN connection

To create a new SSL VPN connection, select Configure VPN or use the drop-down menu in the FortiClient console. In this menu you can configure options outlined in the following figure and table.
Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New VPN</strong></td>
<td>Select SSL VPN.</td>
</tr>
<tr>
<td><strong>Connection Name</strong></td>
<td>Enter a name for the connection.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description for the connection. (optional)</td>
</tr>
<tr>
<td><strong>Remote Gateway</strong></td>
<td>Enter the IP address/hostname of the remote gateway. Multiple remote</td>
</tr>
<tr>
<td></td>
<td>gateways can be configured by separating each entry with a semicolon.</td>
</tr>
<tr>
<td></td>
<td>If one gateway is not available, the VPN will connect to the next</td>
</tr>
<tr>
<td></td>
<td>configured gateway.</td>
</tr>
<tr>
<td><strong>Customize port</strong></td>
<td>Select to change the port. The default port is 443.</td>
</tr>
<tr>
<td><strong>Authentication</strong></td>
<td>Select to prompt on login, or save login. The option to disable is</td>
</tr>
<tr>
<td></td>
<td>available when Client Certificate is enabled.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>If you selected to save login, enter the username in the dialog box.</td>
</tr>
<tr>
<td><strong>Client Certificate</strong></td>
<td>Select to enable client certificates.</td>
</tr>
<tr>
<td><strong>Certificate</strong></td>
<td>Select the certificate option in the drop-down list.</td>
</tr>
<tr>
<td><strong>Do not Warn Invalid</strong></td>
<td>Select if you do not want to warned if the server presents an invalid</td>
</tr>
<tr>
<td><strong>Server Certificate</strong></td>
<td>certificate.</td>
</tr>
<tr>
<td><strong>Add</strong></td>
<td>Select the add icon to add a new connection.</td>
</tr>
<tr>
<td><strong>Delete</strong></td>
<td>Select a connection and then select the delete icon to delete a connection.</td>
</tr>
</tbody>
</table>

Select **Apply** to save the VPN connection and select **Close** to return to the Remote Access screen.
Create a new IPsec VPN connection

To create a new IPsec VPN connection, select Configure VPN or use the drop-down menu in the FortiClient console. In this menu you can configure options outlined in the following figure and table.

**Figure 70:** IPsec VPN configuration options

Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connection Name</strong></td>
<td>Enter a name for the connection.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>Select IPsec VPN.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Enter a description for the connection. (optional)</td>
</tr>
<tr>
<td><strong>Remote Gateway</strong></td>
<td>Enter the IP address/hostname of the remote gateway. Multiple remote gateways can be configured by separating each entry with a semicolon. If one gateway is not available, the VPN will connect to the next configured gateway.</td>
</tr>
<tr>
<td><strong>Authentication Method</strong></td>
<td>Select either X.509 Certificate or Pre-shared Key in the drop-down menu.</td>
</tr>
<tr>
<td><strong>X.509 Certificate, Pre-shared Key</strong></td>
<td>Select X.509 Certificate in the drop-down menu, or enter the pre-shared key in the dialog box.</td>
</tr>
<tr>
<td><strong>Authentication (XAuth)</strong></td>
<td>Select to prompt on login, save login, or disable.</td>
</tr>
<tr>
<td><strong>Username</strong></td>
<td>If you selected save login, enter the username in the dialog box.</td>
</tr>
<tr>
<td><strong>Advanced Settings</strong></td>
<td>Configure VPN settings, Phase 1, and Phase 2 settings.</td>
</tr>
</tbody>
</table>

**VPN Settings**

**IPsec VPN and SSL VPN**

Page 94  FortiClient 5.2.3 Administration Guide
<table>
<thead>
<tr>
<th><strong>Mode</strong></th>
<th>Select one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Main: In Main mode, the phase 1 parameters are exchanged in multiple rounds with encrypted authentication information.</td>
<td></td>
</tr>
<tr>
<td>• Aggressive: In Aggressive mode, the phase 1 parameters are exchanged in a single message with authentication information that is not encrypted.</td>
<td></td>
</tr>
</tbody>
</table>

Although Main mode is more secure, you must select Aggressive mode if there is more than one dialup phase 1 configuration for the interface IP address, and the remote VPN peer or client is authenticated using an identifier (local ID).

<table>
<thead>
<tr>
<th><strong>Options</strong></th>
<th>Select one of the following:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• Mode Config: IKE Mode Config can configure host IP address, Domain, DNS and WINS addresses.</td>
<td></td>
</tr>
<tr>
<td>• Manually Set: Manual key configuration. If one of the VPN devices is manually keyed, the other VPN device must also be manually keyed with the identical authentication and encryption keys. Enter the DNS server IP, assign IP address, and subnet values. Select the check box to enable split tunneling.</td>
<td></td>
</tr>
<tr>
<td>• DHCP over IPsec: DHCP over IPsec can assign an IP address, Domain, DNS and WINS addresses. Select the check box to enable split tunneling.</td>
<td></td>
</tr>
</tbody>
</table>

| **Phase 1** | Select the encryption and authentication algorithms used to generate keys for protecting negotiations and add encryption and authentication algorithms as required. You need to select a minimum of one and a maximum of two combinations. The remote peer or client must be configured to use at least one of the proposals that you define. |

| **IKE Proposal** | Select symmetric-key algorithms (encryption) and message digests (authentication) from the drop-down lists. |

| **DH Group** | Select one or more Diffie-Hellman groups from DH group 1, 2, 5 and 14. At least one of the DH Group settings on the remote peer or client must match one the selections on the FortiGate unit. Failure to match one or more DH groups will result in failed negotiations. |

| **Key Life** | Enter the time (in seconds) that must pass before the IKE encryption key expires. When the key expires, a new key is generated without interrupting service. The key life can be from 120 to 172,800 seconds. |

| **Local ID** | Enter the Local ID (optional). This Local ID value must match the peer ID value given for the remote VPN peer’s Peer Options. |

| **Dead Peer Detection** | Select this check box to reestablish VPN tunnels on idle connections and clean up dead IKE peers if required. |

| **NAT Traversal** | Select the check box if a NAT device exists between the client and the local FortiGate unit. The client and the local FortiGate unit must have the same NAT traversal setting (both selected or both cleared) to connect reliably. |
Provision client VPN connections

You can provision client VPN connections in the FortiClient Profile for registered clients.

**Provision a client VPN in the FortiClient Profile:**

1. Login to your FortiGate device.
2. In the left tree menu, select *User & Device > FortiClient Profiles*.
3. Select the FortiClient profile and select *Edit* from the toolbar.
4. In the Edit FortiClient Profile page, in the FortiClient Configuration Deployment section, toggle the VPN button to ON.
5. Select the Client VPN Provisioning checkbox.
6. Enter a name for the VPN connection.
7. Select the VPN type. Select either IPsec VPN or SSL-VPN.
8. Configure the remote gateway and authentication settings for the type of VPN selected.
9. Select the checkbox to auto-connect when off-net and select a VPN connection from the drop-down list.
10. Select Apply to save the profile.
    The FortiGate will send the FortiClient Profile configuration update to registered clients.
Figure 72: Configuration update received by FortiClient

Figure 73 illustrates VPN settings received by the FortiGate FortiClient Profile. When registered to a FortiGate, VPN settings are enabled and configured in the FortiClient Profile.

Figure 73: VPN settings in the FortiClient Profile

Alternatively, you can provision a client VPN using the advanced VPN FortiClient Profile options in FortiGate. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.
Connect to a VPN

To connect to a VPN, select the VPN connection from the drop-down menu. Enter your username, password, and select the Connect button.

**Figure 74:** Connection options

![Connection options](image)

Provisioned VPN connections will be listed under Corporate VPN. Locally configured VPN connections will be listed under Personal VPN.

Optionally, you can click on the system tray, right-click the FortiClient icon and select the VPN connection you want to connect to.

**Figure 75:** Connect from the system tray icon

![System tray icon](image)

You can also select to edit an existing VPN connection and delete an existing VPN connection using the drop-down menu.

When connected, the console will display the connection status, duration, and other relevant information. You can now browse your remote network. Select the Disconnect button when you are ready to terminate the VPN session.
This page displays the following:

### Name of the VPN connection

<table>
<thead>
<tr>
<th>Status</th>
<th>The status of the VPN connection.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Duration</td>
<td>The duration of the VPN connection.</td>
</tr>
<tr>
<td>Bytes Received</td>
<td>Bytes received through the VPN connection.</td>
</tr>
<tr>
<td>Bytes Sent</td>
<td>Bytes sent through the VPN connection.</td>
</tr>
<tr>
<td>Disconnect</td>
<td>Select to disconnect the VPN connection.</td>
</tr>
</tbody>
</table>

### Save Password, Auto Connect, and Always Up (Keep Alive)

When configuring a FortiClient VPN (IPsec) or SSL VPN connection on your FortiGate device, you can select to enable the following features:

- **Save Password**: Allows the user to save the VPN connection password in the console.
- **Auto Connect**: When FortiClient is launched, the VPN connection will automatically connect.
- **Always Up (Keep Alive)**: When selected, the VPN connection is always up even when no data is being processed. If the connection fails, keep alive packets sent to the FortiGate will sense when the VPN connection is available and re-connect.

For SSL VPN tunnel mode configurations these features are enabled/disabled in the **SSL VPN Portal**.

When enabled in the FortiGate configuration, once the FortiClient is connected to the FortiGate, the client will receive these configuration options.
For FortiClient VPN configurations, once these features are enabled they may only be edited from the command line. Use the following FortiOS CLI commands to disable these features:

```plaintext
config vpn ipsec phase1-interface
  edit [vpn name]
    set save-password disable
    set client-auto-negotiate disable
    set client-keep-alive disable
  end
end
```
FortiToken and FortiClient VPN

You can use FortiToken with FortiClient for two-factor authentication. See the FortiOS 5.0 Handbook for information on configuring FortiToken, user groups, VPN, and two-factor authentication on your FortiGate device for FortiClient VPN connections.

Figure 78: FortiToken authentication
Advanced features (Microsoft Windows)

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

Activating VPN before Windows Logon

When using VPN before Windows logon, the user is offered a list of pre-configured VPN connections to select from on the Windows logon screen. This requires that the Windows logon screen is not bypassed. As such, if VPN before Windows logon is enabled, it is required to also check the check box Users must enter a user name and password to use this computer in the User Accounts dialog box.

To make this change, proceed as follows:

In FortiClient,
1. Create the VPN tunnels of interest or use Endpoint Control to register to a FortiGate which provides the VPN list of interest
2. Enable VPN before logon on the FortiClient Settings page.

On the Microsoft Windows system,
1. Start an elevated command line prompt.
2. Enter control passwords2 and press Enter. Alternatively, you can enter netplwiz.
3. Check the check box for Users must enter a user name and password to use this computer.
4. Click OK to save the setting.

Connect VPN before logon (AD environments)

The VPN <options> tag holds global information controlling VPN states. The VPN will connect first, then logon to AD/Domain.

```xml
<forticlient_configuration>
  <vpn>
    <options>
      <show_vpn_before_logon>1</show_vpn_before_logon>
      <use_windows_credentials>1</use_windows_credentials>
    </options>
  </vpn>
</forticlient_configuration>
```

Create a redundant IPsec VPN

To use VPN resiliency/redundancy, you will configure a list of FortiGate IP/FQDN servers, instead of just one:

```xml
<forticlient_configuration>
  <vpn>
    <ipsecvpn>
      <options>
      ...
    </options>
  </ipsecvpn>
</forticlient_configuration>
```
This is a balanced, but incomplete XML configuration fragment. All closing tags are included, but some important elements to complete the IPsec VPN configuration are omitted.

**RedundantSortMethod = 1**

This XML tag sets the IPsec VPN connection as ping-response based. The VPN will connect to the FortiGate which responds the fastest.

**RedundantSortMethod = 0**

By default, RedundantSortMethod = 0 and the IPsec VPN connection is priority based. Priority based configurations will try to connect to the FortiGate starting with the first in the list.

**Priority based SSL VPN connections**

SSL VPN supports priority based configurations for redundancy.

```xml
<forticlient_configuration>
  <vpn>
    <sslvpn>
      <options>
        <enabled>1</enabled>
        ...
      </options>
      <connections>
        <connection>
          <name>ssl_90_1</name>
          <server>10.10.90.1;ssldemo.fortinet.com;172.17.61.143:443</server>
          ...
        </connection>
      </connections>
    </sslvpn>
  </vpn>
</forticlient_configuration>
```
This is a balanced, but incomplete XML configuration fragment. All closing tags are included, but some important elements to complete the SSL VPN configuration are omitted.

For SSL VPN, all FortiGates must use the same TCP port.

Advanced features (Mac OS X)

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

Create a redundant IPsec VPN

To use VPN resiliency/redundancy, you will configure a list of FortiGate IP/FQDN servers, instead of just one:

```
<forticlient_configuration>
  <vpn>
    <ipsecvpn>
      <options>
        ...
      </options>
      <connections>
        <connection>
          <name>psk_90_1</name>
          <type>manual</type>
          <ike_settings>
            <prompt_certificate>0</prompt_certificate>
            <server>10.10.90.1;ipsecdemo.fortinet.com;172.17.61.143</server>
            <redundantsortmethod>1</redundantsortmethod>
            ...
          </ike_settings>
        </connection>
        ...
      </connections>
    </ipsecvpn>
  </vpn>
</forticlient_configuration>
```

This is a balanced, but incomplete XML configuration fragment. All closing tags are included, but some important elements to complete the IPsec VPN configuration are omitted.

**RedundantSortMethod = 1**

This XML tag sets the IPsec VPN connection as ping-response based. The VPN will connect to the FortiGate which responds the fastest.

**RedundantSortMethod = 0**

By default, RedundantSortMethod =0 and the IPsec VPN connection is priority based. Priority based configurations will try to connect to the FortiGate starting with the first in the list.
Priority based SSL VPN connections

SSL VPN supports priority based configurations for redundancy.

```xml
<forticlient_configuration>
  <vpn>
    <sslvpn>
      <options>
        <enabled>1</enabled>
      </options>
      <connections>
        <connection>
          <name>ssl_90_1</name>
          <server>10.10.90.1;ssldemo.fortinet.com;172.17.61.143:443</server>
        </connection>
        ...
      </connections>
    </sslvpn>
  </vpn>
</forticlient_configuration>
```

This is a balanced, but incomplete XML configuration fragment. All closing tags are included, but some important elements to complete the SSL VPN configuration are omitted.

For SSL VPN, all FortiGates must use the same TCP port.
VPN tunnel & script (Microsoft Windows)

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

Feature overview

This feature supports auto running a user-defined script after the configured VPN tunnel is connected or disconnected. The scripts are batch scripts in Windows and shell scripts in Mac OS X. They are defined as part of a VPN tunnel configuration on FortiGate's XML format FortiClient Profile. The profile will be pushed down to FortiClient from FortiGate. When FortiClient's VPN tunnel is connected or disconnected, the respective script defined under that tunnel will be executed.

Map a network drive after tunnel connection

The script will map a network drive and copy some files after the tunnel is connected.

```xml
<on_connect>
  <script>
    <os>windows</os>
    <script>
      <!--[CDATA[
      net use x: \192.168.10.3\ftpshare /user:Ted Mosby
      md c:\test
      copy x:\PDF\*.* c:\test
      ]]>}
    </script>
  </script>
</on_connect>
```

Delete a network drive after tunnel is disconnected

The script will delete the network drive after the tunnel is disconnected.

```xml
<on_disconnect>
  <script>
    <os>windows</os>
    <script>
      <!--[CDATA[
      net use x: /DELETE
      ]]>}
    </script>
  </script>
</on_disconnect>
```
VPN tunnel & script (Mac OS X)

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

Map a network drive after tunnel connection

The script will map a network drive and copy some files after the tunnel is connected.

```xml
<on_connect>
  <script>
    <os>mac</os>
    <script>
      /bin/mkdir /Volumes/installers
      /sbin/ping -c 4 192.168.1.147 > /Users/admin/Desktop/dropbox/p.txt
      /sbin/mount -t smbfs //kimberly:RigUpTown@ssldemo.fortinet.com/installer s /Volumes/installers/ > /Users/admin/Desktop/dropbox/m.txt
      /bin/mkdir /Users/admin/Desktop/dropbox/dir
      /bin/cp /Volumes/installers/*.log /Users/admin/Desktop/dropbox/dir/.
    </script>
  </script>
</on_connect>
```

Delete a network drive after tunnel is disconnected

The script will delete the network drive after the tunnel is disconnected.

```xml
<on_disconnect>
  <script>
    <os>mac</os>
    <script>
      /sbin/umount /Volumes/installers
      /bin/rm -fr /Users/admin/Desktop/dropbox/*
    </script>
  </script>
</on_disconnect>
```
Vulnerability Scan

FortiClient includes an *Vulnerability Scan* module to check your workstation for known system vulnerabilities. You can scan on-demand or on a scheduled basis. This feature is disabled by default and the tab is hidden for standalone clients. For users who are registered to a FortiGate using endpoint control, the FortiGate administrator may choose to enable this feature. Vulnerability Scan is enabled via the FortiGate Command Line Interface (CLI) only. Once enabled, the *Endpoint Vulnerability Scan on Client* setting is available in the FortiClient Profile.

**Enable Vulnerability Scan**

This section describes how to enable *Vulnerability Scan* in the FortiClient Profile via the FortiGate CLI and configuration options.

**Enable Vulnerability Scan in the FortiClient Profile:**

1. Login to your FortiGate CLI.
2. Enter the following CLI commands:

   ```
   config endpoint-control profile
   edit <profile-name>
   config forticlient-winmac-settings
   set forticlient-vuln-scan enable
   set forticlient-vuln-scan-schedule {daily | weekly | monthly}
   set forticlient-vuln-scan-on-registration {enable | disable}
   set forticlient-ui-options {av | wf | af | vpn | vs}
   end
   end
   ```

   When setting the `forticlient-ui-options`, you must include all the modules that you want to enable in the FortiClient console.

<table>
<thead>
<tr>
<th><code>&lt;profile-name&gt;</code></th>
<th>Enter the name of the FortiClient Profile.</th>
</tr>
</thead>
<tbody>
<tr>
<td>`forticlient-vuln-scan {enable</td>
<td>disable}`</td>
</tr>
<tr>
<td>`forticlient-vuln-scan-schedule {daily</td>
<td>weekly</td>
</tr>
</tbody>
</table>
3. The FortiGate will send the FortiClient Profile configuration update to registered clients.

**Figure 79:** Configuration update was received from FortiGate

The Vulnerability Scan module is now available in FortiClient.

**Figure 80:** Vulnerability Scan page

---

**forticlient-vuln-scan-on-registration {enable | disable}**

Enable or disable vulnerability scan on client registration to FortiGate.

**forticlient-ui-options {av | wf | af | vpn | vs}**

Set the FortiClient components that will be available to the client upon registration with FortiGate.

- av: AntiVirus
- wf: Web Filter
- af: Application Firewall
- vpn: Remote Access
- vs: Vulnerability Scan
**Scan now**

To perform a vulnerability scan, select the *Scan Now* button in the FortiClient console. FortiClient will scan your workstation for known vulnerabilities. The console displays the date of the last scan above the button.

---

You can select to use a FortiManager device for client software and signature updates. When configuring the FortiClient Profile, select *Use FortiManager for client software/signature update* to enable the feature and enter the IP address of your FortiManager device.

---

**View vulnerabilities**

When the scan is complete, FortiClient will display the number of vulnerabilities found in the FortiClient console.

**Figure 81:** Scan complete

![Scan complete](image)

Select the *Vulnerabilities Detected* link to view a list of vulnerabilities detected on your system.
Table 5: Vulnerabilities detected page

<table>
<thead>
<tr>
<th>Vulnerability Name</th>
<th>Severity</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. Adobe Flash Player and AIR Multiple Vulnerabilities APSB13-26</td>
<td>Critical</td>
<td>37534</td>
</tr>
<tr>
<td>3. Adobe Flash Player and AIR Multiple Vulnerabilities APSB13-14</td>
<td>Critical</td>
<td>35579</td>
</tr>
<tr>
<td>4. Adobe Flash Player and AIR Multiple Vulnerabilities APSB13-11</td>
<td>Critical</td>
<td>35164</td>
</tr>
<tr>
<td>5. Adobe Flash Player and AIR Multiple Multiple Vul APSB13-09</td>
<td>Critical</td>
<td>35272</td>
</tr>
<tr>
<td>6. Adobe Flash Player and AIR Vulnerabilities APSB13-05</td>
<td>Critical</td>
<td>34622</td>
</tr>
<tr>
<td>7. Oracle Java SE Critical Patch Update October 2013</td>
<td>Critical</td>
<td>37134</td>
</tr>
<tr>
<td>10. MSVS Active Template Library Remote Code Execution</td>
<td>Critical</td>
<td>20531</td>
</tr>
<tr>
<td>11. Adobe Flash Player and AIR Multiple Vulnerabilities APSB13-21</td>
<td>Critical</td>
<td>37108</td>
</tr>
<tr>
<td>15. Adobe Flash Player and AIR Multiple Vulnerabilities APSB12-24</td>
<td>Critical</td>
<td>33877</td>
</tr>
<tr>
<td>16. Adobe Flash Player and AIR Multiple Vulnerabilities APSB12-22</td>
<td>Critical</td>
<td>33852</td>
</tr>
<tr>
<td>17. MS Windows Unauthorized Digital Certificates Importing KB2728973</td>
<td>Critical</td>
<td>32686</td>
</tr>
</tbody>
</table>

This page displays the following:

**Vulnerability Name**  The name of the vulnerability

**Severity**  The severity level assigned to the vulnerability; Critical, High, Medium, Low, Info.

**Details**  FortiClient vulnerability scan lists a Bugtraq (BID) number under the details column. You can select the BID to view details of the vulnerability on the FortiGuard site, or search the web using this BID number.

**Close**  Close the window and return to the FortiClient console.

Select the *Details* ID number from the list to view information on the selected vulnerability on the FortiGuard site. The site details the release date, severity, impact, description, affected products, and recommended actions.
Vulnerability: Adobe Flash Player and AIR Multiple Vulnerabilities APS813-21

Description:
Adobe Flash Player before 11.7.60.242 and 11.8.x before 11.8.50.106 on Windows and Mac OS X, before 11.2.202.318 on Linux, before 11.7.60.242 on Solaris 10 and 8, and before 11.7.110.35 on Solaris 11, Adobe AIR Edition 8.3.1.159, and Adobe AIR SDK 16 & 18.3.0.9 allows attackers to execute arbitrary code via a denial of service (security bypass) on unspecified actors, a different vulnerability than CR-2015-050, CR-2013-091 (DEC) and CR-2013-004.

Adobe Flash Player before 11.7.60.242 and 11.8.x before 11.8.50.106 on Windows and Mac OS X, before 11.2.202.318 on Linux, before 11.7.60.242 on Solaris 10 and 8, and before 11.7.110.35 on Solaris 11, Adobe AIR Edition 8.3.1.159, and Adobe AIR SDK 16 & 18.3.0.9 allows attackers to execute arbitrary code via a denial of service (security bypass) on unspecified actors, a different vulnerability than CR-2015-050, CR-2013-091 (DEC) and CR-2013-004.

Adobe Flash Player before 11.7.60.242 and 11.8.x before 11.8.50.106 on Windows and Mac OS X, before 11.2.202.318 on Linux, before 11.7.60.242 on Solaris 10 and 8, and before 11.7.110.35 on Solaris 11, Adobe AIR Edition 8.3.1.159, and Adobe AIR SDK 16 & 18.3.0.9 allows attackers to execute arbitrary code via a denial of service (security bypass) on unspecified actors, a different vulnerability than CR-2015-050, CR-2013-091 (DEC) and CR-2013-004.
Settings

This sections describe the available options in the settings menu.

Backup or restore full configuration

To backup or restore the full configuration file select *File* in the toolbar and select *Settings* in the drop-down menu. Select *System* to view the drop-down menu. In this menu you can perform a backup or restore a full configuration file.

**Figure 83:** Backup and restore options

<table>
<thead>
<tr>
<th><strong>Backup</strong></th>
<th>Backup is available when in standalone mode or when registered to FortiGate.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Restore</strong></td>
<td>Restore is available when in standalone mode.</td>
</tr>
</tbody>
</table>

When performing a backup you can select the file destination and save the file in an unencrypted (.conf) or encrypted format (.sconf). You can select to include or exclude comments in the XML configuration file.

**Figure 84:** Backup configuration dialog box
Logging

To configure logging, select File in the toolbar and select Settings in the drop-down menu. Select Logging to view the drop-down menu. You can specify the logging level and select to export logs or clear logs.

Figure 85: Logging options

The following table lists the logging levels and description:

<table>
<thead>
<tr>
<th>Logging Level</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergency</td>
<td>The system becomes unstable.</td>
</tr>
<tr>
<td>Alert</td>
<td>Immediate action is required.</td>
</tr>
<tr>
<td>Critical</td>
<td>Functionality is affected.</td>
</tr>
<tr>
<td>Error</td>
<td>An error condition exists and functionality could be affected.</td>
</tr>
<tr>
<td>Warning</td>
<td>Functionality could be affected.</td>
</tr>
<tr>
<td>Notice</td>
<td>Information about normal events.</td>
</tr>
</tbody>
</table>
FortiClient can be configured via the endpoint profile to send traffic, vulnerability scan, and event logs to your FortiAnalyzer or FortiManager device running v5.0.2 or later.

**Configure logging to FortiAnalyzer or FortiManager**

To configure FortiClient to log to your FortiAnalyzer or FortiManager you require the following:

- FortiClient version 5.2.0 or later
- A FortiGate device running FortiOS version 5.2.0 or later
- A FortiAnalyzer or FortiManager device running version 5.0.7 or later, 5.2.0 or later

The registered FortiClient device will send traffic logs, vulnerability scan logs, and event logs to the log device on port 514 TCP.

**Enable logging on the FortiGate device:**

2. Select the Send Logs to FortiAnalyzer/FortiManager checkbox to enable this feature. Enter the IP address of your log device. You can select Test Connectivity to ensure your FortiGate is able to communicate with the log device on this IP address.

3. Select Apply to save the setting.

FortiClient must be able to access the FortiAnalyzer IP address in order to forward logs.

Enable logging in the FortiClient Profile:
1. Go to User & Device > FortiClient Profiles.
2. Select the FortiClient Profile and select Edit from the toolbar. The Edit FortiClient Profile page opens.
3. In the FortiClient Configuration Deployment Windows and Mac section, toggle the *Upload Logs to FortiAnalyzer/FortiManager* feature to *ON*. You can select either *Same as System* which will follow the FortiGate settings or *Specify* to enter a different IP address. For *Schedule*, select to upload logs *Hourly* or *Daily*. 

---

**Figure 87:** Edit FortiClient Profile page
4. Select Apply to save the setting. Once the FortiClient Profile change is synchronized with the client, you will start receiving logs from registered clients on your FortiAnalyzer/FortiManager system.

Alternatively, you can configure logging in the command line interface. Go to System > Dashboard > Status. In the CLI Console widget, enter the following CLI commands:

```plaintext
config endpoint-control profile
  edit <profile-name>
  config forticlient-winmac-settings
    set forticlient-log-upload enable
    set forticlient-log-upload-server <IP address>
    set forticlient-log-upload-schedule {hourly | daily}
    set forticlient-log-ssl-upload {enable | disable}
    set client-log-when-on-net {enable | disable}
  end
end
```

To download the FortiClient log files on the FortiAnalyzer go to the Log View tab, select the ADOM, and select the FortiClient menu object.

**Updates**

To configure updates, select File in the toolbar and select Settings in the drop-down menu. Select System to view the drop-down menu. In this menu you can configure the behavior of FortiClient when a new software version is available on the FortiGuard Distribution Servers (FDS).

**Figure 88:** Update options

You can select to use a FortiManager device for client software and signature updates. When configuring the endpoint profile, select Use FortiManager for client software/signature updates to enable the feature and enter the IP address of your FortiManager device.

**To configure FortiClient to use FortiManager for software and signature updates:**

1. On your FortiOS device, select User & Device > FortiClient Profiles.
2. Toggle the Use FortiManager for client software/signature update option to ON.
3. Specify the IP address of the FortiManager to use for client software and signature updates.
4. Select the checkbox beside Failover to FDN when FortiManager is not available to have FortiClient receive updates from the FortiGuard Distribution Network when the FortiManager is not available to ensure your clients are always protected.
5. Select *Apply* to save the setting.

**VPN options**

To configure VPN options, select *File* in the toolbar and select *Settings* in the drop-down menu. Select *VPN Options* to view the drop-down menu. In this menu you can configure to enable VPN before logon.

**Figure 89:** VPN options

![VPN Options](image)

| VPN Options | This setting can be configured when in standalone mode. When registered to FortiGate, this setting is set by the XML configuration (if configured). |

**Certificate management**

To configure VPN certificates, select *File* in the toolbar and select *Settings* in the drop-down menu. Select *Certificate Management* to view the drop-down menu. In this menu you can configure IPsec VPN to use local certificates and import certificates to FortiClient.

**Figure 90:** Certificate management options

![Certificate Management](image)

| Certificate Management | This setting can be configured when in standalone mode. When registered to FortiGate, this setting is set by the XML configuration (if configured). |

**Antivirus options**

To configure antivirus options, select *File* in the toolbar and select *Settings* in the drop-down menu. Select *AntiVirus Options* to view the drop-down menu. In this menu you can configure grayware options and the behavior of FortiClient when a virus is detected.
Figure 91: Antivirus options

Configure the following settings:

- **Grayware Options**: These settings can be configured when in standalone mode. When registered to FortiGate, these settings are set by the XML configuration (if configured).

- **AntiVirus Options**
  - Grayware is an umbrella term applied to a wide range of malicious applications such as spyware, adware, and key loggers that are often secretly installed on a user’s computer to track and/or report certain information back to an external source without the user’s permission or knowledge.

- **Adware**: Select to enable adware detection and quarantine during the antivirus scan.

- **Riskware**: Select to enable riskware detection and quarantine during the antivirus scan.

- **Advanced heuristics**: Select to enable advanced heuristics.

- **Alert when viruses are detected**: Select to display notification message window when a virus is detected.

- **Pause background scanning on battery power**: Select to pause background scanning when on battery power.

- **Enable FortiGuard Analytics**: Select to automatically send suspicious files to the FortiGuard Network for analysis.

**Advanced options**

To configure advanced options, select *File* in the toolbar, and select *Settings* in the drop-down menu. Select *Advanced* to view the drop-down menu. In this menu you can configure WAN Optimization, Single Sign-On, configuration sync with FortiGate, disable proxy, and the default tab when FortiClient is started.
Configure the following settings:

<table>
<thead>
<tr>
<th><strong>Advanced</strong></th>
<th>Advanced FortiClient settings.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Enable WAN Optimization</strong></td>
<td>Select to enable WAN Optimization. You should enable only if you have a FortiGate device and your FortiGate is configured for WAN Optimization. This setting can be configured when in standalone mode. When registered to FortiGate, this setting is set by the XML configuration (if configured).</td>
</tr>
<tr>
<td><strong>Maximum Disk Cache Size</strong></td>
<td>Select to configure the maximum disk cache size. The default value is 512MB.</td>
</tr>
<tr>
<td><strong>Enable Single Sign-On mobility agent</strong></td>
<td>Select to enable Single Sign-On Mobility Agent for FortiAuthenticator. To use this feature you need to apply a FortiClient SSO mobility agent license to your FortiAuthenticator device. This setting can be configured when in standalone mode. When registered to FortiGate, this setting is set by the XML configuration (if configured).</td>
</tr>
<tr>
<td><strong>Server address</strong></td>
<td>Enter the FortiAuthenticator IP address.</td>
</tr>
<tr>
<td><strong>Customize port</strong></td>
<td>Enter the port number. The default port is 8001.</td>
</tr>
<tr>
<td><strong>Pre-shared Key</strong></td>
<td>Enter the pre-shared key. The pre-shared key should match the key configured on your FortiAuthenticator device.</td>
</tr>
<tr>
<td><strong>Disable configuration sync with FortiGate</strong></td>
<td>Select to disable configuration synchronization with FortiGate. By disabling this option, this client will be considered as non-compliant and your network traffic might be blocked by FortiGate. This setting can be configured when in standalone mode or when registered to FortiGate.</td>
</tr>
</tbody>
</table>
Single Sign-On (SSO) mobility agent

The FortiClient Single Sign-On Mobility Agent is a client that updates with FortiAuthenticator with user logon and network information.

FortiClient/FortiAuthenticator protocol

The FortiAuthenticator listens on a configurable TCP port. FortiClient connects to FortiAuthenticator using TLS/SSL with two-way certificate authentication. The FortiClient sends a logon packet to FortiAuthenticator, which replies with an acknowledgement packet.

FortiClient/FortiAuthenticator communication requires the following:

- The IP address should be unique in the entire network.
- The FortiAuthenticator should be accessible from clients in all locations.
- The FortiAuthenticator should be accessible by all FortiGates.

Enable Single Sign-On mobility agent on FortiClient:

1. Select File in the toolbar and select Settings in the drop-down menu.
2. Select Advanced to view the drop-down menu.
3. Select to Enable Single Sign-On mobility agent.
4. Enter the FortiAuthenticator server address and the pre-shared key.

Enable FortiClient SSO mobility agent service on the FortiAuthenticator:

2. Select **Enable FortiClient SSO Mobility Agent Service** and a TCP port value for the listening port.
3. Select **Enable authentication** and enter a secret-key value.
4. Select OK to save the setting.

**To enable FortiClient FSSO services on the interface:**
1. Select **System > Network > Interfaces.** Select the interface and select Edit from the toolbar. The *Edit Network Interface* window opens.

**Figure 94:** Edit network interface window
2. Select the checkbox to enable *FortiClient FSSO*.

3. Select **OK** to save the setting.

---

To enable the FortiClient SSO Mobility Agent Service on the FortiAuthenticator, you must first apply the applicable FortiClient license for FortiAuthenticator. For more information, see the *FortiAuthenticator Administration Guide* in the Fortinet Document Library at [http://docs.fortinet.com](http://docs.fortinet.com). For information on purchasing a FortiClient license for FortiAuthenticator, please contact your authorized Fortinet reseller.

---

**Configuration lock**

To prevent unauthorized changes to the FortiClient configuration, select the lock icon located at the bottom left of the *Settings* page. You will be prompted to enter and confirm a password. When the configuration is locked, configuration changes are restricted and FortiClient cannot be shut down or uninstalled.

**Figure 95:** Configuration lock window and dialog box

![Configuration lock window and dialog box](image)

When the configuration is locked you can perform the following actions:

- **Antivirus**
  - Complete an antivirus scan, view threats found, and view logs
  - Select **Update Now** to update signatures
- **Web Security**
  - View violations
- **Application Firewall**
  - View applications blocked
- **Remote Access**
  - Configure, edit, or delete an IPsec VPN or SSL VPN connection
  - Connect to a VPN connection
- **Vulnerability Scan**
  - Complete a vulnerability scan of the system
  - View vulnerabilities found
- **Register and unregister FortiClient for Endpoint Control**
- Settings
  - Export FortiClient logs
  - Backup the FortiClient configuration

To perform configuration changes or to shut down FortiClient, select the lock icon and enter the password used to lock the configuration.

**FortiTray**

When FortiClient is running on your system, you can select the FortiTray icon in the Windows system tray to perform various actions. The FortiTray icon is available in the system tray even when the FortiClient console is closed.

- **Default menu options**
  - Open FortiClient console
  - Shutdown FortiClient

- **Dynamic menu options depending on configuration**
  - Connect to a configured IPsec VPN or SSL VPN connection
  - Display the antivirus scan window (if a scheduled scan is currently running)
  - Display the Vulnerability scan window (if a vulnerability scan is running)

If you hover the mouse cursor over the FortiTray icon, you will receive various notifications including the version, antivirus signature, and antivirus engine.

**Figure 96:** System tray icon and FortiTray menu

When the configuration is locked, the option to shut down FortiClient from FortiTray is greyed out.
Connect to a VPN connection

To connect to a VPN connection from FortiTray, select the Windows System Tray and right-click in the FortiTray icon. Select the connection you wish to connect to, enter your username and password in the authentication window, and select OK to connect.

**Figure 97:** Authentication window
Custom FortiClient Installations

The FortiClient Configurator tool FortiClient is the recommended method of creating customized FortiClient installation files.

You can also customize which modules are displayed in the FortiClient dashboard in the FortiClient Profile. This will allow you to activate any of the modules at a later date without needing to re-install FortiClient. Any changes made to the FortiClient Profile are pushed to registered clients.

When creating VPN only installation files, you cannot enable other modules in the FortiClient Profile as only the VPN module is installed.

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

The FortiClient Configurator tool is included with the FortiClient Tools file in FortiClient v5.2. This file is only available on the Customer Service & Support portal and is located in the same file directory as the FortiClient images.

The Configurator tool requires activation with a license file. Ensure that you have completed the following steps prior to logging in to your FortiCare product web portal:

- Purchased FortiClient Registration License
- Activated the FortiClient license on a FortiGate

This video explains how to purchase and apply a FortiClient License:
http://www.youtube.com/watch?feature=player_embedded&v=slkWaUXK0Ok

This chapter contains the following sections:

- Download the license file
- FortiClient (Mac OS X) Configurator tool
- Create a custom installer
- Custom installation packages

Download the license file

To retrieve your license file:

1. Go to https://support.fortinet.com and login to your FortiCare account.
2. Under Asset select Manage/View Products. Select the FortiGate device that has the FortiClient registration license activated.
   You will see the Get the Key File link in the Available Key(s) section.

Page 128
3. Click the link and download license file to your management computer. This file will be needed each time you use the FortiClient Configurator tool.

FortiClient version 5.2 cannot use FortiClient version 5.0 licenses. To use FortiClient Configurator, you need to use the FortiClient version 5.2 license file.

Create a custom installer

Fortinet offers a repacking tool for both Microsoft Windows and Mac OS X operating systems. The following section provides instructions on creating a custom installer file using the FortiClient Configurator tool.

When selecting to install custom features, only modules selected are installed. To enable other features you will need to uninstall FortiClient, and reinstall an MSI file with these features included in the installer.

FortiClient (Windows) Configurator tool

To create a custom installer using the FortiClient Configurator tool:

1. Unzip the FortiClientTools file, select the FortiClientConfigurator file folder, and double-click the FortiClientConfigurator.exe application file to launch the tool. The tool opens at the Welcome page.
2. Browse and select the FortiClient Configurator Activation Key file (.lic) on your management computer.

3. After entering the FortiClient Configurator license, select Next. The Configuration File page is displayed.

<table>
<thead>
<tr>
<th>Licensed</th>
<th>Licensed mode requires a FortiClient version 5.2 license file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trial</td>
<td>In FortiClient version 5.2, the FortiClient Configurator tool can be used in trial mode. In trial mode, all online updates are disabled. The trial installer is intended to be deployed in a test environment.</td>
</tr>
</tbody>
</table>

The FortiClient Configurator tool is not installed on the management computer. You must upload the FortiClient Configurator Activation Key file (.lic) each time you run the tool.
**Figure 100:** Configuration file page

<table>
<thead>
<tr>
<th>Select Config File (optional)</th>
<th>The configuration file (.conf, .sconf) settings will be included in the installer file.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>If the configuration file is encrypted (.sconf), enter the password used to encrypt the file.</td>
</tr>
</tbody>
</table>

You can use an XML editor to make changes to the FortiClient configuration file. For more information on FortiClient XML configuration, see the FortiClient XML Reference in the Fortinet Document Library, [http://docs.fortinet.com](http://docs.fortinet.com).

4. Browse and select the FortiClient configuration file on your management computer. This is an optional step. If you do not want to import settings from a configuration file, select Skip to continue. The Settings page is displayed.
The following options are available for custom installations:

### Features to Install

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Everything</strong></td>
<td>All Security and VPN components will be installed.</td>
</tr>
<tr>
<td><strong>Client security only</strong></td>
<td>Only AntiVirus, Web Filtering, and Application Firewall will be installed.</td>
</tr>
<tr>
<td><strong>VPN only</strong></td>
<td>Only VPN components (IPsec and SSL) will be installed.</td>
</tr>
<tr>
<td><strong>Other</strong></td>
<td>Select one of the following from the drop-down list:</td>
</tr>
<tr>
<td></td>
<td>• AntiVirus &amp; Web Filtering only</td>
</tr>
<tr>
<td></td>
<td>• Web Filtering only</td>
</tr>
<tr>
<td></td>
<td>• Application Firewall only</td>
</tr>
<tr>
<td></td>
<td>• Application Firewall &amp; Web Filtering only</td>
</tr>
<tr>
<td></td>
<td>• Web Filtering, VPN and Application Firewall</td>
</tr>
<tr>
<td></td>
<td>• Single Sign-On mobility agent only</td>
</tr>
</tbody>
</table>

### Options

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Desktop Shortcut</strong></td>
<td>Select to create a FortiClient desktop icon.</td>
</tr>
<tr>
<td><strong>Start Menu</strong></td>
<td>Select to add FortiClient to the start menu.</td>
</tr>
<tr>
<td><strong>Enable Software Update</strong></td>
<td>Select to enable software updates. This option is disabled when Rebrand FortiClient is selected. This option is also disabled when using Trial mode.</td>
</tr>
</tbody>
</table>
5. Select the features to install and options and select Next to continue.

If you selected to configure the single sign-on mobility agent, the Single Sign-On Mobility Agent Settings page is displayed.

Figure 102: Single Sign-On Mobility Agent Settings page

6. Configure the following settings:

| Configure Single Sign-On mobility agent | Select to configure Singe Sign-On mobility agent for use with FortiAuthenticator. |
| Rebrand FortiClient | Select to rebrand FortiClient. When selected, the option to enable software update is not available. |

Server IP/FQDN
- Enter the IP address or FQDN of the FortiAuthenticator server.

Port Number
- Enter the port number. The default port is 8001.

Pre-Shared Key
- Enter the FortiAuthenticator pre-shared key.

Confirm Pre-Shared Key
- Enter the FortiAuthenticator pre-shared key confirmation.

7. Select Next to continue. If you selected to rebrand FortiClient, the Rebranding page is displayed.
8. Rebrand FortiClient elements as required. The resources folder contains graphical elements. Select Next to continue. The Package Signing page is displayed.

**Figure 103:** Rebranding page

![Rebranding page](image1)

**Figure 104:** Package Signing page

![Package Signing page](image2)
9. Configure the following settings:

| **Select Code Signing Certificate (optional)** | If you have a code signing certificate, you can use it to digitally sign the installer package this tool generates. |
| **Password** | If the certificate file is password protected, enter the password. |

10. Browse and select the code signing certificate on your management computer. This is an optional step. If you do not want to digitally sign the installer package, select Skip to continue. The Execution page is displayed.

**Figure 105:** Execution page

This page provides details of the installer file creation and the location of files for Active Directory deployment and manual distribution. The tool creates files for both 32-bit (x86) and 64-bit (x64) operating systems.

11. When you select Finish, if **Browse to output MSI file upon exit** is selected, the folder containing the newly created MSI file will open.

Before deploying the custom MSI files, it is recommended that you test the packages to confirm that they install correctly. In FortiClient version 5.2.0 and later, an .exe installation file is created for manual distribution.

Installation files are organized in folders within the **FortiClientTools > FortiClient Configurator > FortiClient repackaged** folder. Folder names identify the type of installation files that were created and the creation date.
To create a custom installer using the FortiClient Configurator tool:

1. Unzip the FortiClientTools file, select the Configurator file folder, and double-click the FortiClientConfigurator.dmg application file, and double-click the FCTConfigurator icon to launch the tool. The Configurator tool opens.

**Figure 106:** FortiClient Configurator tool

![FortiClient Configurator tool](image)

2. Configure the following settings:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>**Licensed</td>
<td>Trial**</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>Select the FortiClient Installer file on your management computer. You must use the full installer file, otherwise FortiClient Configurator will fail to create a custom installation file. The FortiClient Installer version and FortiClient Configurator version must match, otherwise the Configurator will fail to create a custom installation file.</td>
</tr>
<tr>
<td><strong>Destination</strong></td>
<td>Enter a name for the custom installation file and select a destination to save the file on your management computer.</td>
</tr>
<tr>
<td><strong>Features to Install</strong></td>
<td>Select to install all FortiClient modules, VPN only, or SSO only. If SSO only is selected, you must configure the SSO settings in the attached configuration file.</td>
</tr>
<tr>
<td><strong>Server IP/FQDN</strong></td>
<td>Enter the IP address or FQDN of the FortiAuthenticator server. This option is available when selecting SSO only for features to install.</td>
</tr>
</tbody>
</table>
3. Select the **Start** button to create the custom FortiClient installation file.

**Figure 107:** Start repackaging

You can now deploy the repackaged FortiClient .dmg file to your Mac OS X systems.
Custom installation packages

When deploying a custom FortiClient XML configuration, use the advanced FortiClient Profile options in FortiGate to ensure the FortiClient Profile settings do not overwrite your custom XML settings. For more information, see the FortiClient XML Reference and the CLI Reference for FortiOS.

FortiClient (Windows)

After the configurator tool generates the custom installation packages, it can be used to deploy the FortiClient software either manually, or using Active Directory. Both options can be found in the `../FortiClient_packaged` directory. Files are created for both x86 (32-bit) and x64 (64-bit) operating systems.

Figure 108: FortiClient_packaged folder
If Active Directory is being used to deploy FortiClient, you can use the custom installer with the MST file found in the `../ActiveDirectory` folder.

**Figure 109:** ActiveDirectory folder

For manual distribution, use the `.exe` file in the `../ManualDistribution` folder.

**Figure 110:** ManualDistribution folder
Advanced FortiClient profiles

When creating custom FortiClient MSI files for deployment, you will need to configure advanced FortiClient profiles on the FortiGate to ensure that settings in the FortiClient profile do not overwrite your custom XML settings. You can configure the FortiClient profile to deliver the full XML configuration, VPN only, or specific FortiClient XML configurations. For more information on customizing the FortiClient XML configuration file, see the FortiClient XML Reference.

Fortinet recommends creating OS specific endpoint profiles when provisioning XML settings. When creating a new FortiClient profile, select the device group as either Windows PC or Mac. If a FortiClient (Windows) XML configuration is pushed to a FortiClient (Mac OS X) system, FortiClient (Mac OS X) will ignore settings which are not supported.

Provision a full XML configuration file

You can deploy the full XML configuration file from the CLI or Web-based Manager.

To deploy the full XML configuration via the CLI:
1. Log in to the FortiGate Command-line Interface.
2. Enter the following CLI commands:
   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-advanced-cfg enable
   set forticlient-advanced-cfg-buffer "Copy & Paste your FortiClient XML configuration here"
   end
   ```

To deploy the full XML configuration via the Web-based Manager:
1. Go to User & Device FortiClient Profiles.
2. Select the FortiClient Profile and select Edit from the toolbar. The Edit FortiClient Profile page is displayed.

After `forticlient-advanced-cfg` is enabled, the `forticlient-advanced-cfg-buffer` CLI command is available from the CLI.

Copy directly from your XML editor, preserving the XML file format. Copy all information from the `<xml version="1.0" encoding="UTF-8" start of syntax to the </forticlient_configuration> end of syntax XML tags. Add double quotes at the start and end of the XML syntax statements.

The buffer size for the FortiClient Control XML configuration is 32kB.
Configure the following settings:

<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Enter a unique name to identify the FortiClient profile.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comments</td>
<td>Optionally, enter a comment.</td>
</tr>
<tr>
<td>Assign Profile To</td>
<td>For more information on configuring device groups, user groups, and users, see the FortiOS Handbook. These options are only available when creating a new FortiClient profile. You can assign the profile to user groups and users when using Active Directory authentication or RADIUS authentication for VPN. FortiClient does not support nested groups in FortiOS.</td>
</tr>
<tr>
<td>Device Groups</td>
<td>Select device groups from the drop down-menu. Use the add icon to add more than one device group.</td>
</tr>
<tr>
<td>User Groups</td>
<td>Select user groups from the drop-down list. Use the add icon to add more than one device group.</td>
</tr>
<tr>
<td>Users</td>
<td>Select users from the drop-down list. Use the add icon to add more than one device group.</td>
</tr>
</tbody>
</table>

**FortiClient Configuration Deployment**

**Windows and Mac**

XML text window Cut and paste the FortiClient XML configuration file in the text window. The XML syntax must be preserved.

3. Select **Apply** to save the FortiClient profile settings.
The current buffer size is 32kB. This may not be large enough to accommodate your FortiClient XML configuration. As a workaround, you can use the FortiClient Configurator tool to create a custom MSI installation file using a .conf FortiClient backup configuration that contains static custom configurations. You can then include a partial configuration in the advanced FortiClient profile. This will push the partial configuration when the client registers with the FortiGate. The partial configuration will be merged with the existing XML configuration on the client.

To provision specific FortiClient XML configuration while preserving custom XML configurations in your MSI file, cut & paste the specific XML configuration into the FortiClient Profile in the following format:

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<forticlient_configuration>
  <partial_configuration>1</partial_configuration>
  <system>
    <ui>
      <ads>0</ads>
      <default_tab>VPN</default_tab>
      <flashing_system_tray_icon>0</flashing_system_tray_icon>
      <hide_system_tray_icon>0</hide_system_tray_icon>
      <suppress_admin_prompt>0</suppress_admin_prompt>
      <culture_code>os-default</culture_code>
    </ui>
    <update>
      <use_custom_server>0</use_custom_server>
      <port>80</port>
      <timeout>60</timeout>
      <failoverport>8000</failoverport>
      <fail_over_to_fdn>1</fail_over_to_fdn>
      <scheduled_update>
        <enabled>0</enabled>
        <type>interval</type>
        <daily_at>03:00</daily_at>
        <update_interval_in_hours>3</update_interval_in_hours>
      </scheduled_update>
    </update>
  </system>
</forticlient_configuration>
```

Ensure that the `<partial_configuration>1</partial_configuration>` tag is set to 1 to indicate that this partial configuration will be deployed upon registration with the FortiGate. All other XML configuration will be preserved.
**Advanced VPN provisioning**

You need to enable VPN provisioning and advanced VPN from the FortiOS CLI to import the FortiClient XML VPN configuration syntax. You can import the XML VPN configuration in the CLI or the Web-based Manager.

**Import XML VPN configuration into the FortiClient Profile via the CLI:**

1. Log in to your FortiGate command-line interface.

2. Enter the following CLI commands:
   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-vpn-provisioning enable
   set forticlient-advanced-vpn enable
   set auto-vpn-when-off-net enable
   set auto-vpn-name <VPN name to connect to automatically when off-net>
   set forticlient-advanced-vpn-buffer <Copy & paste the advanced VPN configuration>
   end
   end
   ```

3. You can also choose to copy & paste the XML content in the Web-based Manager, go to *User & Device > FortiClient Profiles.*

   After the `forticlient-vpn-provisioning` and `forticlient-advanced-vpn` CLI commands are enabled, the `forticlient-advanced-vpn-buffer` CLI command is available from the CLI.

Copy directly from your XML editor, preserving the XML file format. Copy all information from the `<vpn>` start of syntax to the `</vpn>` end of syntax XML tags. Add double quotes before the `<vpn>` tag and after the `</vpn>` tag.
Configure the following settings:

**Profile Name**
Enter a unique name to identify the FortiClient profile.

**Comments**
Optionally, enter a comment.

**Assign Profile To**
For more information on configuring device groups, user groups, and users, see the *FortiOS Handbook.*

These options are only available when creating a new endpoint profile.

You can assign the profile to user groups and users when using Active Directory authentication or RADIUS authentication for VPN.

FortiClient does not support nested groups in FortiOS.

**Device Groups**
Select device groups from the drop down-menu. Use the add icon to add more than one device group.
<table>
<thead>
<tr>
<th><strong>User Groups</strong></th>
<th>Select user groups from the drop-down list. Use the add icon to add more than one device group.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Users</strong></td>
<td>Select users from the drop-down list. Use the add icon to add more than one device group.</td>
</tr>
</tbody>
</table>

### FortiClient Configuration Deployment

#### Windows and Mac

<table>
<thead>
<tr>
<th><strong>AntiVirus Protection</strong></th>
<th>Toggle the button on or off to enable or disable this feature.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Web Category Filtering</strong></td>
<td>Toggle the button on or off to enable or disable this feature. When enabled, you can select a web filter profile in the drop-down list. Select the checkbox to enable client web filtering when on-net.</td>
</tr>
<tr>
<td><strong>VPN</strong></td>
<td>Select the checkbox for Client VPN Provisioning. Cut and paste the FortiClient XML configuration <code>&lt;vpn&gt;</code> to <code>&lt;/vpn&gt;</code> tags in the text window. The XML syntax must be preserved. Select the checkbox to enable auto-connect when off-net and select a VPN connection in the drop-down list.</td>
</tr>
<tr>
<td><strong>Application Firewall</strong></td>
<td>Toggle the button on or off to enable or disable this feature. When enabled, you can select an application control sensor in the drop-down list.</td>
</tr>
<tr>
<td><strong>Endpoint Vulnerability Scan on Client</strong></td>
<td>Toggle the button on or off to enable or disable this feature. When enabled, you can select the scheduled scan type to daily, weekly, or monthly. Select the checkbox to initiate a scan after client registration with the FortiGate. This feature must be enabled per FortiClient profile in the FortiOS CLI.</td>
</tr>
<tr>
<td><strong>Upload Logs to FortiAnalyzer/FortiManager</strong></td>
<td>Toggle the button on or off to enable or disable this feature. When enabled, you can select to use the same FortiAnalyzer/FortiManager used by the FortiGate or select Specify to enter a different device IP. You can set the schedule to hourly or daily. The FortiClient upload logs to the FortiAnalyzer/FortiManager only when it is able to connect to the device on the specified IP address.</td>
</tr>
<tr>
<td><strong>Use FortiManager for client software/signature update</strong></td>
<td>Toggle the button on or off to enable or disable this feature. When enabled, you can specify the IP address of the FortiManager. Select the checkbox to failover to the FortiGuard Distribution Network (FDN) when the FortiManager is not available.</td>
</tr>
<tr>
<td><strong>Dashboard Banner</strong></td>
<td>Toggle the button on or off to enable or disable this feature.</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Client-based Logging when On-Net</strong></td>
<td>Toggle the button on or off to enable client-based logging when on-net.</td>
</tr>
</tbody>
</table>

Select *Apply* to save the FortiClient profile settings.
Upgrade Information

FortiClient (Windows) version 5.2.3 upgrade information

Please review the FortiClient (Windows) 5.2.3 Release Notes prior to upgrading your client. The following information outlines supported upgrade paths and methods.

When upgrading on a Windows XP system, a warning dialog box is displayed indicating that one of the files to be updated is currently in use. Please select the Ignore button to continue with the upgrade.

Users with newer Windows OS versions will receive a different warning dialog box. It warns that a reboot will be required to complete the installation. Please click the OK button to continue with the installation.

FortiClient (Mac OS X) version 5.2.3 upgrade information

Please review the FortiClient (Mac OS X) 5.2.3 Release Notes prior to upgrading your client. The following information outlines supported upgrade paths and methods.
Appendix A: Deployment Scenarios

Basic FortiClient Profile

In this scenario, you want to configure all FortiClient Profile settings in the FortiGate Web-based Manager. When clients register, they will receive the settings configured in the FortiClient Profile. You can configure the default profile, or create a new profile. When creating a new profile, you have additional options to specify device groups, user groups, and users.

Create a basic FortiClient Profile:

1. In the FortiGate Web-based Manager, go to User & Device > FortiClient Profiles. You can either select the default FortiClient Profile or select Create New in the toolbar. The default FortiClient Profile does not include the Device Groups, User Groups, and Users settings. The Edit Endpoint Profile page opens.

Figure 113: Basic FortiClient Profile

2. Set the device groups, user groups, user settings, and other FortiClient Profile settings as required and select Apply to save the FortiClient Profile changes.
Advanced FortiClient Profile (Full XML Configuration)

In this scenario, you have created a custom XML configuration file. The custom file includes all settings required by the client at the time of deployment. When the client registers to the FortiGate, you want to ensure that the client receives the full XML configuration. For future configuration changes you can use the “Advanced FortiClient Profile (Partial XML Configuration)” procedure.

The buffer size in the FortiClient Profile is 32kB. Depending on the size of the FortiClient XML configuration file you may not be able to deploy the full XML configuration file in the FortiClient Profile. Alternatively, you can create a custom installation file with the repackager tool and push a partial XML configuration.

To reduce the size of the FortiClient XML configuration file, you can delete all help text found within the <!-- .... --> comment tags.

Create an advanced FortiClient Profile with the full XML configuration provisioned:

1. In the FortiGate Command-line Interface enter the following commands:

   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-advanced-cfg enable
   end
   end
   ```

2. In the FortiGate Web-based Manager, go to User & Device > FortiClient Profiles. Select the advanced FortiClient profile and select Edit in the toolbar. The Edit FortiClient Profile page opens.
3. Open the FortiClient XML configuration file in a source code editor. Copy and paste the FortiClient XML configuration file into the XML text field in the FortiClient Profile.

Alternatively, you can copy and paste the XML configuration into the CLI using the `set forticlient-advanced-cfg-buffer` command.

4. Set the device groups, user groups, and user settings as required, and select Apply to save the FortiClient Profile changes. In the future, if you need to update the FortiClient configuration follow the procedure in “Advanced FortiClient Profile (Partial XML Configuration)”.

**Advanced FortiClient Profile (Partial XML Configuration)**

In this scenario, you have created a custom XML configuration file and you have created a custom FortiClient installation file using the repackaging tool. The custom XML configuration file includes most settings required by the client at the time of deployment. Due to the 32kB buffer size limitation, you are not able to follow “Advanced FortiClient Profile (Full XML Configuration)” procedure.

When the client registers to the FortiGate, you want to ensure that the client receives the partial XML configuration. The partial configuration will be merged with the existing XML configuration.
Create an advanced FortiClient Profile with the partial XML configuration provisioned:

1. In the FortiGate Command-line Interface enter the following commands:

   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-advanced-cfg enable
   end
   end
   ```

2. In the FortiGate Web-based Manager, go to User & Device > FortiClient Profiles. Select the advanced FortiClient profile and select Edit in the toolbar. The Edit FortiClient Profile page opens.

   **Figure 115:** Advanced FortiClient Profile
3. Open the FortiClient XML configuration file in a source code editor. Copy and paste the following lines directly from the source code editor into the XML text field in the FortiClient profile:

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<forticlient_configuration>
  <partial_configuration>1</partial_configuration>
  .......
</forticlient_configuration>
```

By setting the `<partial_configuration>` statement to 1, the XML configuration will be merged into the existing XML configuration.

Alternatively, you can copy and paste the XML configuration into the CLI using the `set forticlient-advanced-cfg-buffer` command.

4. Set the device groups, user groups, and user settings as required and select Apply to save the FortiClient Profile changes. In the future if you need to update the FortiClient configuration follow the procedure in “Advanced FortiClient Profile (Partial XML Configuration)".

**Advanced VPN Provisioning FortiClient Profile**

In this scenario, you want to provision multiple XML VPN configurations while setting the other FortiClient Profile settings in the FortiGate Web-based Manager. As the current buffer size in the CLI is 32kB, your FortiClient XML configuration may be too large to deploy using the regular advanced FortiClient Profile. You can use the repackaging tool to configure settings which are not available in the FortiClient Profile page by including the FortiClient XML configuration file in the installation

**Create an advanced FortiClient Profile with XML VPN configurations:**

1. In the FortiGate Command-line Interface enter the following commands:

   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-vpn-provisioning enable
   set forticlient-advanced-vpn enable
   set auto-vpn-when-off-net enable
   set auto-vpn-name <VPN name to connect to automatically when off-net>
   end
   end
   ```

2. In the FortiGate Web-based Manager, go to User & Device > FortiClient Profiles. Select the advanced FortiClient profile and select Edit in the toolbar. The Edit FortiClient Profile page opens.
3. Open the FortiClient XML configuration file in a source code editor. Copy and paste all information from the `<vpn>` comment tag to the `</vpn>` comment tag directly from the source code editor into the XML text field in the endpoint profile.

Alternatively, you can copy and paste the XML configuration into the CLI using the `set forticlient-advanced-vpn-buffer` command.

4. Set the device groups, user groups, user settings, and other FortiClient Profile settings as required and select Apply to save the FortiClient Profile changes.
Advanced FortiClient Profile (No Settings Provisioned)

In this scenario, you have created a custom installation file using the repackager tool. The custom file includes all settings required by the client at the time of deployment. When the client registers to the FortiGate, you want to ensure that no settings are pushed to the client and the XML configuration remains intact.

When changes are required you can push a partial configuration to the clients with the specific XML configuration changes.

Create an advanced FortiClient Profile with no settings provisioned:

1. In the FortiGate Command-line Interface enter the following commands:
   
   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-advanced-cfg enable
   end
   end
   ```

2. In the FortiGate Web-based Manager, go to User & Device > FortiClient Profiles. Select the advanced FortiClient profile and select Edit in the toolbar. The Edit FortiClient Profile page opens.

Figure 117: Advanced FortiClient Profile
3. Open the FortiClient XML configuration file in a source code editor. Copy and paste the following lines directly from the source code editor into the XML text field in the FortiClient profile:

```xml
<?xml version="1.0" encoding="UTF-8" ?>
<forticlient_configuration>
    <partial_configuration>1</partial_configuration>
</forticlient_configuration>
```

By setting the `<partial_configuration>` statement to `1`, the XML configuration will be merged into the existing XML configuration. Since no other XML statements are included, no changes will be made to the XML configuration on the client.

Alternatively, you can copy and paste the XML configuration into the CLI using the `set forticlient-advanced-cfg-buffer` command.

4. Set the device groups, user groups, and user settings as required and select `Apply` to save the FortiClient Profile changes. In the future if you need to update the FortiClient configuration follow the procedure in "Advanced FortiClient Profile (Partial XML Configuration)".

Using Active Directory Groups

Some organisations may choose to deploy different FortiClient profiles to different user groups. FortiOS is able to send different FortiClient profiles based on the AD group of the user. This requires use of the FortiAuthenticator.

No special configuration is required on FortiClient.

Monitoring registered users

An administrator can monitor managed FortiClient users. When the client successfully registers to the FortiGate, the client can be monitored on the FortiGate.

In the FortiOS Web-based Manager, all registered clients can be observed on the `User & Device > Monitor > FortiClient` page.

Figure 118: Monitor registered clients
Either of the following FortiOS CLI commands will list all registered clients:

- `diagnose endpoint registration list`, or
- `diagnose endpoint record-list`.

## Customizing FortiClient using XML settings

FortiClient configurations can be customized at the XML level. For more information, see the [FortiClient XML Reference](#).

### Silent registration

You may want to configure FortiClient to silently register to FortiGate without any user interaction. When configured, the user will not be prompted to register to a FortiGate. The `<silent_registration>` tag is intended to be used with the `<disable_unregister>` tag. For more information, see [Disable unregistration](#). The following XML elements can be used to enable this:

```xml
<forticlient_configuration>
    <endpoint_control>
        <silent_registration>1</silent_registration>
    </endpoint_control>
</forticlient_configuration>
```

### Locked FortiClient settings

End-users with administrator permission on their Windows system have access to the FortiClient settings page. If this is not desired, it can be locked with a password from the FortiGate. The following FortiOS Command Line Interface (CLI) command, when included, requires that any client registered to the FortiGate to provide the password before they can access the settings page.

```fortioscli
config endpoint-control profile
edit "fmgr"
    config forticlient-winmac-settings
        ...
        set forticlient-settings-lock disable
        set forticlient-settings-lock-passwd <password>
        ...
    end
    ...
next
end
```
Disable unregistration

With silent endpoint control registration enabled, a user could unregister after FortiClient has registered to the FortiGate. The capability to unregister can be disabled using the following XML element:

```xml
<forticlient_configuration>
  <endpoint_control>
    <disable_unregister>1</disable_unregister>
  </endpoint_control>
</forticlient_configuration>
```

Putting it together

Here is a sample complete FortiClient 5.2.3 XML configuration file with the capabilities discussed above:

```xml
<forticlient_configuration>
  <partial_configuration>1</partial_configuration>
  <endpoint_control>
    <enabled>1</enabled>
    <disable_unregister>1</disable_unregister>
    <silent_registration>1</silent_registration>
    <fortigates>
      <fortigate>
        <serial_number />  
        <name />
        <registration_password>un9r3Ak@b!e</registration_password>
        <addresses>newyork.example.com</addresses>
      </fortigate>
    </fortigates>
  </endpoint_control>
</forticlient_configuration>
```

The FortiGate that is registered to is listed in the `<fortigates>` element. The `<registration_password>` element is required if the endpoint control configuration on the FortiOS requires one. This can be exported as an encrypted file from a registered FortiClient.

The configuration provided above is not the full FortiClient configuration file. Thus, the `<partial_configuration>` element is set to 1.

Off-net VPN auto-connect

**Configure off-net VPN auto-connect and disable the VPN disconnect button**

1. Configure the corresponding FortiClient profile from the FortiGate CLI. Enter the following CLI commands:

   ```
   config endpoint-control profile
   edit <profile_name>
   config forticlient-winmac-settings
   set forticlient-vpn-provisioning enable
   set forticlient-advanced-vpn enable
   end
   ```
2. Log into FortiGate Web-based Manager.

3. Go to User & Device > FortiClient Profiles and select the profile you edited in the previous step.

4. Copy and paste the VPN configuration in XML format into the VPN field. This includes the VPN connection and the settings for off-net VPN auto connect.

```xml
<vpn>
  <options>
    <autoconnect_tunnel>ssl209.77</autoconnect_tunnel>
    <autoconnect_only_when_offnet>1</autoconnect_only_when_offnet>
    <keep_running_max_tries>0</keep_running_max_tries>
    <allow_personal_vpns>0</allow_personal_vpns>
    <disable_connect_disconnect>1</disable_connect_disconnect>
  </options>
  <sslvpn>
    <options>
      <enabled>1</enabled>
    </options>
    <connections>
      <connection>
        <name>ssl209.77</name>
        <server>209.207.125.77:443</server>
        <username />
        <single_user_mode>0</single_user_mode>
        <ui>
          <show_remember_password>1</show_remember_password>
          <show_alwaysup>1</show_alwaysup>
          <show_autoconnect>1</show_autoconnect>
        </ui>
        <password />
        <certificate />
        <prompt_certificate>0</prompt_certificate>
        <prompt_username>1</prompt_username>
        <fgt>1</fgt>
        <on_connect>
          <script>
            <os>windows</os>
          </script>
        </on_connect>
        <on_disconnect>
          <script>
            <os>windows</os>
          </script>
        </on_disconnect>
      </connection>
    </connections>
  </sslvpn>
</vpn>
```
5. FortiClient will receive the profile from the FortiGate upon registration. The user will be prompted to enter their username and password and connect to the VPN.

6. When FortiClient is detected as off-net, the VPN connection window will be displayed. The user will enter their username and password and connect to the VPN.

7. After the VPN is connected, the disconnect button will be disabled.

8. FortiClient will then always attempt to connect to the VPN.
You can operate FortiClient VPNs using the COM-based FortiClient API. The API can be used with IPsec VPN only. SSL VPN is currently not supported.

This chapter contains the following sections:

- Overview
- API reference

**Overview**

The FortiClient COM library provides functionality to:

- Retrieve a list of the VPN tunnels configured in the FortiClient application.
- Start and stop any of the configured VPN tunnels.
- Send XAuth credentials.
- Retrieve status information:
  - configured tunnel list
  - active tunnel name
  - connected or not
  - idle or not
  - remaining key life
- Respond to FortiClient-related events:
  - VPN connect
  - VPN disconnect
  - VPN is idle
  - XAuth authentication requested

For more information, see the vpn_com_examples ZIP file located in the VPN Automation file folder in the FortiClientTools file.

**API reference**

The following tables provide API reference values.

**Table 7: Methods**

<table>
<thead>
<tr>
<th>Method</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect(bstrTunnelName As String)</td>
<td>Open the named VPN tunnel. This connection must already be configured in your FortiClient application.</td>
</tr>
<tr>
<td>Disconnect(bstrTunnelName As String)</td>
<td>Close the named VPN tunnel.</td>
</tr>
<tr>
<td>GetPolicy pbAV As Boolean, pbAS As Boolean, pbFW As Boolean, pbWF As Boolean)</td>
<td>Command is deprecated in FortiClient version 5.0.</td>
</tr>
</tbody>
</table>
### Table 7: Methods (continued)

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connect(bstrTunnelName As String)</td>
<td>Open the named VPN tunnel. This connection must already be configured in your FortiClient application.</td>
</tr>
<tr>
<td>GetRemainingKeyLife(bstrTunnelName As String, pSecs As Long, pKBytes As Long)</td>
<td>Retrieve the remaining key life for the named connection. Whether keylife time (pSecs) or data (pKBytes) are significant depends on the detailed settings in the FortiClient application.</td>
</tr>
<tr>
<td>MakeSystemPolicyCompliant()</td>
<td>Command is deprecated in FortiClient version 5.0.</td>
</tr>
<tr>
<td>SendXAuthResponse (tunnelName As String, userName As String, password As String, savePassword As Boolean)</td>
<td>Send XAuth credentials for the named connection: User name, Password True if password should be saved.</td>
</tr>
<tr>
<td>SetPolicy (bAV As Boolean, bAS As Boolean, bFW As Boolean, bWF As Boolean)</td>
<td>Command is deprecated in FortiClient version 5.0.</td>
</tr>
</tbody>
</table>

### Table 8: Functions

<table>
<thead>
<tr>
<th>Function Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GetActiveTunnel() As String</td>
<td>Retrieve the name of the active connection.</td>
</tr>
<tr>
<td>GetTunnelList()</td>
<td>Retrieve the list of all connections configured in the FortiClient application.</td>
</tr>
<tr>
<td>IsConnected (bstrTunnelName As String) As Boolean</td>
<td>Return True if the named connection is up.</td>
</tr>
<tr>
<td>IsIdle (bstrTunnelName As String) As Boolean</td>
<td>Return True if the named connection is idle.</td>
</tr>
</tbody>
</table>

### Table 9: Events

<table>
<thead>
<tr>
<th>Event Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OnConnect(bstrTunnelName As String)</td>
<td>Connection established.</td>
</tr>
<tr>
<td>OnDisconnect(bstrTunnelName As String)</td>
<td>Connection disconnected.</td>
</tr>
<tr>
<td>OnIdle(bstrTunnelName As String)</td>
<td>Connection idle.</td>
</tr>
<tr>
<td>OnOutOfCompliance(bAV As Boolean, bAS As Boolean, bFW As Boolean, bWF As Boolean)</td>
<td>Command is deprecated in FortiClient version 5.0.</td>
</tr>
<tr>
<td>OnXAuthRequest(bstrTunnelName As String)</td>
<td>The VPN peer on the named connection requests XAuth authentication.</td>
</tr>
</tbody>
</table>
Appendix C: Rebranding FortiClient

The FortiClient Configurator can be used to create custom FortiClient MSI installers with various combinations. The customized MSI installer generated may be used to install FortiClient on all supported platforms using Active Directory or SCCM. A FortiClient setup executable file is also generated for manual distribution.

The FortiClient license for FortiOS version 5.2 includes the license file required to use the FortiClient Configurator tool used to create custom FortiClient installers. The Configurator tool also allows you to rebrand the installer file.

**Figure 119:** FortiClient Configurator Settings page

Under *Options*, you can select to enable software updates, configure the single sign-on mobility agent, and rebrand FortiClient. Rebranding allows you to edit various UI elements including graphics.
When replacing files in the resource folder, the replacement file should be the same file type and dimensions. Icons (.ico) are a special case. The `Main_icon.ico` file for example, is a composite file of multiple icons. The operating system picks the appropriate icon size from this file for the context in which the icon is being displayed.

Rebranding elements:

<table>
<thead>
<tr>
<th>Installer Product Name</th>
<th>Where Used: Setup Wizard header and body, File directory name in Installer Company Name file folder, engine/signature update bubble messages. Default Value: FortiClient</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installer Company Name</td>
<td>Where Used: File directory name in Program Files Default Value: Fortinet</td>
</tr>
<tr>
<td>Manufacturer Name</td>
<td>Where Used: Default Value: Fortinet Inc</td>
</tr>
<tr>
<td>Shortcut Text</td>
<td>Where Used: Name of shortcut on desktop Default Value: FortiClient</td>
</tr>
<tr>
<td>Product Name</td>
<td>Where Used: Name of installer file (.msi/.mst), UI header, configuration received from FortiGate bubble messages, Default Value: FortiClient</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Product Name Text</td>
<td>Where Used: Name of client in main page Default Value: FortiClient</td>
</tr>
<tr>
<td>Company</td>
<td>Where Used: Help &gt; About &gt; Copyright page Default Value: Fortinet</td>
</tr>
<tr>
<td>Company WebSite URL</td>
<td>Where Used: Help &gt; About &gt; Copyright page Default Value: <a href="http://www.fortinet.com">http://www.fortinet.com</a></td>
</tr>
<tr>
<td>Company Website Text</td>
<td>Where Used: Help &gt; About &gt; Copyright page Default Value: <a href="http://www.fortinet.com">www.fortinet.com</a></td>
</tr>
<tr>
<td>Feedback Email</td>
<td>Where Used: Help &gt; About &gt; Copyright page, Send Feedback Default Value: <a href="mailto:forticlient-feedback@fortinet.com">forticlient-feedback@fortinet.com</a></td>
</tr>
<tr>
<td>Feedback Email Text</td>
<td>Where Used: Help &gt; About &gt; Copyright page, Send Feedback Default Value: <a href="mailto:forticlient-feedback@fortinet.com">forticlient-feedback@fortinet.com</a></td>
</tr>
<tr>
<td>EULA</td>
<td>Where Used: Help &gt; About &gt; Copyright page, Click here to view the license agreement Default Value: <a href="http://www.fortinet.com/doc/legal/EULA.pdf">http://www.fortinet.com/doc/legal/EULA.pdf</a></td>
</tr>
<tr>
<td>Knowledge Base Text</td>
<td>Where Used: Help menu option Default Value: Fortinet Knowledge Base Leave this field blank to omit the field in the console.</td>
</tr>
<tr>
<td>Knowledge Base Link</td>
<td>Where used: Link used by Knowledge Base text Default value: <a href="http://kb.fortinet.com">http://kb.fortinet.com</a> Leave this field blank to omit the field in the console.</td>
</tr>
<tr>
<td>Advertisement 1</td>
<td>Where used: Link used by dashboard banner advertisement 1 Default value: <a href="http://www.forticlient.com/video/001">http://www.forticlient.com/video/001</a></td>
</tr>
<tr>
<td>Advertisement 2</td>
<td>Where used: Link used by dashboard banner advertisement 2 Default value: <a href="http://www.forticlient.com/video/002">http://www.forticlient.com/video/002</a></td>
</tr>
<tr>
<td>Advertisement 3</td>
<td>Where used: Link used by dashboard banner advertisement 3 Default value: <a href="http://www.forticlient.com/video/003">http://www.forticlient.com/video/003</a></td>
</tr>
</tbody>
</table>
## Resources folder elements:

<table>
<thead>
<tr>
<th>File Name</th>
<th>Where Used</th>
<th>File Type</th>
<th>Width</th>
<th>Height</th>
<th>Bit Depth</th>
</tr>
</thead>
<tbody>
<tr>
<td>About_red_shield_logo.png</td>
<td>Where Used:</td>
<td>PNG File (.png)</td>
<td>43 pixels</td>
<td>43 pixels</td>
<td>32</td>
</tr>
<tr>
<td>Advertisement_ad_0.png</td>
<td>Where Used: Dashboard advertisement banner</td>
<td>PNG File (.png)</td>
<td>628 pixels</td>
<td>66 pixels</td>
<td>32</td>
</tr>
<tr>
<td>Advertisement_ad_1.png</td>
<td>Where Used: Dashboard advertisement banner</td>
<td>PNG File (.png)</td>
<td>628 pixels</td>
<td>66 pixels</td>
<td>32</td>
</tr>
<tr>
<td>Advertisement_ad_2.png</td>
<td>Where Used: Dashboard advertisement banner</td>
<td>PNG File (.png)</td>
<td>628 pixels</td>
<td>66 pixels</td>
<td>32</td>
</tr>
<tr>
<td>Antivirus_AV_scan_top_banner_left_hand_side.png</td>
<td>Where Used: Banner used in right-click “scan with product name” dialog box</td>
<td>BMP File (.bmp)</td>
<td>1 pixel</td>
<td>40 pixels</td>
<td>8</td>
</tr>
<tr>
<td>Antivirus_AV_scan_top_banner_right_hand_side.png</td>
<td>Where Used: Banner used in right-click “scan with product name” dialog box</td>
<td>BMP File (.bmp)</td>
<td>440 pixels</td>
<td>40 pixels</td>
<td>8</td>
</tr>
<tr>
<td>Common_fgt-not-found-page-bg.png</td>
<td>Where Used: FortiGate not found page</td>
<td>PNG File (.png)</td>
<td>673 pixels</td>
<td>189 pixels</td>
<td>32</td>
</tr>
<tr>
<td>Common_fortinet-icon.png</td>
<td>Where Used:</td>
<td>PNG File (.png)</td>
<td>79 pixels</td>
<td>79 pixels</td>
<td>32</td>
</tr>
<tr>
<td>File Name</td>
<td>Where Used</td>
<td>File Type</td>
<td>Width</td>
<td>Height</td>
<td>Bit Depth</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>--------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>Common_registration_icon.png</td>
<td>Where Used: FortiGate detected page</td>
<td>PNG File (.png)</td>
<td>85</td>
<td>85</td>
<td>32</td>
</tr>
<tr>
<td>Common_searching-page-bg.png</td>
<td>Where Used: Searching for FortiGate page</td>
<td>PNG File (.png)</td>
<td>673</td>
<td>189</td>
<td>32</td>
</tr>
<tr>
<td>Dashboard_forticlient_v5_dashboard_bg.png</td>
<td>Where Used: Client console</td>
<td>PNG File (.png)</td>
<td>628</td>
<td>451</td>
<td>32</td>
</tr>
<tr>
<td>Dashboard_warning-shield.png</td>
<td>Where Used: Dashboard warning shield, displayed when antivirus is disabled.</td>
<td>PNG File (.png)</td>
<td>59</td>
<td>75</td>
<td>32</td>
</tr>
<tr>
<td>Installer_background.bmp</td>
<td>Where used: Setup Wizard background image.</td>
<td>BMP file (.bmp)</td>
<td>491</td>
<td>312</td>
<td>8</td>
</tr>
<tr>
<td>Installer_banner.bmp</td>
<td>Where Used: Setup Wizard banner image on destination page, ready to install page, installing pages.</td>
<td>BMP file (.bmp)</td>
<td>491</td>
<td>58</td>
<td>8</td>
</tr>
<tr>
<td>LightInstaller_icon.ico</td>
<td>Where Used: Light Installer Icon</td>
<td>ICO File (.ico)</td>
<td>32</td>
<td>32</td>
<td>32</td>
</tr>
<tr>
<td>Main_icon.ico</td>
<td>Where Used: Shortcut on desktop</td>
<td>ICO file (.ico)</td>
<td>48</td>
<td>48</td>
<td>32</td>
</tr>
<tr>
<td>Icon Name</td>
<td>Where Used</td>
<td>File Type: ICO File (.ico)</td>
<td>Width:</td>
<td>Height:</td>
<td>Bit Depth:</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------</td>
<td>-----------------------------</td>
<td>--------</td>
<td>---------</td>
<td>------------</td>
</tr>
<tr>
<td>Main_logo_black.ico</td>
<td>Client console header</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>setup.ico</td>
<td>Setup icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray_Icons_alert.ico</td>
<td>System tray alert icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray_Icons_alert_vpn.ico</td>
<td>System tray VPN alert icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray_Icons_running.ico</td>
<td>System tray running icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray(Icons for scanning)</td>
<td>System tray, these eleven images animate the scanning activity of the tray icon.</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tray_Icons_vpn.ico</td>
<td>System tray VPN icon</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
When rebranding FortiClient, you can select to digitally sign the installer package using a code signing certificate.

**Figure 121:** Package Signing

![Package Signing](image.png)
## Appendix D: FortiClient Log Messages

**Table 10:** FortiClient log messages

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>AntiVirus</td>
<td>0x00017912</td>
<td>Warning</td>
<td>Found virus by [AntiVirus scan</td>
<td>AntiVirus realtime protection] in [filesystem</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017913</td>
<td>Warning</td>
<td>Found malware by [AntiVirus scan</td>
<td>AntiVirus realtime protection] in [filesystem</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017914</td>
<td>Warning</td>
<td>Found suspicious by [AntiVirus scan</td>
<td>AntiVirus realtime protection] in [filesystem</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017915</td>
<td>Info</td>
<td>User enabled Realtime AntiVirus protection</td>
<td>Logged when someone enables Realtime AntiVirus.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017916</td>
<td>Warning</td>
<td>User disabled Realtime AntiVirus protection</td>
<td>Logged when someone disables Realtime AntiVirus.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017917</td>
<td>Info</td>
<td>Communication error, [detailed info], err=[error_code]</td>
<td>Communication error with other modules</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017918</td>
<td>Warning</td>
<td>AntiVirus realtime protection killed malware process : [process name]</td>
<td>A malware process killed a malware process.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791d</td>
<td>Info</td>
<td>av_task scan is started</td>
<td>This message is logged if AV scanning is started.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791e</td>
<td>Info</td>
<td>av_task scan is stopped</td>
<td>This message is logged if AV scanning is stopped.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x00017919</td>
<td>Info</td>
<td>av_task scan thread is suspended</td>
<td>This message is logged if AV scanning is paused.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791a</td>
<td>Info</td>
<td>av_task scan thread is resumed</td>
<td>This message when AV scanning is resumed.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791b</td>
<td>Warning</td>
<td>av_task killed suspicious process : &lt;filename or process name&gt;</td>
<td>&lt;filename or process name&gt; is a suspicous process and has been terminated.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791c</td>
<td>Info</td>
<td>Cannot start scan task, license expired</td>
<td>License expired.</td>
</tr>
<tr>
<td>AntiVirus</td>
<td>0x0001791f</td>
<td>Error</td>
<td>Scheduled scan failed: Path to file/folder no longer exists.</td>
<td>Path not found.</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f4</td>
<td>Info</td>
<td>User enabled Webfilter</td>
<td>Logged when someone enables webfiltering.</td>
</tr>
<tr>
<td>Client Feature</td>
<td>ID</td>
<td>Level</td>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
<td>--------</td>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f5</td>
<td>Warning</td>
<td>User disabled Webfilter</td>
<td>Logged when someone disables webfiltering.</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f6</td>
<td>Warning</td>
<td>user’s access to the url [action and reason]</td>
<td>the action to the user’s access, and the reason</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f7</td>
<td>Info</td>
<td>user’s access to the url [action and reason]</td>
<td>the action to the user’s access, and the reason</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f8</td>
<td>Warning</td>
<td>The Webfilter Violation report was cleared [user name]</td>
<td>Logged when someone clears the webfilter violation report.</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178f9</td>
<td>Warning</td>
<td>Unable to create proxy/webfilter communication socket.</td>
<td>FortiClient will not be able to determine the FortiGuard rating of URLs.</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178fa</td>
<td>Warning</td>
<td>Unable to retrieve the webfilter UDP port number.</td>
<td>FortiClient will not be able to determine the FortiGuard rating of URLs.</td>
</tr>
<tr>
<td>Webfilter</td>
<td>0x000178fb</td>
<td>Warning</td>
<td>status=warn [logged on user] temporarily disabled blocking of category [category id] ([category name]) to access [url]</td>
<td>The user [logged on user] proceeded to the url [url] after acknowledging a warning message.</td>
</tr>
<tr>
<td>Application FireWall</td>
<td>0x00017982</td>
<td>Info</td>
<td>User enabled Firewall</td>
<td>User enabled Firewall</td>
</tr>
<tr>
<td>Application FireWall</td>
<td>0x00017983</td>
<td>Warning</td>
<td>User disabled Firewall</td>
<td>User disabled Firewall</td>
</tr>
<tr>
<td>Application FireWall</td>
<td>0x00017984</td>
<td>Warning</td>
<td>The Application Firewall report was cleared</td>
<td>Logged when someone clears the application firewall report.</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017930</td>
<td>Info</td>
<td>VPN tunnel status</td>
<td>VPN tunnel status</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017931</td>
<td>Warning</td>
<td>locip=&lt;ip address&gt; locport=&lt;port number&gt; remip=&lt;ip address&gt; remport=&lt;port number&gt; outif=&lt;interface&gt; vptunnel=&lt;tunnel name&gt; status=negotiate_error msg=No response from the peer, phase1 retransmit reaches maximum count.</td>
<td>No response from the peer, phase1 retransmit reaches maximum count.</td>
</tr>
</tbody>
</table>

Table 10: FortiClient log messages (continued)
Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IKE VPN</td>
<td>0x00017932</td>
<td>Warning</td>
<td>locip=&lt;ip address&gt; locport=&lt;port number&gt; remip=&lt;ip address&gt; remport=&lt;port number&gt; outif=&lt;interface&gt; vpntunnel=&lt;tunnel name&gt; status=negotiate_error msg=No response from the peer, phase2 retransmit reaches maximum count.</td>
<td>No response from the peer, phase2 retransmit reaches maximum count.</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017933</td>
<td>Warning</td>
<td>locip=&lt;ip address&gt; locport=&lt;port number&gt; remip=&lt;ip address&gt; remport=&lt;port number&gt; outif=&lt;interface&gt; vpntunnel=&lt;tunnel name&gt; status=negotiate_error msg=Received delete payload from peer check xauth password.</td>
<td>Received delete payload from peer check xauth password.</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017934</td>
<td>Error</td>
<td>locip=&lt;ip address&gt; locport=&lt;port number&gt; remip=&lt;ip address&gt; remport=&lt;port number&gt; outif=&lt;interface&gt; vpntunnel=&lt;tunnel name&gt; status=negotiate_error msg=Failed to acquire an IP address.</td>
<td>Failed to acquire an IP address for the virtual adapter.</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017935</td>
<td>Error</td>
<td>ike error, &lt;detailed error info&gt;</td>
<td>General error of IKE</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017936</td>
<td>Info</td>
<td>negotiation information, &lt;detailed info&gt;</td>
<td>negotiation information</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017937</td>
<td>Error</td>
<td>negotiation information error, &lt;detailed error&gt;</td>
<td>negotiation error</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017938</td>
<td>Error</td>
<td>replayed packet detected (packet dropped), &lt;detailed error&gt;</td>
<td>replayed packet detected (packet dropped).</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x00017939</td>
<td>Info</td>
<td>VPN user accept the banner and continue with the tunnel setup</td>
<td>The VPN user accept the banner warning</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x0001793a</td>
<td>Info</td>
<td>VPN user choose disconnect the tunnel or no response</td>
<td>The VPN user reject the banner warning and disconnect the tunnel</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x0001793b</td>
<td>Info</td>
<td>locip=&lt;ip address&gt; locport=&lt;port number&gt; remip=&lt;ip address&gt; remport=&lt;port number&gt; outif=&lt;interface&gt; vpntunnel=&lt;tunnel name&gt; action=install_sa, inspi=&lt;inbound spi&gt; outspi=&lt;outbound spi&gt; &lt;Initiator</td>
<td>Responder&gt; tunnel &lt;ip address/ip address&gt; install sa</td>
</tr>
<tr>
<td>Client Feature</td>
<td>ID</td>
<td>Level</td>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------</td>
<td>-------</td>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x0001793c</td>
<td>Info</td>
<td>VPN before logon was enabled</td>
<td>Logged when someone enables VPN before logon.</td>
</tr>
<tr>
<td>IKE VPN</td>
<td>0x0001793d</td>
<td>Info</td>
<td>VPN before logon was disabled</td>
<td>Logged when someone disables VPN before logon.</td>
</tr>
<tr>
<td>SSL VPN</td>
<td>0x00017958</td>
<td>Info</td>
<td>SSLVPN tunnel status</td>
<td>SSLVPN tunnel status</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x00017a71</td>
<td>Info</td>
<td>User enabled WAN Acceleration</td>
<td>User enabled WAN Acceleration</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x00017a70</td>
<td>Info</td>
<td>User disabled WAN Acceleration</td>
<td>User disabled WAN Acceleration</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x0000b000</td>
<td>Error</td>
<td>Network registry keys are missing</td>
<td>When enumerating the network interface subkeys, it was found that there were no subkeys present.</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x0000b001</td>
<td>Error</td>
<td>Network adapter is missing a description</td>
<td>When enumerating the network interfaces, one was found without a descriptions.</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x0000b002</td>
<td>Error</td>
<td>Error opening redirector device</td>
<td>Wan acceleration will not function.</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x0000b003</td>
<td>Info</td>
<td>WAN Acceleration was enabled by [user name]</td>
<td>Logged when someone enables WAN Acceleration.</td>
</tr>
<tr>
<td>Wan Acceleration</td>
<td>0x0000b004</td>
<td>Info</td>
<td>WAN Acceleration was disabled by [user name]</td>
<td>Logged when someone disables WAN Acceleration.</td>
</tr>
<tr>
<td>Vulnerability Scan</td>
<td>0x00017908</td>
<td>Info</td>
<td>The vulnerability scan status has changed</td>
<td>A vulnerability scan status change</td>
</tr>
<tr>
<td>Vulnerability Scan</td>
<td>0x00017909</td>
<td>Info</td>
<td>A vulnerability scan result has been logged</td>
<td>A Vulnerability scan result log</td>
</tr>
<tr>
<td>EndPoint Control</td>
<td>0x00017ab6</td>
<td>Info</td>
<td>upload logs, [state]</td>
<td>Upload logs to registered FortiGate</td>
</tr>
<tr>
<td>EndPoint Control</td>
<td>0x00017ab7</td>
<td>Info</td>
<td>Endpoint control policy synchronization was enabled</td>
<td>Logged when someone enables Endpoint control policy synchronization.</td>
</tr>
<tr>
<td>EndPoint Control</td>
<td>0x00017ab8</td>
<td>Warning</td>
<td>Endpoint control policy synchronization was disabled</td>
<td>Logged when someone disables Endpoint control policy synchronization.</td>
</tr>
<tr>
<td>EndPoint Control</td>
<td>0x00017ab9</td>
<td>Info</td>
<td>Endpoint Control Status changed to [status]</td>
<td>Endpoint Control Status Changed</td>
</tr>
<tr>
<td>EndPoint Control</td>
<td>0x00017aba</td>
<td>Warning</td>
<td>OffNet configuration version [version] doesn’t match FortiGate configuration version [version]</td>
<td>OffNet configuration version doesn’t match FortiGate configuration version</td>
</tr>
</tbody>
</table>
### Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EndPoint</td>
<td>0x00017abb</td>
<td>Info</td>
<td>Endpoint Control Registration Status changed to [status] with FGT [serial], [address] and client ip [address]</td>
<td>Endpoint Control Registration Status Changed</td>
</tr>
<tr>
<td>Control</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a2a</td>
<td>Info</td>
<td>Customer initiated a software update request.</td>
<td>Logged when a user presses the gui’s update button.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a37</td>
<td>Info</td>
<td>Checking for updates.</td>
<td>Checking for updates.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a2c</td>
<td>Info</td>
<td>Update allowed only if you have a valid license</td>
<td>Update allowed only if you have a valid license</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a38</td>
<td>Info</td>
<td>Software update started.</td>
<td>Software update started.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a2d</td>
<td>Info</td>
<td>Software updates are disabled.</td>
<td>Software updates from FortiGuard have been disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a2e</td>
<td>Info</td>
<td>Software updates from FortiGuard have been disabled</td>
<td>Software updates from FortiGuard have been disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a2f</td>
<td>Info</td>
<td>Software updates require administrative privileges.</td>
<td>The user does not have sufficient privileges to perform software updates.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a30</td>
<td>Info</td>
<td>Software update successful.</td>
<td>Software update successful.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a31</td>
<td>Info</td>
<td>Software update failed.</td>
<td>Software update failed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a32</td>
<td>Info</td>
<td>Unable to perform software update. Registry does not contain image id to download.</td>
<td>The image id that is expected to be in the registry is missing.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a33</td>
<td>Info</td>
<td>Update &lt;module description&gt; successful, new version is &lt;version number&gt;</td>
<td>Update was successful to the given version for the given module.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a34</td>
<td>Error</td>
<td>Unable to load AV engine</td>
<td>Failed to load the av engine</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a35</td>
<td>Error</td>
<td>Error patching AV signature.</td>
<td>Error patching AV signature.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a36</td>
<td>Error</td>
<td>Unable to load FASLE engine</td>
<td>Unable to load FASLE engine</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Update</td>
<td>0x00017a39</td>
<td>Info</td>
<td>Update successful, &lt;all engine/signature versions&gt;</td>
<td>Update was successful, current engine/signature information recorded.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scheduler</td>
<td>0x00017a20</td>
<td>Info</td>
<td>Forcefully kill a child process after grace period expires</td>
<td>A scheduler owned child process failed to stop when instructed to do so, so was forcefully terminated.</td>
</tr>
</tbody>
</table>

FortiClient Log Messages
### Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scheduler</td>
<td>0x00017a21</td>
<td>Error</td>
<td>The scheduler cannot start the scheduled task because the task's license is expired.</td>
<td>The scheduler cannot start the scheduled task because the task's license is expired.</td>
</tr>
<tr>
<td>Scheduler</td>
<td>0x00017a68</td>
<td>Info</td>
<td>FortiClient is starting up</td>
<td>FortiClient is starting up</td>
</tr>
<tr>
<td>Scheduler</td>
<td>0x00017a69</td>
<td>Info</td>
<td>%s is shutting down</td>
<td>FortiClient is shutting down</td>
</tr>
<tr>
<td>FortiProxy</td>
<td>0x00017a49</td>
<td>Info</td>
<td>Fortiproxy is enabled</td>
<td>Fortiproxy is enabled</td>
</tr>
<tr>
<td>FortiProxy</td>
<td>0x00017a48</td>
<td>Warning</td>
<td>Fortiproxy is disabled</td>
<td>Fortiproxy is disabled</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a53</td>
<td>Info</td>
<td>FortiShield is enabled</td>
<td>FortiShield is enabled</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a52</td>
<td>Warning</td>
<td>FortiShield is disabled</td>
<td>FortiShield is disabled</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a54</td>
<td>Info</td>
<td>The console was locked</td>
<td>The console password was locked.</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a55</td>
<td>Warning</td>
<td>The console was unlocked</td>
<td>The console password was unlocked.</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a56</td>
<td>Warning</td>
<td>The console password was removed</td>
<td>The console password was removed.</td>
</tr>
<tr>
<td>FortiShield</td>
<td>0x00017a57</td>
<td>Warning</td>
<td>FortiShield blocked application: [application path] from modifying: [file or registry path]</td>
<td>FortiShield has prevented an application from modifying a file or registry setting protected by FortiClient.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d001</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - creating new database.</td>
<td>A critical error occurred. The application database will not work. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d003</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - BIND command.</td>
<td>A critical error occurred. The application database will not work. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
</tbody>
</table>
Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Database</td>
<td>0x0000d004</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - opening database.</td>
<td>A critical error occurred. The application database is not present. An attempt to automatically regenerate it will occur. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d005</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - preparing sql statement.</td>
<td>The sql statement used is invalid. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d006</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - unable to find fingerprint.</td>
<td>The fingerprint does not exist in the database. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d007</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - invalid md5.</td>
<td>The parameter supplied is not an MD5. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d008</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; db error - row not found.</td>
<td>The requested row does not exist. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d00a</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Can’t open file.</td>
<td>The file cannot be opened. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
</tbody>
</table>
### Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application</td>
<td>0x0000d00b</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Unable to extract vendor id.</code></td>
<td>The files is not digitally signed, or the signature cannot be read. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d00e</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Can't access file because of sharing violation.</code></td>
<td>Can’t access file because of sharing violation. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d00f</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Can't open driver.</code></td>
<td>Can’t open the apd driver. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d010</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Can't start driver.</code></td>
<td>Can’t start the apd driver. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d011</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Driver io error.</code></td>
<td>APD driver io error. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d016</td>
<td>Error</td>
<td><code>&lt;context&gt; &lt;file reference&gt; Server-side pipe error.</code></td>
<td>A communication error occurred. It is probably temporary. <code>&lt;context&gt;</code> is the service that generated the log. <code>&lt;file reference&gt;</code> is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Client Feature</td>
<td>ID</td>
<td>Level</td>
<td>Format</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>-------</td>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d017</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Pipe server initialization error.</td>
<td>A communication initialization error occurred. It is probably temporary. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d018</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Pipe server creation error.</td>
<td>A communication initialization error occurred. It is probably temporary. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d019</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Unable to bypass fortishield.</td>
<td>Failed to bypass self-protection. The daemon might not function normally after this. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d01a</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Invalid arguments.</td>
<td>Invalid command line options supplied. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d01c</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Unable to allocate memory for vendor id cache.</td>
<td>Low memory. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Database</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Application</td>
<td>0x0000d01d</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Vendor id cache not initialized.</td>
<td>This is probably temporary. An attempt will be made later to read/write to the cache. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
</tbody>
</table>
Table 10: FortiClient log messages (continued)

<table>
<thead>
<tr>
<th>Client Feature</th>
<th>ID</th>
<th>Level</th>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Database</td>
<td>0x0000d01e</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Unable to open vendor id cache shared memory.</td>
<td>Application detection will not be functioning normally. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Application Database</td>
<td>0x0000d01f</td>
<td>Error</td>
<td>&lt;context&gt; &lt;file reference&gt; Unable to open mutex to access vendor id shared memory.</td>
<td>Application detection will not be functioning normally. &lt;context&gt; is the service that generated the log. &lt;file reference&gt; is optional and describes the file was being accessed when the log was generated.</td>
</tr>
<tr>
<td>Config Import/Export</td>
<td>0x00017a5c</td>
<td>Info</td>
<td>A configuration file is exported to [location]</td>
<td>Logged when someone exports a config file.</td>
</tr>
<tr>
<td>Config Import/Export</td>
<td>0x00017a5d</td>
<td>Info</td>
<td>A configuration file is imported from [location]</td>
<td>Logged when someone imports a config file.</td>
</tr>
<tr>
<td>Single Sign-On Mobility Agent</td>
<td>0x00017ad4</td>
<td>Info</td>
<td>Single Sign-On event</td>
<td>Single Sign-On event.</td>
</tr>
<tr>
<td>Single Sign-On Mobility Agent</td>
<td>0x00017ad5</td>
<td>Info</td>
<td>Single Sign-On Mobility Agent was enabled</td>
<td>Logged when someone enables Single Sign-On Mobility Agent.</td>
</tr>
<tr>
<td>Single Sign-On Mobility Agent</td>
<td>0x00017ad6</td>
<td>Warning</td>
<td>Single Sign-On Mobility Agent was disabled</td>
<td>Logged when someone disables Single Sign-On Mobility Agent.</td>
</tr>
<tr>
<td>Single Sign-On Mobility Agent</td>
<td>0x00017ad7</td>
<td>Info</td>
<td>Single Sign-On Mobility Agent is starting..., version:[nnn]</td>
<td>Single Sign-On Mobility Agent is starting</td>
</tr>
<tr>
<td>Single Sign-On Mobility Agent</td>
<td>0x00017ad8</td>
<td>Info</td>
<td>Single Sign-On Mobility Agent is stopping..., version:[nnn]</td>
<td>Single Sign-On Mobility Agent is stopping</td>
</tr>
<tr>
<td>UI</td>
<td>0x00017a66</td>
<td>Warning</td>
<td>Logs were cleared</td>
<td>Logged when logs are cleared.</td>
</tr>
<tr>
<td>UI</td>
<td>0x00017a67</td>
<td>Info</td>
<td>Alerts were cleared</td>
<td>Logged when alerts are cleared by a user.</td>
</tr>
</tbody>
</table>
## Index

### A
- **access**
  - settings 156
- **activation**
  - configurator 128
- **Active Directory**
  - deployment 135
  - endpoint registration 60
  - MSI 26
- **AD 155**
- **advanced options**
  - settings 121
- **adware**
  - grayware options 76
- **anti-rootkit**
  - database 69
  - engine 69
- **antivirus**
  - anti-rootkit engine 69
  - anti-rootkit version 69
  - antivirus database 69
  - antivirus engine 69
  - antivirus extended database 69
  - conflicting software 66
  - custom scan 67, 70
  - enable or disable 65
  - endpoint profile 77
  - exclusion list 71
  - full scan 67
  - grayware options 76
  - logging 75
  - notifications 66
  - perform on-demand scanning 67
  - quarantined threats 72
  - quick scan 67
  - removable media scan 67
  - scan a file or folder 68
  - scan type 70
  - schedule a scan 70
  - settings 120
  - signature updates 69
  - signature version 69
  - view signatures 69
  - virus alert 74
- **antivirus engine**
  - version 69
- **application control**
  - security profiles 88
  - sensor 88
- **application control filter 88**
- **application firewall**
  - enable or disable 88
  - endpoint profile 90
  - view blocked applications 91

### B
- **backup**
  - settings 114
- **broadcast discovery messages**
  - edit interface 40
- **Bugtraq ID**
  - vulnerability scan 112

### C
- **captive portal**
  - edit interface 41
- **certificate management**
  - settings 120
- **clear logs**
  - logging 76
- **CLI 156**
- **client**
  - monitor 155
  - client certificate
    - SSL VPN 93
  - client collections
    - SCCM 28
  - client deployment
    - SCCM 28
  - client policy polling interval
    - SCCM 28
  - client security issues
    - SCCM 28
  - command line interface. See CLI
  - configurator
    - activate 129, 136
    - activation 128
    - license key 128
  - configure VPN
    - IPsec VPN 92
    - SSL VPN 92
  - conflicting antivirus software 23
  - conflicting software
    - antivirus 66
  - create a redundant IPsec VPN
    - XML 107
  - create new connection
    - IPsec VPN 94
    - SSL VPN 92
  - custom FortiClient installation 128
  - custom scan
    - antivirus 67, 70
  - customize installation
    - advanced options 128
D
deployment
  Active Directory 135
  manual distribution 135
disable
  unregister 157
DNS name
  XML 56
download
  FortiClient 21
  license key 128
download FortiClient
  SSL VPN portal 49
E
edit interface
  broadcast discovery messages 40
  captive portal 41
  FCT-Access 40
enable safe search
  web security 81
endpoint
  management 39
endpoint control
  profiles 155
  silent 157
endpoint control synchronization
  enable 55
endpoint management
  firewall policies 46
endpoint profile
  advanced options 128
  antivirus 77
  application firewall 90
  configure 43
  deploy over VPN 51
  topologies 48
  vulnerability scan 96, 109
  web category filtering 85
endpoint registration
  Active Directory 60
  FortiClient 58
EULA
  install 22
exclusion list
  antivirus 71
  web security 80
export configuration file
  SCCM 37
export logs
  logging 76
F
FCT-Access
  edit interface 40
firewall policies
  endpoint management 46
FortiAnalyzer
  logging 116
  upload logs 46
FortiAuthentication 155
FortiClient
  Configurator 128
  dashboard 128
  download 21
  endpoint registration 58
  language support 14
  remembered FortiGates 52
  tools 128
  virus cleaner 21
  Windows upgrade 147
FortiClient Configurator 128
FortiGuard
  vulnerability scan 112
FortiManager
  logging 116
  signature updates 69
  updates 46
  upload logs 46
FortiTray
  connect to a VPN 127
  menu options 126
  Windows system tray 126
full scan
  antivirus 67
G
grayware options
  adware 76
  antivirus 76
  riskware 76
I
infected system
  install 25
install
  EULA 22
  infected system 25
  Mac OS X 24
  Microsoft Windows 22
  setup wizard 22
install FortiClient
  SCCM 36
installation
  supported operating systems 11
installation packages
  location 138
  x64 138
  x86 138
IPsec VPN
  configure VPN 92
  create new connection 94
  pre-shared key 94
  X.509 certificate 94
L
language support
  FortiClient 14
license key
  configurator 128
download 128
licensing 10
list all registered FortiClient endpoints 56
log level
  logging 75, 115
logging
  antivirus 75
clear logs 76
export logs 76
FortiAnalyzer 116
FortiManager 116
log level 75, 115
log settings 116
vulnerability scan 113
web security 81

M
Mac OS X
  install 24
  upgrade 147
XML 105
manual distribution
  deployment 135
map a network
  SCCM 35
Microsoft Windows
  install 22
XML 103
monitor
  client 155
users 155
MSI
  Active Directory 26
  FortiClient Configurator 128
multiple redundant gateways
  roaming clients 54
multiple security profiles
  feature settings 43

N
notifications
  antivirus 66

P
password to complete registration
  XML 57
pre-shared key
  IPsec VPN 94
profile
  endpoint control 155

Q
quarantined threats
  antivirus 72
quick scan
  antivirus 67

R
registered clients
  custom dashboard 128
registered FortiClient
  view 57
remembered FortiGates
  forget 53
FortiClient 52
removable media scan
  antivirus 67
restore
  settings 114
riskware
  grayware options 76
roaming clients
  multiple redundant gateways 54

S
scan a file or folder
  antivirus 68
scan type
  antivirus 70
SCCM
  client collections 28
  client configuration 28
  client deployment 28
  client discovery options 28
  client policy polling interval 28
  client security issues 28
  export configuration file 37
  install FortiClient 36
  map a network drive 35
  task sequences 29
  uninstall FortiClient 38
  upgrade FortiClient 38
schedule a scan
  antivirus 70
security profiles
  application control 88
  web filter profile 83
settings
  access 156
  advanced options 121
  antivirus 120
  backup 114
  certificate management 120
  restore 114
  SSO mobility agent 123
  updates 119
  VPN options 120
  WAN optimization 122
setup wizard
  install 22
signature updates
  antivirus 69
silent
  endpoint control 157
SSL VPN
    client certificate 93
    configure VPN 92
    create new connection 92
SSL VPN portal
    download FortiClient 49
SSO mobility agent
    settings 123
synchronization group
    DNS name 56
    XML 56

T
    task sequence
      monitor 34
    task sequences
      SCCM 29
tools
    configurator 128
    FortiClient 128

U
    uninstall FortiClient
      SCCM 38
    unregister
      disable 157
      FortiClient 54
    unregister from FortiGate 54
updates
    FortiManager 46
    settings 119
upgrade
    Mac OS X 147
upgrade FortiClient
    SCCM 38
upload logs
    FortiAnalyzer 46
    FortiManager 46
user
    monitor 155

V
    view blocked applications
      application firewall 91
    view scan results
      vulnerability scan 111
    view signatures
      antivirus 69
    virus alert
      antivirus 74
    virus cleaner
      FortiClient 21
VPN
    connect 99
    VPN options
      settings 120
vulnerability scan
    Bugtraq ID 112
    endpoint profile 96, 109
    FortiGuard 112
    logging 113
    perform a vulnerability scan 111
    view scan results 111

W
    WAN optimization
      settings 122
    web category filtering
      endpoint profile 85
    web filter profile
      security profiles 83
web security
    enable safe search 81
    enable/disable 78
    YouTube education filter 81
web security
    exclusion list 80
    logging 81
    settings 78
Windows upgrade
    FortiClient 147

X
    X.509 certificate
      IPsec VPN 94
XML 157
    configuration file 157
    connect VPN before logon 103
    create a redundant IPsec VPN 107
    DNS name 56
    Mac OS X 105
    Microsoft Windows 103
    password to complete registration 57
    priority based SSL VPN connections 106
    synchronization group 56

Y
    YouTube education filter
    web security 81